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Preface

Oracle WebCenter Content: Desktop provides convenient access to the files on a
number of content repositories (including Oracle WebCenter Content Server and
Oracle Content Database) from a number of familiar desktop applications, such as
Windows Explorer, Microsoft Office applications (Word, Excel, and PowerPoint), email
clients (Microsoft Outlook and Lotus Notes), and web browsers (Internet Explorer,
Mozilla Firefox, and Google Chrome).

Audience
This document is intended for end users who are using the Oracle WebCenter
Content: Desktop client software on their computers.

Documentation Accessibility
For information about Oracle's commitment to accessibility, visit the Oracle
Accessibility Program website at http://www.oracle.com/pls/topic/lookup?
ctx=acc&id=docacc.

Access to Oracle Support

Oracle customers that have purchased support have access to electronic support
through My Oracle Support. For information, visit http://www.oracle.com/pls/topic/
lookup?ctx=acc&id=info or visit http://www.oracle.com/pls/topic/lookup?ctx=acc&id=trs
if you are hearing impaired.

Related Documents
The complete Oracle WebCenter Content documentation set is available from the
Oracle Help Center at http://www.oracle.com/pls/topic/lookup?
ctx=fmw122120&id=wccdocs.

Conventions
The following text conventions are used in this document:

Convention Meaning

boldface Boldface type indicates graphical user interface
elements associated with an action, or terms defined in
text or the glossary.

italic Italic type indicates book titles, emphasis, or placeholder
variables for which you supply particular values.
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Convention Meaning

monospace Monospace type indicates commands within a
paragraph, URLs, code in examples, text that appears
on the screen, or text that you enter.

Preface
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What's New and Changed in This Guide

This section outlines the new features and enhancements in Oracle WebCenter
Content: Desktop.

This section contains the following topics:

• New and Changed Features in 12c (12.2.1.2.0)

• New and Changed Features for 12c (12.2.1.1)

• New and Changed Features for 12c (12.2.1)

New and Changed Features for 12c (12.2.1.2.0)
Desktop Integration Suite 12c (12.2.1.2.0) does not contain any new or changed
features.

New and Changed Features for 12c (12.2.1.1)
Desktop Integration Suite 12c (12.2.1.1) does not contain any new or changed
features.

New and Changed Features for 12c (12.2.1)
Desktop Integration Suite 12c (12.2.1) is the first 12c release, which offers many new
features and enhancements compared to version 11g Release 1.

Note:

Some of the new features may not be available on all servers, depending on
their server type, software version, and system configuration.

Following are the features that have been added:

• Show In Browser context menu item. See How do I access content servers?.

• Framework Folder Trash Support. See How do I delete libraries, folders, and
files?.

• Insert WebCenter Content feature. See Microsoft Office Integration.

• Microsoft Office 2010/2013 File Tab. See Microsoft Office Integration.

• Microsoft Outlook Check In Mail Item. See How does Desktop integrate with
Microsoft Outlook? and How do I preserve email messages and attachments on a
content server?.

What's New and Changed in This Guide
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• Lotus Notes Check In Mail Item. See How does Desktop integrate with Lotus
Notes? and How do I preserve email messages and attachments on a content
server?.

• Specify special characters using the registry key. See How do I preserve email
messages and attachments on a content server?.

• Prevent the file extension change. See How do I view and modify library, folder,
and file information and properties?.

• Open file location or Open folder location context menu item. See What are the
Content Folders (on WebCenter Content Servers)? and How do I work with
standard Windows shortcuts?.

What's New and Changed in This Guide
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1
Getting Started with Oracle WebCenter
Content: Desktop

This chapter describes the content repositories and the client applications the Oracle
WebCenter Content: Desktop supports.

This section covers these topics:

• What is Oracle WebCenter Content: Desktop?

• What are the content repositories the Desktop client software supports?

• Which are the client applications the Desktop client software supports?

• What are the localized user interfaces that Desktop offers?

• What are the accessibility features that Desktop supports?

• How do I set up the Desktop client software on a computer?

1.1 What is Oracle WebCenter Content: Desktop?
Oracle WebCenter Content: Desktop provides a set of embedded applications that
help you seamlessly integrate your desktop experience with Oracle WebCenter
Content Server, Oracle Content Server, Oracle Content Database, or other WebDAV-
based content repositories. More specifically, it provides convenient access to these
content servers directly from Microsoft Windows Explorer, Microsoft Office applications
(Word, Excel, and PowerPoint), email clients (Microsoft Outlook and Lotus Notes), and
web browsers (Internet Explorer, Mozilla Firefox, and Google Chrome).

Integrating content repositories such as Oracle WebCenter Content Server with your
desktop applications improves your ability to work with files on the content server. You
can easily manage files on the server and share files with other users directly from
your desktop in addition to using the web browser interface. Desktop provides a
simplified interface for managing files in a unified way from all your familiar desktop
applications.

Note:

Desktop can work with all content files on Oracle WebCenter Content Server
instances, including records and sealed documents (as managed by Oracle
Information Rights Management).
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1.2 What are the content repositories the Desktop client
software supports?

The client software of Oracle WebCenter Content: Desktop 12c can connect to these
content repositories:

• Oracle WebCenter Content Server and Oracle Content Server

• Oracle Content Database

• Other Content Repositories That Support the Standard WebDAV Protocol

Oracle WebCenter Content Server and Oracle Content Server

Oracle WebCenter Content: Desktop 12c can connect to Oracle WebCenter Content
Server and Oracle Content Server repositories. For the latest information on the
supported server configurations, see the Oracle Fusion Middleware Supported System
Configurations page at:

http://www.oracle.com/technetwork/middleware/ias/downloads/fusion-

certification-100350.html

For the Desktop client software to connect to Oracle WebCenter Content Server or
Oracle Content Server, the following components must be installed and enabled on
the server:

• DesktopIntegrationSuite, which handles core content management integration
functions on the server. This component is included in the Desktop distribution zip
file. It is also installed along with the Oracle WebCenter Content Server 12c
software, but the component is not enabled by default.

• CoreWebdav, which provides core WebDAV capabilities for the content
management integrations. This component is one of the Oracle WebCenter
Content Server or Oracle Content Server system components.

• Framework Folders (11gR1 11.1.1.6 or higher) or Folders_g (11gR1 prior to
11.1.1.6 and 10gR3), which enables the content folders in the integrated folder
tree. These components are part of the Oracle WebCenter Content Server or
Oracle Content Server core.

• CheckoutAndOpenInNative, which enables content items to be checked out from
Oracle WebCenter Content Server or Oracle Content Server and opened in their
associated applications. This component is one of the preinstalled Oracle
WebCenter Content Server or Oracle Content Server system components, and it
is also included in the Desktop distribution zip file.

Note:

This document assumes that servers are running the latest Oracle WebCenter
Content Server version with the Framework Folders component.

In addition, the following optional components may be installed and enabled:

Chapter 1
What are the content repositories the Desktop client software supports?
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• DesktopTag, which manages custom properties in Microsoft Office files that are
used for content tracking purposes, and also provides the workflow processing
functionality in Microsoft Office applications. This component is included in the
Desktop distribution zip file. It is also installed along with the Oracle WebCenter
Content Server 12c software, but the component is not enabled by default.

• OracleCleanContent, which is used by DesktopTag. This component is one of the
Oracle WebCenter Content Server or Oracle Content Server system components.

• EmailMetadata, which maps email message fields to email metadata fields and is
also required for dragging and dropping emails into content folders in Microsoft
Outlook and Lotus Notes. This component is included in the Desktop distribution
zip file. It is also installed along with the Oracle WebCenter Content Server 12c
software, but the component is not enabled by default.

• RMAEmail, which provides email metadata fields and enables users to work with
email distribution lists. This component is part of Oracle WebCenter Content:
Records. (Oracle WebCenter Content: Records cannot be used with a server that
is using the WebCenter Content user interface.)

Note:

The Desktop 11gR1 components (DesktopIntegrationSuite,
CheckoutAndOpenInNative, DesktopTag, and EmailMetadata) can be installed
on Oracle WebCenter Content Server 10gR3, but the product build number of
the server must be 7.2.4.55 or higher. To see this number, go to the
Administration page of the server and then click 'Configuration for
server_name'. The build number is included on the configuration information
page, under 'System Configuration'.

Integration with Oracle WebCenter Content Server provides the broadest content
management capabilities directly in the supported desktop applications. Not all
features of Desktop 12c may be available if you are connecting to a pre-12c Oracle
Content Server instance.

Oracle Content Database

Oracle WebCenter Content: Desktop 12c can connect to Oracle Content Database
repositories. For the latest information on the supported server configurations, see the
Oracle Fusion Middleware Supported System Configurations page at:

http://www.oracle.com/technetwork/middleware/ias/downloads/fusion-

certification-100350.html

Integration with Oracle Content Database provides basic content management
capabilities directly in the supported desktop applications. See What are the
capabilities of a content server? for details on the integrated content management
capabilities offered for Oracle Content Database instances.

Other Content Repositories That Support the Standard WebDAV Protocol

Integration with WebDAV servers provides basic content management capabilities
directly in the supported desktop applications. The WebDAV DeltaV extension is not
supported. See What are the capabilities of a content server? for details on the
integrated content management capabilities offered for WebDAV servers.

Chapter 1
What are the content repositories the Desktop client software supports?
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Note:

See Working with Content Server Connections for more information on
connecting to content servers.

1.3 Which are the client applications the Desktop client
software supports?

The Desktop client software can integrate each of the following client applications with
the supported content servers. The installer automatically detects the supported
applications on your computer and installs the appropriate integration features to
provide these applications direct access to content management functionality.

Windows Explorer

• Microsoft Windows XP (SP2 or higher, 32-bit or 64-bit version)

• Microsoft Windows Vista (SP1 or higher, 32-bit or 64-bit version)

• Microsoft Windows 7 (32-bit or 64-bit version)

File Explorer

• Microsoft Windows 8

• Microsoft Windows 8.1

Desktop Applications

• Microsoft Word 2002 (XP) through 2013

• Microsoft PowerPoint 2002 (XP) through 2013

• Microsoft Excel 2002 (XP) through 2013

Note:

You can interact with content servers from within these applications directly.
Files created in other office applications (such as Microsoft Visio or Corel
WordPerfect) can be managed using Windows Explorer integration or the
content server's web interface.

Email Client Applications

• Microsoft Outlook 2002 (XP) through 2013

• Lotus Notes email client version 8 (through 8.5.3), with Lotus Domino mail
databases based on release 8 mail templates

Chapter 1
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Note:

The Desktop client software can coexist with the Oracle Beehive extensions for
Microsoft Outlook and Windows Explorer.

Web Browsers (for the Search Engine Plug-in)

• Microsoft Internet Explorer 8.0 or higher

• Mozilla Firefox 3.5 or higher

• Google Chrome 10 or higher

For more information on setting up client computers for use with Desktop, see How do
I set up the Desktop client software on a computer?.

1.4 What are the localized user interfaces that Desktop
offers?

Oracle WebCenter Content: Desktop 12c offers localized user interfaces for the client
software. The following user interface languages are supported: English, German,
French, Spanish, Portuguese (both Brazil and Portugal), Italian, Dutch, Danish,
Swedish, Norwegian, Finnish, Polish, Czech, Slovak, Hungarian, Romanian, Russian,
Greek, Turkish, Hebrew, Chinese (both Simplified and Traditional), Japanese, Korean,
Thai, and Arabic.

The user interface language is automatically set to match the locale of the operating
system; for example, if you are running a German version of Microsoft Windows, then
the Desktop user interface will also be German.

1.5 What are the accessibility features that Desktop
supports?

Oracle WebCenter Content: Desktop complies with Oracle's accessibility guidelines. It
provides accessibility features in a number of areas.

Menu Access

The Desktop client software adds a number of menus and toolbars to some of the
applications it integrates with. As is customary in Windows applications, each menu
item has its own keyboard shortcut (Alt key plus a letter).

Context Menus

The Desktop client software provides context menus to provide options that are
relevant to the current context of the application. For example, with a content folder
selected, it shows options that are applicable to that folder in that particular context. To
show a context menu, right-click an object in the folder tree or the content pane, or
press the menu key on your keyboard.

Chapter 1
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Standard Windows Keyboard Shortcuts

The Desktop client software supports many standard Windows keyboard shortcuts,
including:

• Ctrl+C: copy

• Ctrl+V: paste

• Delete: delete

• F2: rename

• Shift+F10: open the context menu for the selected item (this is the same as right-
clicking the item)

• Tab: move to the next user interface element

• Shift+Tab: move to the previous user interface element

Additional Keyboard Shortcuts

You can use the following additional keyboard shortcuts in the Search panel of the
Select Content dialog:

• F5: refresh the web browser form

• F6: move out of the web browser form

1.6 How do I set up the Desktop client software on a
computer?

This section explains the process of setting up the Desktop client software on
computers running the Microsoft Windows operating system. It covers these topics:

• Installation Considerations

• Installation Process

• Uninstalling a Previous Version of the Desktop Client Software

• Installing the Latest Version of the Desktop Client Software

• Manually Configuring the Notes.ini File

• Setting Up Content Server Connections

1.6.1 Installation Considerations
Note the following considerations with regard to setting up a client computer for use
with Desktop:

• Your system administrator may set up the required Desktop software on your
client computer for you. If you must do it yourself, contact your system
administrator for instructions on where to obtain the Desktop client software
installer.

If you have access to an Oracle WebCenter Content Server 12c instance, you can
find the Desktop client installer on the My Downloads page in the Content Server
web interface (under My Content Server).

Chapter 1
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You can also obtain the Desktop distribution zip file from the downloads section at
Oracle.com.

• The Desktop client software can communicate with Oracle WebCenter Content
Server 12c as well as Oracle WebCenter Content Server 11gR1, Oracle Content
Server 11gR1 and 10gR3. Other Content Server versions are not supported.

Not all features of Desktop 12c may be available if you are connecting to an
Oracle Content Server version prior to 12c (see What's New and Changed in This
Guide).

• The Desktop client software can communicate with Oracle Content Database
(Oracle Content DB) 10gR1 (10.2).

• The Desktop client installer includes both the 32-bit and 64-bit versions of Desktop
12c. It will automatically install the 32-bit Desktop version on 32-bit Microsoft
Windows and the 64-bit Desktop version on 64-bit Microsoft Windows.

• The Desktop client software must be installed using administrator-level
permissions. If you do not have these permissions and you attempt to install the
software, the registry settings will not be set up correctly and the software will not
function properly. If you need assistance, contact your system administrator.

• The Desktop client installer includes 32-bit and 64-bit msi installers, which system
administrators can extract to help them roll out Desktop 12c on client computers
more efficiently. For more information, see Configuring the Content Server for
Desktop in Installing and Configuring Oracle WebCenter Content.

1.6.2 Installation Process
Setting up the Desktop client software consists of the following steps:

1. Uninstalling a Previous Version of the Desktop Client Software

2. Installing the Latest Version of the Desktop Client Software

3. Manually Configuring the Notes.ini File

4. Manually Configuring the Notes.ini File (if required)

5. Setting Up Content Server Connections

1.6.3 Uninstalling a Previous Version of the Desktop Client Software
If a previous version of the Desktop client software is already on your computer, it is
strongly recommended that you uninstall it first. It is important that you completely
uninstall everything previously installed.

To completely uninstall the desktop integration client software:

1. Open Windows Control Panel.

2. Click the following link, depending on your operating system:

• Windows XP: Add or Remove Programs

• Windows Vista and Windows 7 (category view): Uninstall a program (under
Programs)

• Windows Vista and Windows 7 (icon view): Programs and Features

3. Select Oracle WebCenter Content: Desktop or Oracle Content Server -
Desktop Integration Suite.

Chapter 1
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4. Do the following, depending on your operating system:

• Windows XP: Click Remove.

• Windows Vista and Windows 7: Right-click and choose Uninstall.

The uninstall wizard is launched.

5. Click Yes when asked if you are sure that you want to remove the Desktop client
software from your computer.

The software is removed from the client computer.

6. Restart your computer.

Note:

If you uninstall and then reinstall the Desktop client software (for example,
during an upgrade), all server connections that you set up earlier will continue
to be available after reinstalling the software. Additionally, any files that were
cached locally (see How are content files stored in a local cache?) will continue
to be available.

1.6.4 Installing the Latest Version of the Desktop Client Software
If there are no previous versions of the Desktop client software on your computer, you
can install the current version of the Desktop 12c client software.

To install the Desktop 12c client software on your computer:

1. Contact your system administrator for instructions on where to obtain the Desktop
client software installer.

If you have access to an Oracle WebCenter Content Server 12c instance running
the native 12c user interface, then you can find the Desktop client installer on the
My Downloads page in the Content Server web interface (under My Content).

You can also obtain the Desktop distribution zip file from the downloads section at
Oracle.com.

The Desktop client installer includes both the 32-bit and 64-bit versions of Desktop
12c. It will automatically install the 32-bit Desktop version on 32-bit Microsoft
Windows and the 64-bit Desktop version on 64-bit Microsoft Windows.

2. After obtaining the client software, run the installer executable.

3. On the Welcome screen, click Next to start the installation.

4. Respond to any prompts from the installation wizard.

In the Custom Setup dialog, select the supported applications you want to
integrate with content servers.

The list includes all supported applications that were detected on your local
computer (see Which are the client applications the Desktop client software
supports?). All applications are selected for integration by default. If you do not
want to integrate an application with content servers, click its icon and choose
"This feature will not be available" from the menu. The icon associated with the
application then changes to a red X.
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Figure 1-1    Selection of Applications to Integrate with Content Server

Note:

If no Outlook accounts have been defined yet, no integration will be set up
in Outlook, even if it was selected in the application selection dialog.

By default, the software is installed to C:\Program Files\Oracle\WebCenter
Desktop\Content. If you want to install the software to a different folder, click the
Change... button and point to a different destination.

After you have verified the applications to integrate with as well as the software
installation location, click Next to continue, or Cancel to exit the installation
process.

5. If any of the applications that you want to integrate with a content server are
currently running, a warning may be displayed stating that some Desktop features
will not be available until the affected applications are restarted. Click Next to
continue.

Note:

If no Outlook accounts have been defined yet, no integration will be set up
in Outlook, even if it was selected in the application selection dialog.

6. Click Install to start the installation.

All required files are copied.
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When installing the Lotus Notes integration, you may receive an error message
stating that the Notes.ini file could not be found. If you receive this error, first
complete the installation and then follow the instructions in Manually Configuring
the Notes.ini File.

7. After the installation has been completed, click Finish to exit the installation
wizard.

8. It is recommended that you restart your computer.

1.6.5 Manually Configuring the Notes.ini File
If Lotus Notes is one of the applications selected for integration, then you must make
some changes to the Notes.ini file. The Desktop client software installer attempts to
make these changes automatically. If the installer is unable to do this, an error
message is displayed, and you must make the changes manually.

To manually make the required changes to the Notes.ini file:

1. Locate the Notes.ini file. You will find this file in the following location:

• Windows XP: Lotus-Notes-App-Dir\Notes.ini (for example, C:\Program Files
\Lotus\Notes\Notes.ini)

• Windows Vista and Windows 7: C:\Users\User-Name\AppData\Local
\VirtualStore\Lotus-Notes-App-Dir\Notes.ini (for example, C:\Users\jsmith
\AppData\Local\VirtualStore\Program Files\Lotus\Notes\Notes.ini)

Note the following for Windows Vista and Windows 7:

– The Lotus Notes application directory also has a Notes.ini file, but this is
not the file that needs to be modified.

– The AppData structure in Windows Vista and Windows 7 is hidden by
default. You must enable the option to view hidden folders in Windows
Explorer.

– If multiple users are using a client computer running Windows Vista or
Windows 7, then the Notes.ini file needs to be modified for each user.

Consult your Notes administrator if you have trouble finding the Notes.ini file.

2. Open the Notes.ini file in a text editor.

3. Look for the AddInMenus entry.

• If there is an AddInMenus entry, add STELNI.DLL to the end of the entry,
separated by a comma, for example:

AddInMenus=FILE1.DLL,FILE2.DLL,STELNI.DLL

• If there is no AddInMenus entry, add the following line to the end of the file:

AddInMenus=STELNI.DLL

(The last character of the DLL file name is the upper-case letter i, not the number
1.)

4. Save and close the Notes.ini file.
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1.6.6 Setting Up Content Server Connections
After installing the Desktop client software on your computer, you must set up
connections to all content servers that you want to access from your computer. For
more information, see Working with Content Server Connections.

Note:

You may not need to set up server connections for Desktop on your own
computer, as this is often handled by system administrators.
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2
Working with Content Server Connections

This chapter describes how to manage a content server connection. You can add a
server connection through Windows Explorer and integrated applications such as
Microsoft Office, Microsoft Outlook, and Lotus Notes.

This section covers these topics:

• What are content server connections?

• How can I add and manage a content server connection?

• How can I connect to a content server?

• How do I log off from a content server?

• How do I work with content server in offline mode?

2.1 What are content server connections?
Before you can integrate content management features into your desktop experience,
you must establish a connection with a server, so you can access the files on it. You
can define server connections in any of the integrated applications (Windows Explorer,
Microsoft Word, Microsoft PowerPoint, Microsoft Excel, Microsoft Outlook, or Lotus
Notes). You must only define a server connection once. When you create a new
server connection, that connection will be available to all supported applications on
your computer that you use to interact with the content server. After you have defined
a server connection, you can begin working with that server based on your server
permissions.

If you add or remove a server connection, or change its display name, this only affects
your own computer. The server settings are stored on your own computer; no other
users are affected. Also, when you uninstall the Desktop client software from your
computer and reinstall it (for example, to upgrade to a newer version), all previously
configured server connections will continue to be available after you reinstall the
software.

Note:

Your system administrator may decide to set up all content server connections
for you.

Content Server Types

The Desktop client can connect to these types of servers:

• WebCenter Content Server: This is an Oracle WebCenter Content Server
instance, which offers the broadest content management integration: opening files
directly from the server (check-out), saving files to the server (check-in), file
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versioning, searching for files on the server, comparing Microsoft Word documents
on the server, and so on.

Oracle WebCenter: Desktop can work with both the new WebCenter Content user
interface offered by WebCenter Content 11gR1 (11.1.1. 8.0) and the native 11g
user interface offered by all WebCenter Content 11g releases.

This server type was called 'UCM Content Server' in earlier Desktop releases.

• Content DB Server: This is an Oracle Content Database (Oracle Content DB)
server. These servers offer some content management integration. You can open
files directly from the server and save files to it, but you cannot search for files on
the server using the Desktop client software.

• WebDAV Server: This is a server that is not an Oracle WebCenter Content Server
or Oracle Content Database server but which supports the standardized Web
Distributed Authoring And Versioning (WebDAV) enhancements to the HTTP
protocol. (The WebDAV DeltaV extension is not supported.) These servers offer
some content management integration. You can open files directly from the server
and save files to it, but you cannot search for files on the server using the Desktop
client software.

You select the content server type when you create the server connection.

Server Type Icons

Each server type has its own icon that visually identifies it in the folders directories in
Windows Explorer and Microsoft Outlook.

Server Icons Server Type

WebCenter Content Server instance

Oracle Content Database (Oracle Content DB) server

Other WebDAV server
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2.2 How can I add and manage a content server
connection?

Information You Need Before You Can Add a Content Server Connection

Before you begin, you must obtain the following information for the server you are
connecting to:

• The server type: WebCenter Content Server, Content DB Server, or WebDAV
Server.

• The URL for your WebDAV server. This information is needed to access the
resources provided by your WebDAV Server.

• The CGI URL for your content server. This is only for Oracle WebCenter Content
Server.

• The URL of the server that provides the resources for the Oracle WebCenter
Content user interface, if you want to use this interface. This interface is available
for Oracle WebCenter Content Server 11gR1 (11.1.1.8.0) or higher.

• Ask your system administrator if you do not already have this information.

Note:

The URL of the single sign-on (SSO) server is available depending on the
type of server that Desktop Integration Suite uses. Single Sign-On is
available only for Content DB Server and WebDAV Server type. For all
other server types, Desktop Integration Suite automatically detects and
redirects you to the appropriate page.

Adding a Content Server Connection through Windows Explorer

When you add a server connection to your folder tree, you can connect to that server
and work with the content on it.

Begin by selecting the WebCenter Content Servers folder in the Windows Explorer
navigation pane, then choosing the File menu, followed by Add Server....

In the Server Name text box, enter the name for the new server connection. This
name will be displayed in the folder tree. You can use any name as long as it is not
already used for another server.

In the text box under Server WebDAV URL, enter the URL for your WebDAV server.
A URL is automatically inserted using the name you specified as the server name. You
may need to modify this information to suit your particular server. Each defined content
server connection must have its own, unique WebDAV URL. You cannot have two
server connections on your computer that use the exact same WebDAV URL.

In the text box under CGI URL, enter the CGI URL for your content server. A URL is
automatically inserted using the name you specified as the server name. You may
need to modify this information to suit your particular server.
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In the text box under User Interface URL, if you want to use the WebCenter Content
user interface, you must enter the URL of the server that provides the resources for
this user interface.

Click Options to open the Server Options dialog for Oracle WebCenter Content
Server instances, where you can set the authentication method for the server as well
as the metadata fields whose values should be remembered for new check-ins. Click
OK when you are done.

To add the server connection, click OK in the Add Server dialog.

The new server connection is now added to your folder tree (under "WebCenter
Content Servers"), and is available to all other integrated applications.

Adding a Content Server Connection through Your Integrated Applications

You can add a content server connection through Microsoft Office, Microsoft Outlook,
and Lotus Notes. You begin by opening the Add Server dialog, then continuing in the
same way as for adding a connection through Windows Explorer (explained
previously).

The following are the other ways to open the Add Server dialog from your integrated
applications:

• In Microsoft Word, Excel, and Powerpoint, open the WebCenter Content menu or
ribbon, choose Edit Server List, then choose New. (The Edit Server List option
may be on an Options drop-down list.)

• In Microsoft Outlook, select the WebCenter Content Servers folder in the folders
pane, move the mouse cursor to an unused area in the content pane (that is, away
from any of the items listed in it), then right-click and choose Add Server....

• In Lotus Notes, open the Actions menu and choose Email Integration
Settings...., then Edit Server List, and then New....

• In Windows Explorer, right-click the WebCenter Content Servers folder in your
navigation pane and choose Add Server....

• In Windows Explorer, right-click in an unused area of the content pane (that is,
away from any of the items listed in it), then choose Add Server....

Adding a Connection from the Content Server Web Interface

You can also add a connection to an Oracle WebCenter Content Server 11gR1
(11.1.1.8.0) or higher, directly from its WebCenter Content user interface (if enabled).

Begin by opening your web browser and logging in to the WebCenter Content user
interface. Ask your system administrator if you do not know what URL to use.

Open your user menu and choose Add Server to Desktop Integration.

Enter a server name and click Add Server.

The server connection is created automatically in the WebCenter Content Server
folder tree using the correct WebDAV, CGI, and user interface URLs, and you can
interact with the server from your desktop applications.

Changing the Name of a Server Connection

In Windows Explorer, you may change the name of a server connection if no content
items on the server are currently in your local cache. If you change the name, it is
updated automatically in the WebCenter Content Servers folder tree.
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You change a content server name in the Server Properties dialog. Right-click the
name in the folder tree, choose Properties, then enter the new name in the Name
box.

Viewing Existing Content Server Connection URLs

Note:

You cannot edit any of the URLs of an existing server connection. If you need
to modify a server URL, you should remove the server connection and re-
create it using the new URL.

You can view the Server WebDAV URL by opening the Server Properties dialog in
Windows Explorer. Right-click the content server name and choose Properties.

To see the other URLs (if any) you must open the Edit Server List dialog in a Microsoft
Office application. Open the WebCenter Content menu or ribbon, then choose Edit
Server List.... (The Edit Server List option may be on an Options drop-down list.)
Select the server whose connection properties you want to view, then choose View....
All URLs used for the server connection are shown on this dialog.

Removing a Content Server Connection

When you remove a server connection from your folder tree, you can no longer work
with the content on that server from your desktop applications.

You can remove a server connection in Windows Explorer or from within Microsoft
Office applications.

To remove a server connection in Windows Explorer, select the server name in the
folders pane, right-click and choose Remove. Alternatively, you can press Delete on
your keyboard.

To remove a server connection from within Microsoft Office applications, open the
WebCenter Content menu or ribbon, and then choose Edit Server List.... (The Edit
Server List option may be on an Options drop-down list.) Select the server connection
that you want to remove, and choose Delete. Then click Yes to confirm.

The server is automatically removed from the WebCenter Content Servers folder tree
and is no longer available in all integrated applications on your computer. Only the
server connection is removed; no content files are deleted from the actual server.

Setting Metadata to be Remembered for Form-Based Check-Ins

For each server connection, you can set the metadata that will be "remembered" each
time you check in a content item using a content check-in form. As a result, at each
check-in, the metadata values you used at the last check-in will populate the metadata
fields configured to be remembered (assuming these values are available). If you enter
new values in the metadata fields, the new ones will be used for the file (and also
remembered for the next form-based check-in).

You can set the metadata fields to be remembered for a server when you initially
create a connection to that server (which was described above), or you can modify this
setting later.

You can modify the setting through your Microsoft Office applications and through
Microsoft Outlook. You cannot modify the setting through Windows Explorer.
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To begin modifying the setting through Microsoft Word, PowerPoint, and Excel, open
the WebCenter Content menu or ribbon, and choose Edit Server List.... (The Edit
Server List option may be on an Options drop-down list.)

To begin modifying the setting through Microsoft Outlook, open the WebCenter
Content menu or ribbon, select Email Integration Settings, then click the Edit
Server List button.

On the Edit Server List dialog, select the server for which you want to set the metadata
to be remembered, and click View....

On the Edit Server dialog, click Options. On the Server Options dialog, open the
Remember Metadata Fields tab, and move the metadata fields whose values should
be remembered between check-ins from the left column ("Available Metadata Fields")
to the right column ("Selected Metadata Fields").

After you have closed all dialogs, the setting takes effect immediately.

Setting the Authentication Method

For each server connection, you can set the authentication method that is used when
you log on to the server. The authentication method is set up by the content server
administrator and there is generally no need to change the default on your client
computer unless specifically asked to do so.

You can set the authentication method for a server when you initially create a
connection to that server (which was described above), or you can modify it later.

You can set the authentication method through your Microsoft Office applications and
through Microsoft Outlook. You cannot modify the setting through Windows Explorer.

To begin setting the authentication method through Microsoft Word, PowerPoint, and
Excel, open the WebCenter Content menu or ribbon, and choose Edit Server List....
(The Edit Server List option may be on an Options drop-down list.)

To begin setting the authentication method through Microsoft Outlook, open the
WebCenter Content menu or ribbon, select Email Integration Settings, then click
the Edit Server List button.

On the Edit Server List dialog, select the server for which you want to set the metadata
to be remembered, and click View....

On the Edit Server dialog, click Options. On the Server Options dialog, open the
Authentication tab, and select the authentication method to be used. Contact your
content server administrator if you are not sure which authentication method to use.

After you have closed all dialogs, the setting takes effect immediately.

2.3 How can I connect to a content server?
To access a content server from one of the supported desktop applications, you must
establish a connection to that server. To do so, select the content server in the folder
directory (in Windows Explorer, Microsoft Office, or Microsoft Outlook). You are then
typically prompted to provide your login credentials (that is, your user name and
password). After entering this information, you are able to view and interact with the
files on the content server.
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You will typically see a login web form or a login dialog, depending on the
authentication scheme used for the content server. In either case, provide your
assigned user name and password to gain access to the files on the server.

You may be logged off a content server automatically if there is no activity for a certain
period of time.

2.4 How do I log off from a content server?
When you are finished interacting with a content server, you may wish to break the
server connection (log off). To log off a content server, right-click that server in the
WebCenter Content Servers folder directory and choose Log Off in the context menu.
You can then no longer access the content on the server until you log back on.

You may be logged off a content server automatically if there is no activity for a certain
period of time.

2.5 How do I work with content server in offline mode?
You can work with a content server in offline mode. This means that you cannot
directly access any files on the server, but you can work with files from the server that
are currently in your local cache.

To work with a content server in offline mode, right-click that server in the folder
directory or the content pane, and choose Work Offline in the context menu. The
server icon then changes to include an offline indicator (Figure 2-1). In addition, the
Work Offline option in the server's context menu is preceded by a check mark. To
cancel the offline status, select the Work Offline option in the context menu again.

Figure 2-1    Offline Oracle WebCenter Content Server

After a server is offline, it has an Offline Files folder, which provides easy access to
all files on the server that you made available offline.

Related Topics

How can I access the content server files in offline mode?

How are content files stored in a local cache?
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3
Understanding the WebCenter Content
Servers Folder Tree

This chapter provides information on the WebCenter Content Servers folder tree that
enables you to interact with content servers and files.

This section covers these topics:

• What is a folder tree?

• What is the Top-Level Folder ("WebCenter Content Servers")?

• What are the Server Folders?

• What are the Content Folders (on WebCenter Content Servers)?

3.1 What is a folder tree?
The WebCenter Content Servers folder tree enables you to interact with content
servers and the files on them in a convenient, familiar desktop environment
(Figure 3-1). It appears in Windows Explorer and Microsoft Outlook. It does not appear
in Microsoft Office applications or in Lotus Notes, where you instead use menus,
toolbars, and ribbons to work with content servers and their files.

Figure 3-1    Example of Folder Tree with One Oracle WebCenter Content Server
Connection (Fully Expanded)

The WebCenter Content Servers folder tree appears in the navigation pane of
Windows Explorer and Microsoft Outlook. If you do not see the navigation pane in
these applications, you must turn it on. For example, in Windows Explorer on Windows
7, choose Organize, then Layout, and then Navigation Pane. Also, you must enable
the folder tree in your email application, as it is not displayed by default.

When you open a content folder, you see all files on the server in that folder for which
you have access privileges. You can perform content management tasks, such as
checking out or copying a file, directly from this list.

The "files" in the content folders are not actual files on your local computer, but rather
they are symbolic links or pointers to content items in the content server repository,
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each with a full revision history. You work with content managed on a content server
(the "files") in much the same way you do with other folders and files on your
computer. You can copy files, drag and drop them into folders, right-click objects to
open context menus, and so on. However, some tasks typically performed on files or
folders on your local computer may have a different effect when performed on files and
folders managed by a content server. For example, copying a file or saving an email
message to a content folder does not put it on your local computer, but rather uploads
and saves it on the content server. In addition, the context menus of files may include
items specific to content management, such as Check In, Check Out, Copy Links, and
so on.

The user logins and security controls on a content server also apply to files and folders
that are managed through the folder tree. For example, if you have only read
permission for a content item, you will be able to open a copy of the native file, but you
will not be able to check a new revision of the file in to the content server (which
requires write permission). Similarly, when you create a new folder in the folder tree on
the server, each person who has the rights to view that folder will see it on their local
computer. The files you add to the folder will also be available to each user on the
content server, again according to their security permissions.

3.2 What is the Top-Level Folder ("WebCenter Content
Servers")?

The top-level folder in the tree is always named "WebCenter Content Servers." You
cannot modify its name, nor can you delete it. In Microsoft Outlook, you must enable
its display, because it is not displayed by default.

When the top-level folder is selected, all defined content server connections are shown
as folders beneath it and in the adjacent file list or content pane. How the information
is displayed depends on the view mode: icons, lists, details, and so on. The icon of
each server denotes its type.

3.3 What are the Server Folders?
The server folders are immediately below the top-level WebCenter Content Servers
folder in the tree. They represent the defined server connections. You can select a
server folder to connect to the server it represents. Depending on the server
configuration and current login status, you may be prompted to provide your login
credentials for that server (your user name and password).

The display name of each server in the folder tree is the name as provided in the Add
Server dialog when the server connection was created. You can change the server
name through the Server Properties dialog (unless you have checked out any files or
made any files available offline).

The icon for each server in the folder tree denotes its type.

Support for Oracle WebCenter Content Servers

The Desktop client software provides direct access to content on Oracle WebCenter
Content servers. This server type is represented in the folder tree using this icon:

Chapter 3
What is the Top-Level Folder ("WebCenter Content Servers")?

3-2



The folder tree for Oracle WebCenter Content servers shows different folders
depending on the server version and configuration.

Oracle WebCenter Content Server 11gR1 (11.1.1.8.0) or higher offers two user
interfaces, each with its own folder tree:

• the WebCenter Content user interface

• the native 11g user interface

Oracle WebCenter Content Server releases prior to 11gR1 (11.1.1.8.0) offer only the
native 11g user interface.

The look of the folder tree may further differ depending on the active folders
component on the server (Framework Folders, Folders_g, or Folders).

In both user interfaces, you see only libraries, folders, and files for which you are
assigned access privileges on the server.

If you select a library or folder in the folder tree, the content pane shows all items in
that library or folder (although unpublished items may be hidden).

The icons of managed files in a content folder show their associated applications (for
example, Microsoft Word for .doc or .docx files) as well as their content management
status (in the form of application icon overlays), if applicable.

If you select an object in the content pane, the preview pane shows information about
that object from the content server (for example, general information for a library, or
summary information for a file).

Support for Oracle Content Database Servers

The Desktop client software provides direct access to content on Oracle Content
Database (Oracle Content DB) servers. This server type is represented in the folder
tree using this icon:

The folder tree for Oracle Content Database servers shows the folder structure as
defined on the content server. You see only folders and files for which you were
assigned access privileges on the server. See the Oracle Content Database
documentation for more information on working with repositories of this type.

Support for WebDAV Servers

The Desktop client software provides direct access to files on any content server that
supports the standardized Web Distributed Authoring And Versioning (WebDAV)
enhancements to the HTTP protocol. (The WebDAV DeltaV extension is not
supported.) This server type is represented in the server tree using this icon:
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The server tree for WebDAV servers shows the folder structure as defined on the
server. You see only folders and files for which you were assigned access privileges
on the server.

3.4 What are the Content Folders (on WebCenter Content
Servers)?

The content folders are below the server folders. You will see different content folders
depending on which user interface has been set up for the server.

WebCenter Content User Interface

These are the content folders you will see if you are using the WebCenter Content
user interface:

• Enterprise Libraries

• Favorites

• My Checked-Out Content

• My Workflow Assignments

• New Check-In

• Other Folders

– Users

• Offline Files

• Search Results (in the WebCenter Content User Interface)

Native 11g User Interface

These are the content folders and subfolders you will see if you are using the native
11g user interface:

• My Content Server

– My Checked-Out Content

– My Workflow Assignments

– My Saved Queries

– My Folders

• New Check-In

• Offline Files

• Search Results (in the Native 11g User Interface)

• Browse Content

– Projects
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– Trash

Enterprise Libraries

For WebCenter Content user interface, organizing documents in libraries helps to
ensure documents are secure, can be shared, and are easily found by yourself and
others.

Enterprise libraries list the folders, subfolders, and content items used by everyone on
the selected server. You will see only items for which you have access privileges.

You need extended privileges to create enterprise libraries.

You create enterprise libraries to provide flexible security and comprehensive
document management for an entire organization. Enterprise libraries offer a
comprehensive document revision history, a detailed security model per document,
and a full range of metadata options and control.

Favorites

For WebCenter Content user interface, the Favorites folder lists all libraries, folders,
and documents you have specified as favorites. You will not see any favorites chosen
by other people, unless you have also chosen them as a favorite.

You add an item to your Favorites folder by right-clicking the item and choosing
Favorite.

My Checked-Out Content

The My Checked-Out Content folder lists all content files that you currently have
checked out of the server. You see only files that you have checked out yourself, not
files checked out by others.

This My Checked-Out Content list is identical to the one in the Oracle WebCenter
Content Server web interface (under 'My Content Server').

The checked-out status of a content item is indicated by a green check mark, overlaid
on the application icon for the file type.

Icon Description

This icon is used to indicate that you have currently checked out the
content item. The versions of your locally cached copy and the original
file on the content server match; that is, no changes have been made
to either version since the file was checked out.

All shortcuts to a checked-out file will also show this icon, since they
are linked to the original file.

This icon is used to indicate that you have currently checked out the
content item. However, the versions of your locally cached copy and
the original file on the content server do not match; more specifically,
the modified timestamp of the file in your local cache has changed.
This will typically be the case if you checked out a file, made changes
to it, but did not yet check it back in to the content server. The icon
provides a visual reminder for this.

All shortcuts to a checked-out file will also show this icon, since they
are linked to the original file.
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My Workflow Assignments

The My Workflow Assignments folder lists all content files in a workflow on that
particular server that you are assigned to review and then approve or reject. You see
only workflow assignments for yourself, not for others. You can approve or reject the
items directly in this list.

This My Workflow Assignments list in is identical to the one in the Oracle WebCenter
Content Server web interface (under 'My Content Server').

New Check-In

The New Check-In folder lists all content profiles defined on the server. Content
profiles allow content server administrators to control what metadata fields are shown
on content pages (including the check-in form) and to set default metadata for files
depending on their application type.

When you double-click a content profile (or select it and press Enter), you see a list of
all content items on the server that were checked in using that profile. You will see
only content items for which you have access privileges on the server. You can
perform content management tasks directly from this list, such as checking out or
copying a file. You can also drag-and-drop or copy-and-paste files to a content profile
in the list to check that file in to the server using that profile (you will be prompted for
metadata if required). This allows you to check in a file without using the folder
hierarchy.

In addition to the defined content profiles on a server, the list will always include a
'[Standard]' node, which represents no profile. You cannot remove this default profile.

Other Folders

For WebCenter Content user interface, other Folders lists folders and content on the
server not listed elsewhere.

Depending on the content server configuration (specifically, the folders component that
is running), there may be a Users folder under Other Folders. This contains the
personal folders for all authenticated users on the server, but you see only your own
personal folder (unless you have administrative server privileges).

You can create folders beneath your personal folder.

Offline Files

If a content server is in offline mode, its folder tree includes a folder called Offline
Files. This lists all files on the server that are in offline mode, including those that are
not in a content folder. You can interact with these files directly from the list.

Search Results (in the WebCenter Content User Interface)

For WebCenter Content user interface, this Search Results folder lists all files on the
server that meet the criteria of the search query that was most recently performed.
You see only files for which you are assigned access privileges.

You can interact with content items in the search results list just as you could any
other content item on the server:

• You can open and view content items.

• You can check out and check in items.
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• You can use the Summary, Metadata, Sharing, and Preview tabs in the preview
pane.

• You can remove items from your folders but leave them on the content server.
When you remove an item from the Search Results folder, it is also removed from
the folder in which it is stored.

• You can delete items from the content server, at the same time as removing them
from your folders.

Additionally, you can open the parent folder for an item in the search results. You do
this by right-clicking the item and choosing Open file location.

You can drag and drop the Search Results folder (while holding the Ctrl key) to a
content library or folder to create a dynamic query folder.

You can view one set of search results at a time, for each server you are connected to.
The results of the last search you entered while you were in the File Explorer or email
application session are shown. When you close the session by closing the window, the
search results list is cleared.

Search Results (in the Native 11g User Interface)

For native 11g user interface, this Search Results folder lists all files on the server that
meet the criteria of the search query that was most recently performed. You see only
files for which you are assigned access privileges.

You can interact with content items in the search results list just as you could any
other content item on the server. For example, you can open, view, check out, and
check in content items in the folder. You can also view the content information page
and make changes to the assigned metadata, if necessary.

It is important to note that the items in the search results list are the actual files, not
copies or pointers of some sort. That is why you may see the content displayed in
multiple places, such as in a content folder and in the search results list. You can
remove a file from view in the search results list, but if you also choose to delete the
file, you are removing the actual content item from the content server.

You can save your most recent search query by right-clicking the Search Results node
in the folder tree and choosing Save Query. This adds the query to the My Saved
Queries list, where you can easily run the query again. You can also drag and drop the
Search Results folder (while holding the Ctrl key) to My Saved Queries or to a content
folder to create a dynamic query folder.

You can view one set of search results at a time, for each server you are connected to.
The results of the last search you entered while you were in the File Explorer or email
application session are shown. When you close the session by closing the window, the
search results list is cleared.

My Content Server

For native 11g user interface, the My Content Server folder provides a number of
personalized views of the content on the server. It includes the following subfolders:

• My Checked-Out Content

• My Workflow Assignments

• My Saved Queries

• My Folders
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My Saved Queries

For native 11g user interface, the My Saved Queries node lists all search queries that
you performed on the server and decided to save. Each saved query is dynamic,
which means that every time you run it, the content pane shows all items that meet the
search criteria at that particular moment. In other words, your saved queries will
always produce the latest search results.

This My Saved Queries list is identical to the one in the Oracle WebCenter Content
Server web interface (under 'My Content Server'). A saved query is saved on the
content server and is also available from the content server web interface.

Double-click a saved query (or select it and press Enter) to execute the query and
display a search results list in the content pane containing all items on the content
server that meet the search criteria.

You can right-click a saved query to view (and modify, if required) its query definition.
See the Oracle WebCenter Content Server documentation for more information on the
query format.

You can also drag and drop a saved query to anywhere within the folder tree under
Browse Content. This creates a query folder, which is a dynamic folder that always
contains all content items on the server that meet the search criteria and for which you
have access privileges (subject to any limit that has been set to the number of results
shown). The default query folder name is 'Search Results' (or a 'Copy of' variant if this
already exists), but you can rename it afterwards.

My Folders

For native 11g user interface, my Folders shows the personal folder tree that you
created on the server. All authenticated users on the server have their own personal
folder tree, but your personal folder tree is visible only to you. The tree under My
Folders is identical to your personal folders under Browse Content, Users (if present).
You can create subfolders and add files to your personal folders in the same way you
do with other folders in the hierarchy. You can also store query folders in your
personal folder tree. Your personal folders provide quick and convenient access to
items on the server.

It is important to note that all content items in your personal folders are the actual files,
not copies or pointers of some sort. You can interact with content items in your
personal folders just as you can any other content item on the server. If you delete a
file from a personal folder, you are removing the actual content item from the content
server.

Browse Content

For native 11g user interface, the Browse Content folder contains the content folder
tree as defined on the content server. Depending on the active folders component on
the server and the server configuration, the content folders may be displayed
immediately below Browse Content, or there may be an intermediate folder called
Contribution Folders or Content Folders.

Depending on the content server configuration (specifically, the folders component that
is running), there may also be a Users folder under Browse Content. This folder
contains the personal folders for all authenticated users on the server, but you see
only your own personal folder (unless you have administrative server privileges). Your
personal folder tree under Users is identical to the one under My Folders.
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Depending on the content server version and configuration, there may also be
Projects and Trash subfolders under Browse Content, which show, respectively, all
defined collaboration projects on the server and all content items that you recently
deleted on the server.
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4
Microsoft File Explorer Integration

This chapter describes the integration of Microsoft File Explorer with content servers.

This section covers these topics:

• How do I integrate Microsoft File Explorer with content servers?

• How do I access content servers?

• How can I create libraries and folders?

• How can I create new files?

• How do I modify existing files?

• How do I rename libraries, folders, and files?

• How do I search for files in the Microsoft File Explorer navigation pane?

• How do I search for files using the Quick Search feature?

• How do I work with saved Search Queries and Query Folders?

• How do I browse to Content Files?

• How do I work with Oracle WebCenter Content Server shortcuts ("Special
Shortcuts")?

• How do I work with standard Windows shortcuts?

• How do I work with Personal Folders?

• How can I create a list of Favorite Content Items?

• How do I view files?

• How do I open files?

• How do I check out files?

• How do I check in files?

• How do I copy libraries, folders, and files?

• How do I move libraries, folders, and files to and from a server?

• How do I delete libraries, folders, and files?

• How do I view and modify library, folder, and file information and properties?

• How do I propagate library and folder metadata?

• How can I copy content file links?

• How do I work with workflows on content server instances?

• How can I access the content server files in offline mode?
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4.1 How do I integrate Microsoft File Explorer with content
servers?

The integration of supported content servers into Microsoft File Explorer (previously
called Windows Explorer) provides a convenient way to manage files on those servers
using a familiar work environment. You do not need to work with the files on the
content server in a web browser or other dedicated interface (although these options
remain available). Instead, you can interact with content servers and the files on them
using a 'folders tree' in Microsoft File Explorer.

After you install the Desktop client software on your computer, Microsoft File Explorer
includes a top-level node called WebCenter Content Servers, through which you can
connect to servers and work with the files on them.

You work with content managed on a content server in much the same way you do
with other folders and files on your computer. You can copy files, drag and drop files
into folders, right-click objects to open context menus, and so on. However, some
tasks typically performed on files or folders on your local computer may have a
somewhat different effect when performed on files and folders managed by a content
server. For example, copying a new file to a content folder does not put it on your local
computer, but rather uploads and saves it on the content server. In addition, the
context menus of files may include items specific to content management, such as
Check In, Check Out, Copy Links, and so on.

The user logins and security controls on a content server also apply to files and folders
that are managed through the folder tree in Microsoft File Explorer. For example, if you
have only read permission for a content item, you will be able to open a copy of the
native file, but you will not be able to check a new revision of the file in to the content
server (which requires write permission). Similarly, when you create a new folder in the
folder hierarchy on the server, each person who has the rights to view that folder will
see it on their local computer. The files you add to the folder will also be available to
each user on the content server, again according to their security permissions.

You cannot access Oracle WebCenter Content Server administrative functions
through the Microsoft File Explorer integration. You must access all such functions
through the Oracle WebCenter Content Server web browser interface.

The Features of Microsoft File Explorer Integration

If you install the Desktop client software on Windows Vista, Windows 7 or Windows 8,
the software integrates into the different areas of Microsoft File Explorer:
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See the following table for more information about each numbered area.

Window part How it is used

1. Left pane (previously the
"navigation pane") [Numbers 1 and 6
on the Windows Explorer image.]

This is where your content servers are listed, under the
WebCenter Content Servers folder. This folder is also
added to the Favorites list. Expand the WebCenter
Content Servers folder to show the content servers you
can use and the folder tree for each server. You can
then copy files, drag and drop them into folders, right-
click objects to open context menus, and so on.
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Window part How it is used

2. File list (previously the "content
pane")

When you select an object in the left pane, the file list
shows the contents of that object (for example, a list of
files in the current content folder on the server). How the
information is displayed depends on the view mode:
icons, lists, details, and so on. Where the operating
system supports it, overlaid symbols indicate the content
management status of objects. For example, if the file is
currently checked out by yourself, this is shown using a
green check mark:

Files shown in a different color (usually green) are
unpublished files; that is, content items on the server
that are currently in a workflow, have not yet been fully
converted or indexed, or have a future release date.

If you hover your mouse pointer over a managed file in
the file list, a screen tip is displayed providing content
management information about that file. For example:

In details view, columns show metadata information
about the files or folders (for example, their security
group or author). These columns can be changed in the
usual way for File Manager.

3. Preview/Details pane [Numbers 3
and 4 on the Windows Explorer
image.]

If you select a managed file in the file list, the preview
pane shows information about the selected item (as
examples: the content information page for a file on the
content server; or tabs showing summary information,
metadata, and a preview of the selected document).
You can turn the preview pane on or off in the standard
Windows way. The preview pane remains enabled or
disabled for each specific server connection, which
includes every folder in it. If you open a folder from a
different server connection, you will see the preview
pane only if it was enabled for that server.
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Window part How it is used

5. Quick Search box This is where you can search for items on the current
WebCenter Content server. The Quick Search box is
shown above the file list when you are anywhere within
a server's folder tree. If you do not see it, right-click in an
unused area of the content pane (that is, away from any
of the items listed in it) and choose Show Quick Search.
Quick Search visibility applies to each server separately.
The search results are displayed in the file list.

4.2 How do I access content servers?
You can access your content servers in Microsoft File Explorer using any of the
following methods:

• Double-click the WebCenter Content Servers icon on your Windows desktop.

• Navigate to the top-level WebCenter Content Servers folder in Microsoft File
Explorer.

• Select WebCenter Content Servers in the Favorites list in the navigation pane
(Windows 7).

• Double-click a shortcut to a particular content server, content folder, or content
item.

Adding Content Servers and Folders to the Favorites List

You can add the WebCenter Content Servers folder or a content folder to the favorites
list in the standard Windows way, for example by selecting the folder in the content
pane and dragging it to the Favorites node in the navigation pane (Windows 7+). This
is available only in the native 11g user interface.

Opening the Web Page for an Oracle WebCenter Content Server Connection

For WebCenter Content user interface, while working with a content server in
Microsoft File Explorer, you can open its home page in a web browser. You do this by
right-clicking anywhere in the file list and choosing Show in Browser.

4.3 How can I create libraries and folders?
You can create a new, empty enterprise library or content folder on a content server, in
much the same way as you add folders on your local computer.

To create a new enterprise library or content folder on a content server:

1. Open the WebCenter Content Servers node in Microsoft File Explorer, making
sure that the navigation pane is visible.

2. Browse to the location on the server where you want to add the new library or
folder.
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Enterprise libraries must be added under the Enterprise Libraries node.

You can add content folders under certain nodes only. Where you cannot add a
content folder, the option is not available on the File menu.

3. Open the File menu and choose New Library or New Folder, as required.

4. Provide the name of the new library or folder and press Enter.

Your new library or folder is created and its information page is shown in the preview
pane.

Tips

• There is also a New Library command and a New Folder command on the
context menu that you get by right-clicking an unused area in the content pane
(that is, away from any of the items listed in it).

• After you have created an enterprise library, you can create folders beneath it, and
then add documents to those folders. You can also add documents directly to
library nodes (except to the top-most Enterprise Libraries node).

• When you add a new content folder, default metadata and settings are applied to
that folder. You can change the metadata while adding the new folder, or any time
after you add it.

• When you add files to the new folder, they inherit default metadata from the folder.

4.4 How can I create new files?
Creating a new content file from Microsoft File Explorer basically consists of copying or
saving a file to a content server. This checks the file in to the server as a new content
item and makes it available to other users on that server.

You can create new content files in the following ways:

• Copy and paste, drag and drop, or move a file from your local computer to a
library, folder, or profile on a content server.

• Double-click a Microsoft Office document on your local computer to open it in its
associated application (for example, Word for .doc or .docx files), and then check it
in to a content server using the Save As New option on the application's
WebCenter Content menu or ribbon.

Tips

• For WebCenter Content user interface, you cannot add content files directly to the
supplied Enterprise Libraries node, only to library nodes that have been created
beneath it.

• If the target location on the content server already contains a file of the same
name as one being copied or moved, then it is not checked into the server as a
new content item.

– For WebCenter Content user interface, the file is checked in as a new revision
of the existing file (even though they may be completely different files).

– For Oracle Content Database servers and WebDAV servers, the existing file in
the folder is typically overwritten with the new file.
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4.5 How do I modify existing files?
You Must Check Out Before Modifying

If you want to modify an existing content file (that is, a file that is already managed on
a content server), you must first check it out of the server. A copy of the content file is
then downloaded from the content server and placed in temporary storage space on
your computer. The file is locked on the content server, and no other user can check
out the file until you either check it back in or undo the check-out. After you have
checked out a file, you can modify it as needed, and check it back in to the server
when you are done.

Microsoft Office Documents Can Be Checked Out Automatically for Modification

If you want to modify a managed Microsoft Office document, you can open that
document in its associated Microsoft Office application. It is then automatically
checked out of the content server. After editing the document, you can check it back in
directly from the Microsoft Office application or from Microsoft File Explorer.

You Can Open Email Messages But Not Check Them Out

Checked-in email messages are not intended to be checked out, modified, and
checked back in. Email messages are checked in to a content server for the express
purpose of preserving them exactly as they were received. You can open a checked-in
email message from a server to view it in its associated email application (and even
make changes if you want), but you cannot check it back in to the server. You can,
however, send the message to other people or save a copy on your local computer.

4.6 How do I rename libraries, folders, and files?
You can rename libraries, folders, and files on the content server in much the same
way as other folders and files on your computer.

To rename a library, folder, or file in Microsoft File Explorer:

1. Locate and select the library, folder, or file you want to rename.

2. Open the File menu and choose Rename.

3. Provide the new name of the folder or file, and press Enter.

You cannot rename the supplied library and folder nodes (such as My Checked-Out
Content).

You cannot rename a file if it is currently in the local cache (for example, because it is
checked out of the content server).

Tips

• The Rename and Properties options are also available from the context menu.

• You can also rename libraries, folders, and files on their properties dialogs and
information pages.

• When you rename a library or folder on your local computer, this is reflected on
the content server (and vice versa).
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• The title of a content file may (initially) be based on its file name. If you change the
file name in the folder tree, its title is not automatically modified to reflect the new
file name (or vice versa).

• If you rename a library, folder, or file, the names of any shortcuts to the library,
folder, or file are not updated automatically.

4.7 How do I search for files in the Microsoft File Explorer
navigation pane?

Note:

You cannot search Oracle Content Database servers or other WebDAV
servers. You must browse to files on these servers to select them. See How do
I browse to Content Files?.

To search for files in the Microsoft File Explorer navigation pane:

1. Select the server, library, or folder whose content you want to search.

2. Open the File menu and choose Search.

This opens the Content Query Capture dialog, which is basically the standard
Oracle WebCenter Content Server search form.

3. Enter the search criteria in the form.

You can perform searches based on metadata (that is, information about files) or
full text (that is, text contained in the actual files), or a combination of both. If
content profiles are defined on the server, you can select one from the drop-down
list to limit the metadata fields shown on the search form. For more details on
using the search form, see How do I browse and search for content? in Using
Oracle WebCenter Content.

If you ran the search from a content folder, there may be a check box on the
search form to include all its subfolders in your search query, depending on the
server configuration. Otherwise the search will be limited to content items in the
current folder only.

4. Click Search.

The content pane shows all content items on the server that meet your search criteria,
and you can work with any of these files directly from there. You can right-click a
selected file to see a menu with relevant options for that file.

The search results list shows only content items that meet the search criteria, not
shortcuts to content items or folder names, even if these meet the search criteria.

The items in the search results list are the actual files, not copies or pointers of some
sort. Deleting a file from the search results removes it from all folders and may remove
the actual content item from the server (you are offered this as an option).

The files are also listed in the Search Results node of the server. You can quickly call
up these search results again until you perform another query. You can also save the
query for future use.
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4.8 How do I search for files using the Quick Search
feature?

To search for files using the Quick Search feature in Microsoft File Explorer:

1. Select the server, library, or folder whose content you want to search.

2. For native 11g user interface, make sure the Quick Search panel is visible. If this
is not the case, right-click and make sure that Show Quick Search is checked in
the context menu.

3. In the text entry box, enter some characters to represent what you are searching
for.

For native 11g user interface, you can choose search categories from a drop-down
list: Quick Search (a file name search), Authors, and Titles.

4. Press Enter, or click the search icon to the right of the text entry box.

Note:

Desktop Integration Suite Quick Search and Full Search in WebCenter Content
Server configured with Framework Folders must have Oracle Text Search
(OTS) as the search engine.

The content pane shows all content items on the server that meet your search criteria,
and you can work with any of these files directly from there. You can right-click a
selected file to see a menu with relevant options for that file.

The search results list shows only content items that meet the search criteria, not
shortcuts to content items or folder names, even if these meet the search criteria.

The items in the search results list are the actual files, not copies or pointers of some
sort. You can remove a file from view in the search results list, but if you also choose
to delete the file, you are removing the actual content item from the content server.

For WebCenter Content user interface, after a search, a Filter Search Results icon
appears in the Quick Search panel. By selecting this icon, you may be able to see and
select the search results, sorted into subcategories.

The files are also listed in the Search Results node of the server. You can quickly call
up these search results again until you perform another query. You can also save the
query for future use.

You can perform general metadata searches from the Quick Search panel, or use
personal quick searches as defined on the content server (under My Content Server,
My Quick Searches). See Creating Quick Search Queries in Using Oracle WebCenter
Content for information on how to define personal quick searches.
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4.9 How do I work with saved Search Queries and Query
Folders?

When you perform a search query, the Search Results node shows all content items
on the server that meet the search criteria and for which you have access privileges on
the server. You can save the most recent search query so you can easily run it again
at a later time.

Each saved query and query/search results folder is dynamic, which means that every
time you open it, the content pane shows all content items on the server that meet the
search criteria at that particular moment. In other words, your saved queries and
query/search results folders will always produce the latest search results.

Saved query lists or query/search results folders show only content items that meet
the search criteria, not shortcuts to content items or folder names, even if these meet
the search criteria.

There may be a limit to the number of items shown in query/search results folders.

The items in saved query lists or query/search results folders are the actual files, not
copies or pointers of some sort. Deleting a file from the search results removes it from
all folders and may remove the actual content item from the server (you are offered
this as an option).

Saved Searches

For WebCenter Content user interface, you can drag and drop the most recent search
results (while holding the Ctrl key) to any library or folder on the server.

For native 11g user interface, to save the most recent search query, right-click the
Search Results folder and choose Save Query. Enter a name for the query and click
OK (or press Enter) to save it to My Saved Queries under My Content Server.

You can view (and modify, if required) the definition of a saved query by right-clicking it
and choosing View Query Definition. See About Saved Queries in Using Oracle
WebCenter Content for more information on the query format.

You can also drag and drop the most recent search results (while holding the Ctrl key)
or a saved query to anywhere within the content folders tree under Browse Content.
This creates a query folder, which you can open to run the associated search query
on the server. If you drag and drop a saved query, the default query folder name is the
same name as the original saved query with 'Copy of' preceding it. If you drag and
drop the search results, the default query folder name is 'Search Results'. You can
rename query folders in the same way as other folders. Query folders are indicated by
a special icon (Figure 4-1).

Figure 4-1    Query Folder Icon
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4.10 How do I browse to content files?
In addition to searching for files, you can also browse to a file on a content server and
select it for further use. When browsing to a file, you navigate to it by moving down a
tree structure on the server until you have located the file you want to work with. This
is just like browsing for any file when using Microsoft File Explorer.

When you have browsed to the file, you can right-click it to see a menu showing
relevant options for that file.

4.11 How do I work with Oracle WebCenter Content Server
shortcuts ("Special Shortcuts")?

Unlike standard Windows shortcuts, Oracle WebCenter Content Server shortcuts are
not link files (.lnk), but rather copies of the referenced file. As long as they stay within
the folder structure of a content server, they are tightly linked to the item they
reference. Their context menus have the exact same options as those of the original
item. This means, for example, that you can check out a content file through its
shortcut context menu. Also, the icons of file shortcuts reflect the current content
management status of the original files. For example, if the original file is currently
checked out of the content server, all shortcuts to that file will also show the checked-
out icon. Shortcuts to content items are never included in search results lists, even if
these content items meet the search criteria.

When you create a shortcut to a content library, folder or file, its name is the original
folder or file name preceded by "Shortcut to," for example "Shortcut to Sales Report
2011.docx." In addition, the shortcut icon shows a small arrow symbol in the bottom
left corner to indicate it is a reference to another item (Figure 4-2). (This link symbol is
slightly different from standard Windows shortcuts, which visually reminds you this is a
Desktop shortcut.)

The shortcut is placed in the same location as the original item: a shortcut to a file is in
the same content folder as the file it references, and a shortcut to a folder is a folder at
the same level as the original folder (preceded with "Shortcut to"). You can rename
shortcuts as desired, and also copy them to other locations in the folder tree of the
same server or to a different server.

Important:

If you copy or move the shortcut to a location outside the Oracle WebCenter
Content Server hierarchy (for example, to your desktop), the shortcut may lose
its link to the original item, depending on the content server configuration, and
you may not be able to check a file back in to the server as a new revision of
the existing content item when you open it.
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Figure 4-2    Original File with Shortcut

When you double-click a shortcut to a content library or folder, its contents are
displayed. When you double-click a shortcut to a content file, it is checked out of the
content server (providing it is available and if you have permission to check it out) and
opened in its associated application.

If you hover the mouse cursor over an Oracle WebCenter Content Server special
shortcut, you see content information for its associated item, such as the content ID,
file size, and the like.

Creating Special Shortcuts

To create a special Oracle WebCenter Content Server shortcut, do one of the
following:

• Select a library, folder, or file on a content server, right-click, and then choose
Create Shortcut.

• Select a file on a content server, open the File menu, then choose Create
Shortcut.

You create a special shortcut by selecting a folder or file on a content server, opening
the File menu, then choosing Create Shortcut. (This option is also available from the
item's context menu.)

This creates an Oracle WebCenter Content Server shortcut in the same location as
the original item (preceded by "Shortcut to"). You can copy or move these special
shortcuts to other locations within the WebCenter Content Servers hierarchy on the
content server, for example to a single folder from where you will have easy access to
your most important documents. If, however, you move these special shortcuts to a
location outside the WebCenter Content Servers hierarchy the content server, such as
your desktop, they may stop behaving like special shortcuts.

Renaming Special Shortcuts

You can rename a special shortcut to items within the WebCenter Content Servers
hierarchy: Select the shortcut and press F2, or by right-clicking it and choosing
Rename.

Renaming a special shortcut does not affect the name of the original file and vice
versa.

You cannot rename standard Windows shortcuts created from managed content
items.

Copying Special Shortcuts

You can copy and paste special shortcuts to items within the WebCenter Content
Servers hierarchy. After selecting the shortcut to be copied, you can use the following
standard Windows methods of copying and pasting it:

Chapter 4
How do I work with Oracle WebCenter Content Server shortcuts ("Special Shortcuts")?

4-12



You copy a special shortcut by selecting it, then doing one of the following:

• Right-click and choose Copy. Then, at the target location, right-click and choose
Paste.

• Press Ctrl+C on your keyboard. Then, at the target location, press Ctrl+V.

• Choose Copy from the Edit menu. Then, at the target location, choose Paste from
the Edit menu. (This is supported only in Microsoft File Explorer, not in email
applications.)

• Drag and drop the selected folders and/or files to the target location.

Not all of the above methods are available for every combination of folder, file, and
destination.

If you copy an Oracle WebCenter Content Server special shortcut to a location outside
the WebCenter Content Servers hierarchy (for example, your desktop), the item
copied is not a shortcut, but the actual file, which is no longer linked to the original file.
This means that you cannot check the file back in to the server as a new revision of
the original file.

Deleting Special Shortcuts

You can delete special shortcuts to items within the WebCenter Content Servers
hierarchy. After selecting the shortcut to be deleted, you can use the following
standard Windows methods of deleting it:

You delete a special shortcut by selecting it, then doing one of the following:

• Right-click and choose Delete.

• Press Delete on your keyboard.

• For shortcuts to content items, Choose Delete from the File menu. (Only for
shortcuts to files.) (This is supported only in Microsoft File Explorer, not in email
applications.)

When you delete a special shortcut, only the shortcut itself is deleted. The folder or file
on the content server that the shortcut pointed to remains intact.

4.12 How do I work with standard Windows shortcuts?
In addition to the special Oracle WebCenter Content Server shortcuts, you can also
create standard Windows shortcuts to content libraries, folders, and files on a server.
The shortcut is a link file (.lnk) that points to the full URL of the referenced file or folder.
If you hover the mouse cursor over a standard Windows shortcut, you see the URL of
the referenced item.

When you double-click a shortcut to a content library or folder, its contents are
displayed. When you double-click a shortcut to a content file, it is opened in its
associated application in view mode. By default, you cannot check the file back in to
the server as a new revision of the original content item.

You cannot rename standard Windows shortcuts created from managed content
items.

Creating Standard Windows Shortcuts

To create a standard Windows shortcut:
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1. Within the WebCenter Content Servers hierarchy, Select the library, folder, or file
to which you want to create a shortcut.

2. From the Edit menu, select Copy.

3. At a location outside the WebCenter Content Servers hierarchy (for example, your
desktop), right-click and choose Paste Shortcut.

This procedure creates a standard Windows shortcut, from which the following
operations are available:

• For content items

Double-click (or select View File From Server from the context menu) to open the
content item in its associated application as a local copy of the managed item.

Select Open File Location from the context menu to open Microsoft File Explorer
with the content item highlighted in the content pane.

• For libraries and folders

Double-click (or select Open from the context menu) to open Microsoft File
Explorer with the server node highlighted in the folders pane.

Select Open Folder Location from the context menu to open Microsoft File
Explorer with the library or folder highlighted in the content pane.

4.13 How do I work with Personal Folders?
All authenticated users on the content server have their own personal folders, which
allow you to set up 'favorites' to content items or folders on the server. You can create
subfolders and add content items to your personal folders in the same way you do with
other folders in the hierarchy. You can also store query folders in your personal folders
tree.

Even though all authenticated users on the server have their own personal folders, you
can see only yours unless you have administrator privileges.

You can find your personal folders in the Desktop folder tree in two places:

• Under My Content Server, My Folders, and

• Under Browse Content, Users, USER_NAME (for example, jsmith).

The personal folder trees in these locations are exactly the same, and you can work
with the content in the folders from either location.

It is important to note that all content items in your personal folders are the actual files,
not copies or pointers of some sort. You can interact with content items in your
personal folders just as you could any other content item on the server. If you delete a
file from a personal folder, you are removing the actual content item from the content
server.

4.14 How can I create a list of Favorite Content Items?
Oracle WebCenter Content Server 11gR1 (11.1.1.8.0) or higher instances running the
WebCenter Content user interface include a node for content favorites.

If you frequently access certain content items and do not want to search through the
folder tree each time you want to use them, you can gather them together under your
Favorites node.
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If you add a library or folder to your Favorites node, that library or folder and all the
content items in it will be added.

You cannot add the My Checked-Out Content, New Check-In, or Other Folders nodes
to your favorites.

To add a library, folder, or file to your Favorites node, right-click the library, folder, or
file and select Favorite. (To remove the item from your Favorites node, repeat the
selection.)

4.15 How do I view files?
You view a file by selecting it, opening the File menu, then choosing one of the
following options:

• View File From Server

With this option, the file remains checked in to the content server and a temporary
copy is downloaded to your computer. The file opens in its associated application
in read-only mode. You can make changes to the file in the application, but you
will have to save it as a new file (with a new file name) and check it in to the server
as a new content item.

• View

You will see this option if the file is already in your local cache (typically because
you checked it out and edited it earlier, but did not yet check it back in to the
server). With this option, you can open the cached, typically newer version of the
file. If you instead view the file from the server, the locally cached file version is left
untouched and remains available.

Tips

• The View and View File From Server options are also available on the file's
context menu.

• For WebCenter Content user interface, a read-only preview of a document is
available (by selecting the Preview tab of the preview pane).

• By default, when you double-click a file in a server's directory structure, you view
the file. You can change this default behavior to open the file in full edit mode
('open' rather than 'view').

4.16 How do I open files?
When you open a file on a server, it is checked out of the content server and a copy is
placed in temporary storage space on your computer. The file is locked on the content
server, and no other user can check out the file until you either check it back in or
cancel its checked-out status ("undo the check-out").

You open a file by selecting it, opening the File menu, then choosing one of the
following options:

• Open

With this option, the file is checked out and opens in its associated application in
full edit mode. If the file is already in your local cache (typically because you
checked it out and edited it earlier, but did not yet check it back in to the server), it
opens from there; otherwise, the latest released revision on the content server
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opens. You can make changes to the file in the application as required and check
it back in to the server as a new revision of the content item.

• Open with...

This option is available if the file was already checked out earlier. With this option,
you can select the application with which to open the selected file (rather than the
application associated with the file type). The list of available applications is
exactly the same as for other, unmanaged files of the same type on your
computer. Using this option may be useful if, for example, you want to open a
managed web or media file in an editor rather than a viewer, which is often the
default application for these file types. You can then edit the file as needed and
then check it back in to the server.

Tips

• The Open and Open with... options are also available on the file's context menu.

• If you open a managed Microsoft Office document in its associated application, it
is automatically checked out of the content server, as for other types of files. After
editing the document, you can check it back in directly from the application.

• By default, when you double-click a file in a server's directory structure, you view
the file. You may change this default behavior to open the file in full edit mode
('open' rather than 'view').

4.17 How do I check out files?
When you check out a file from a content server, the file is downloaded from the server
and a copy is placed in temporary storage space on your computer. The file is locked
on the content server, and no other user can check out the file until you either check it
back in or cancel its checked-out status ("undo the check-out").

If you check out a file in Microsoft File Explorer, the checked-out file is not opened in
its associated application. (This is how checking out a file is different from opening it.)
You can process the file as desired, and check it back in to the server when you are
ready. As long as the file is checked out, its file icon shows the checked-out status by
a green check mark overlay of the application icon (Figure 4-3).

Figure 4-3    Checked-out Microsoft Word Document

Checking Out a File

You check out a file by selecting it on the server, opening the File menu and choosing
Check Out.

The file is checked out of the server and its application icon shows a green check mark
to indicate its checked-out status. You can now work with the file as needed, and
check it back in to the server when you are done.

The Check Out option is also available on the file's context menu.
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If the Check Out option is not available, the file is already checked out.

Undoing a File Check-Out

You can undo the check-out of a content file; that is, cancel the checked-out status of
the file on the server. The file lock is then removed on the server and other content
server users may check out the file. No changes are made to the file. You can only
undo the check-out of files you have checked out yourself, unless you have
administrator privileges on the server.

You undo the check-out of a file by selecting it on the server, opening the File menu
and choosing Undo Check Out.

The file is no longer checked out and its application icon no longer shows a green
check mark. Other users on the server can now check out the file.

The Undo Check Out option is also available on the file's context menu.

If the Undo Check Out option is not available, the file is not checked out.

Viewing All Your Checked-Out Files

You can view all files that you have currently checked out of an Oracle WebCenter
Content Server 11g instance in one convenient list. This enables you to check the file
status, process the files, or cancel their checked-out status.

You view the list of all your checked out files on a server by doing one of the following:

• For WebCenter Content user interface, select the My Checked-Out Content
node.

• For native 11g user interface, open the My Content Server node and then click
My Checked-Out Content.

If the server does not have a node called My Checked-Out Content, then it is not a
Content Server 11g instance.

The content pane lists all files that you have currently checked out on the current
content server. All items show a green check mark in their icons to indicate their
checked-out status (Figure 4-4). You see only files that you checked out yourself, not
other users' checked-out files.

Figure 4-4    Word Document Checked Out By Yourself

You can work with the files in this list as you would with other content files. However,
you cannot delete or rename files in your list of checked-out files.

4.18 How do I check in files?
When you check a file in to a content server, it is uploaded and stored on that server.
Other users on the server have access to it in accordance with their assigned
privileges.
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If you check a currently checked-out file back in to an Oracle WebCenter Content
Server instance, this file is checked in as a new revision of the existing content item.
On Oracle Content Database servers and other WebDAV servers, the file that is
checked in will typically overwrite the existing file on the server.

You can check files in to a server only if you checked out that file yourself, or if you
have administrator privileges for that server.

You can check in a file only if it has been changed since it was checked out. If it has
not been changed, you can choose to undo the check-out instead.

When checking in files from Microsoft File Explorer, you may check in existing content
files (that is, files that are already managed on a content server) or new files (that is,
files that are not yet managed).

Checking In Previously Checked-Out Files

You check in a file that was previously checked out by first selecting it on the content
server. All files that you checked out yourself have a green check mark in their file
icons. You then open the File menu and choose Check In.

The file is uploaded from your local cache to the server and checked back in. Its
application icon no longer shows a green check mark. Other users on the server can
now check out the file again.

The Check In option is also available from the file's context menu.

The Check In option is available only if the selected file is currently checked out and
has been changed since it was checked out.

Checking In New Files

You can check new, unmanaged files in to a content server and make them available
to other users on that server in a variety of ways:

• By copying and pasting a file from your local computer to a library, folder or profile
on a content server.

• By dragging and dropping a file to a library, folder or profile on a content server.

• By moving a file to a library, folder or profile on a content server.

When a file is copied or moved to a library or folder node on a content server, it is
checked in to that server as a new content item only if that node does not yet contain a
file with the same name. Otherwise, the file is checked in as a new revision of the
existing file (even though they may be completely different files).

When you drag and drop or copy and paste a new file to a content server, you may be
asked to provide metadata for the file, depending on the settings for the target
document library or content folder. If you are not prompted to provide metadata, the
file inherits the default metadata assigned to the target library or folder.

Tips

• You can see the revision history of a file on its content information page on the
server.

• If you want to check in a new content item, but do not want to assign it to a content
folder, then you can drag-and-drop or copy-and-paste it into any of the content
profiles under New Check-In. This opens the Check In Content dialog, where you
can provide profile-specific metadata before check-in.
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• When you check in a local copy of a managed file (for example, one that was
emailed to you), you may see a warning that it is not currently checked out and
that the file has been changed on the server (that is, there is a newer revision on
the server). You can then choose to open the current file or the latest revision from
the server.

• For native 11g user interface, if Oracle WebCenter Content: Records is installed
on Oracle WebCenter Content Server with its DoD compliance features enabled,
then you may not be able to check in files by copying and pasting or dragging and
dropping them into content folders. This is because the DoD compliance features
make the Category or Folder field required, which means an item cannot be
checked in if this field is empty. Since copying and pasting or dragging and
dropping a file into a content folder often does not require any further user
intervention, the check-in cannot complete successfully unless the content server
administrator configured Records to enable such check-ins. (Oracle WebCenter
Content: Records cannot be used with a server that is using the WebCenter
Content user interface.)

4.19 How do I copy libraries, folders, and files?
You can copy and paste items managed by a content server in much the same way as
other files on your computer. After selecting the libraries, folders, or files to be copied,
you can use all standard Windows methods of copying and pasting items:

• Right-click and choose Copy or Copy File From Server. Then, at the target
location, right-click and choose Paste.

• Press Ctrl+C on your keyboard. Then, at the target location, press Ctrl+V.

• Choose Copy from the Edit menu. Then, at the target location, choose Paste from
the Edit menu. (This is supported only in Microsoft File Explorer, not in email
applications.)

• Drag and drop the selected libraries, folders, and/or files to the target location.

Copied libraries are not pasted to their destination as libraries. Instead, they are
pasted as content folders.

You cannot copy a file to the same folder as the one it is in. Nor can you copy content
files to query folders.

The file name and title of the copied file are the same as for the original file, but you
can, of course, change these afterwards. The copied file does have a different content
ID as it is a separate content item on the server.

Copying Multiple Items

You can select multiple items (folders or files or a combination of both) using the
standard methods in Windows (to the extent that Windows allows this) and copy them
all at the same time. If multiple files are to be checked in to the content server as a
result of the copy action, a dialog may open for you to provide metadata for the files
before checking them in.

Copy Sources and Targets

You can copy items between various sources and targets:

• From an unmanaged location to a content server: When you copy a file from
an unmanaged location (for example, a folder on your local computer outside the
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WebCenter Content Servers folder tree or a shared network location) to a content
folder on a server in the folder tree, then this file is checked in to that server. This
turns the file into a managed content item on the server and makes it accessible to
other users on that server. Depending on how the content server is set up, you
may be prompted to provide metadata for the copied file before it is checked in.

If you copy a folder, then all files in that folder (including subfolders) are checked
in to the server as separate content items with their own content IDs. The folder is
included in the folder tree for everyone with the appropriate access privileges to
see.

• From a content server to an unmanaged location: When you copy a file from a
content folder on a server in the folder tree to an unmanaged location (for
example, a folder on your local computer outside the WebCenter Content Servers
folder tree or a shared network location), then this file becomes an unmanaged
file. The copied file is not managed by the content server, and it is not accessible
to users on that server (of course, the original content item on the server is still
accessible).

If you copy a folder, then all files in that folder (including subfolders) are copied to
the target location.

If you copied Microsoft Office documents, you may be able to check them back in
to their originating Oracle WebCenter Content Server instance, even if they are in
a location outside the folder tree. This depends on how the content server is set
up; specifically, whether the DesktopTag feature is enabled. If this is the case, the
Microsoft Office documents contain embedded information about the server
location where they originated. This enables these documents to be uploaded to
that same server location. You check these documents in using the WebCenter
Content menu or ribbon in the Microsoft Office application.

• Within the content folder structure of the same server: When you copy a file
from a content folder on a server in the folder tree to a different folder on the same
server, then a new content item is checked in to the server with a new content ID.
This means that the server now stores two copies of the same file (in two different
locations). These files are in no way connected; they are completely separate
entities. Any changes to one file do not affect the other, and vice versa. The new
content item keeps all the metadata from the original file, including the security
group. However, if the folder you copy the file into has the Force Folder Security
property set to 'True', then the copied file has its security group changed to match
that of the target folder.

Note:

If you want to copy files to a content folder on the same server, make sure
to hold the Ctrl key while doing it. Otherwise the content item will be moved
rather than copied.

• Between two different content servers: In addition to copying a file within the
same content server, you can also copy a file between different servers in the
folder tree. When you copy and paste between servers, the file you paste to the
new location is checked in to that content server as a new, separate content item
with a new content ID, unless a content item with the same file name and
extension already exists in the folder. In that event, the copied file is checked in to
the content server as a new revision to the existing file.
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When a new content item is checked in to the folder on the target server, you may
be prompted to provide metadata for the new item. This happens if the target
server is an Oracle WebCenter Content Server 11g instance and metadata
prompting has been enabled for the folder. You are also prompted for metadata if
any required metadata is missing regardless of the metadata prompting setting.
The default metadata values in the check-in form will be the ones specified for the
content folder that the file was copied into.

Oracle WebCenter Content: Records

For native 11g user interface, if Oracle WebCenter Content: Records is installed on
Oracle WebCenter Content Server with its DoD compliance features enabled, then you
may not be able to check in files by copying and pasting or dragging and dropping
them into content folders. This is because the DoD compliance features make the
Category or Folder field required, which means an item cannot be checked in if this
field is empty. Since copying and pasting or dragging and dropping a file into a content
folder often does not require any further user intervention, the check-in cannot
complete successfully unless the content server administrator configured Records to
allow such check-ins. (Oracle WebCenter Content: Records cannot be used with a
server that is using the WebCenter Content user interface.)

Tips

• If you want to drag and drop files to a content folder on the same server, make
sure to hold the Ctrl key while doing it. Otherwise the content item will be moved
rather than copied.

• If a file to be copied is already in your local cache (typically because you checked
it out and edited it earlier, but did not yet check it back in to the server), the context
menu includes both a Copy and Copy File From Server option. You can then
choose which file version to copy: the cached, typically newer version (Copy) or
the latest released version on the server (Copy File From Server). All other copy
methods will copy the locally cached file version if it exists, and otherwise the
latest released revision from the server.

• Use the menu copy-and-paste options (not keyboard commands) when copying
items between Lotus Notes and Microsoft File Explorer. Lotus Notes has an
internal clipboard and data from that clipboard is retained when using keyboard
copy-and-paste commands. For example, if you use the keyboard to copy a Lotus
Notes memo to your clipboard, paste it into a folder on a content server, then copy
a file from Microsoft File Explorer and attempt to paste it into the same content
server folder, the result is the previous Lotus Notes memo.

4.20 How do I move libraries, folders, and files to and from a
server?

You can move items to and from a content server in much the same way as other files
on your computer. After selecting the libraries, folders, or files to be moved, you can
use all standard Windows methods of moving items:

• Right-click and choose Cut. Then, at the target location, right-click and choose
Paste.

• Choose Cut from the Edit menu. Then, at the target location, choose Paste from
the Edit menu. (This is supported only in Microsoft File Explorer, not in email
applications.)
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• Drag and drop the selected libraries, folders, and/or files to the target location
within the folder tree.

Some of the Windows methods for moving items may not be available when moving
items from and to the same server.

Moving Multiple Items

You can select multiple items (folders or files or a combination of both) using the
standard methods in Windows (to the extent that Windows allows) and move them all
at the same time. If multiple files are to be checked in to the content server as a result
of the move action, a dialog may be displayed where you can provide metadata for the
files before checking them in. This happens if the target server is an Oracle
WebCenter Content Server 11g instance or Oracle Content DB instance and metadata
prompting has been enabled for the folder. You are also prompted for metadata if any
required metadata is missing, regardless of the metadata prompting setting.

Move Sources and Targets

You can move items from unmanaged locations to a content server or between folders
on the same server; you cannot move content items from a server to somewhere else
outside of that server.

When you move a file from an unmanaged location (for example, a folder on your local
computer or a shared network location) to a content folder on a server, then this file is
checked in to that server. This turns the file into a managed content item on the server
and makes it accessible to other users on that server. Depending on how the content
server is set up, you may be prompted to provide metadata for the copied file before it
is checked in.

If you move a folder, then all files in that folder (including subfolders) are checked in to
the server as separate content items with their own content IDs. The folder is included
in the server's directory structure for everyone with the appropriate access privileges to
see.

Changing the Folder Location of Content Item

On Oracle WebCenter Content Server instances running Framework Folders, if you
move an existing content item to a different folder, you change its folder location, or
more precisely, its virtual folder association on the content server.

If you move a content item to a folder on the server that already contains a content
item with the same file name, then you are prompted whether this new file should
replace the existing file in the folder (similar to what happens when copying or moving
files on your file system). If you confirm the action, the new content item takes the
place of the old one in the content folder. It is not checked in as a new revision of the
old content item. The old content item is not removed, though, it just loses its folder
association (so it is not "overwritten" as files on your file system are). It is still on the
content server and you can search for it. For example, imagine the content folder
'Sales' contains a content item named 'Report 2011.docx', which has four revisions,
and the content folder 'Marketing' also contains a file with that same name, which has
two revisions. If you move the file from the 'Sales' to the 'Marketing' folder and choose
to replace that file, then the 'Marketing' folder will only contain the file moved from the
'Sales' folder, which still has four revisions. The original file in the 'Marketing' folder is
no longer associated with that folder, but it is still on the content server (with two
revisions).

Oracle WebCenter Content: Records
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For native 11g user interface, if Oracle WebCenter Content: Records is installed on
Oracle WebCenter Content Server with its DoD compliance features enabled, then you
may not be able to check in files by cutting and pasting them into content folders. This
is because the DoD compliance features make the Category or Folder field required,
which means an item cannot be checked in if this field is empty. Since cutting and
pasting a file into a content folder often does not require any further user intervention,
the check-in cannot complete successfully unless the content server administrator
configured Records to enable such check-ins. (Oracle WebCenter Content: Records
cannot be used with a server that is using the WebCenter Content user interface.)

Tips

• If you drag and drop files to a library or folder on the same server, you can hold
the Ctrl key to copy rather than move them.

• You can easily change the folder location of a content item, or assign it to a folder
if it had not been before, by searching for it and then dragging and dropping it from
the search results node to the target content folder.

4.21 How do I delete libraries, folders, and files?
You can delete items managed by a content server in much the same way as other
files on your computer. After selecting the libraries, folders, and/or files to be deleted,
you can use all standard Windows methods of deleting items:

• Right-click and choose Delete.

• Press Delete on your keyboard.

• Choose Delete from the File menu. (This is supported only in Microsoft File
Explorer, not in email applications.)

You should be very careful deleting a library or folder. If you delete one, all subfolders
and all revisions of all content items in that folder may also be deleted, which may
affect everyone who uses that content server.

To delete a content item, you must have Delete permission for the security group of
that content item.

Depending on how the folders functionality has been set up on Oracle WebCenter
Content Server, you may be prompted whether just the file entry should be removed
from the content folder or also the actual content item from the server.

When you delete a library, folder, or file, it may be permanently deleted or moved to a
Trash folder, depending on the content server configuration (specifically, its folders
component). For more information, see About Deleting Libraries, Folders, and
Documents in Using Oracle WebCenter Content.

To delete a library or folder, you must be the owner of the library or folder or have
Delete permission for the library's or folder's security group, and you must have Delete
permission for the security groups of all subfolders and content items within the library
or folder.

If you have permission to delete a library or folder, the library or folder and all its
contents will be deleted from the content server. If, during the delete process, the
system encounters content that you do not have permission to delete, the delete
process will end at that item, and the remainder of the content in the library or folder
will be retained.
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You cannot delete the main nodes of an Oracle WebCenter Content Server instance
(such as My Content Server, Browse Content, and so on, or Enterprise Libraries,
Favorites, My Checked-Out Content, and so on).

All libraries, folders, and content items that are deleted are moved into the Trash
folder. You can select multiple libraries or folders from the Trash folder and delete
them permanently or restore them back to the file repository. Click Delete
Permanently to delete libraries, folders, or content items permanently. Click Restore
to restore a deleted library, folder, or content item that have been already deleted.
Click Yes to confirm the restore.

In addition to these options, Desktop also allows you to restore a particular revision of
a content item. Each content item may be revised multiple times and when you delete
this content items, all the revisions are also moved into the Trash folder. Click Restore
Revision to select and restore a particular revision or click Restore to restore the
latest revision of a content item. Click Permanently Delete to permanently delete one
or more revisions.

Note:

Trash folder feature is available only if it is enabled for your version of Oracle
WebCenter Content Server.

4.22 How do I view and modify library, folder, and file
information and properties?

You can view information and properties for libraries, folders, and files. You can
sometimes also change the information and properties.

To view and change information and properties:

1. Select the library, folder, or file whose information or properties you want to view
or modify.

You can now see information about the selected item in the preview pane. If you
make any changes to the information here, you can save them by clicking Save.
The changes take effect immediately.

2. Right-click the item and choose one of the following menu items:

• Library Information, Folder Information or Content Information. For
WebCenter Content user interface, the information is divided between tabbed
pages that may have selection and editing controls. If you are changing the
profile metadata for a content file, click the Edit button. If you make any
changes, you can save them by clicking Save. The changes take effect
immediately. For native 11g user interface, on the information page, open the
Folder Actions menu (for folders) or the Content Actions menu (for files),
then choose Update. You may also be able to right-click the folder or file in the
navigation pane or content pane and choose Update Metadata. If you make
any changes, you can save them by clicking Submit Update.

• Properties. The Folder Properties dialog or Content Item Properties dialog
opens. These are basically standard Windows properties dialogs, with some
added content management information. You can change the folder or file
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name in the Name field. The name change will take effect immediately. The
name is also changed on the content server, which means that everyone using
that server who views the folder or file will see it by its new name. Click OK
when you are done.

• Advanced Properties. A folder or content information window opens showing
general Oracle Content Database properties of the selected folder or file.

• Sharing. A folder or content information window opens showing the sharing
Oracle Content Database properties of the selected folder or file. Depending
on your assigned security privileges, you can determine which users have
access to that folder or file and which roles they have been granted.

Libraries are available only if you are connected to a WebCenter Content Server 11g
instance running the WebCenter Content user interface.

Tips

• You cannot modify the file extension on a content server. Due to this restriction,
Windows Explorer does not allow you to rename the file extension.

• Be careful when changing the security group of a library, folder, or file. If you
assign these to a more restrictive security group, authors may no longer have
permission to manage their own content items.

• The right-click menu options described above are mostly also available from the
File menu.

• If you are using Windows Explorer, you can change which columns are displayed
in the content pane, for example by right-clicking any heading then choosing the
columns to be shown from a list. In Windows 7, this change to the column
headings will be temporary, unless you also select Folder Options from the Tools
menu, then click Apply to Folders on the View tab.

4.23 How do I propagate library and folder metadata?
You can copy the metadata of a library or folder on an Oracle WebCenter Content
Server instance to all its sublibraries, subfolders, and files. This feature is available
only if the content server administrator has enabled it on the server and if you have the
required permission level. To propagate metadata to content items in a folder, you
must have Write permission for the library or folder and the content items themselves.
To propagate to any libraries or folders below the library or folder in the hierarchy, you
must have Delete permission for the libraries or folders or be the author and have
Write permission.

The content ID and title of items are always considered properties specific to those
items and are never automatically propagated. Also, a library or folder can be
excluded from metadata propagation from a higher-level one by setting its Inhibit
Propagation property on the Hierarchical Folder Configuration page to 'True'.

To propagate the metadata of a library or folder to all underlying libraries, folders, and
files:

• Right-click the library or folder whose metadata you want to propagate, then
choose Propagate.

If the content server is running Framework Folders or the WebCenter Content user
interface, a dialog opens where you can specify which metadata fields and values you
want to propagate before starting the process.
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Otherwise, all metadata fields and values are propagated.

The (selected) library or folder metadata is now copied to all underlying libraries,
folders, and files, unless a library or folder was specifically excluded from metadata
propagation on its configuration page (using the Inhibit Propagation property).

4.24 How can I copy content file links?
You can copy URL links to one or more content items on a server to the Windows
clipboard and paste that information into an email message, text editor, Microsoft
Office document, or another business document. For files on an Oracle WebCenter
Content Server instance, three URL links are copied for each content item: to the web-
viewable file, the native file, and the content information page. For files on an Oracle
Content Database server or other WebDAV server, only one link is copied: the URL of
the file on the server.

To copy content file links, select one or more files on the server, right-click, and
choose Copy Links. Alternatively, for a single file, open the File menu and choose
Copy Links. The link information is copied into the Windows clipboard, so that you
can easily paste it into another file or application.

4.25 How do I work with workflows on content server
instances?

Workflows on Oracle WebCenter Content Server instances specify how content is
routed for review and approval before it is released and made available to other users
on the server for viewing or check-out. Users on the server do not have access to a file
until it successfully moves through the entire workflow. If you have been designated as
a reviewer for a content item, you are notified by email when you have a file to review.

4.25.1 How do I view all the workflow assignments?
You can view all your current workflow assignments for an Oracle WebCenter Content
Server instance in one convenient list in Microsoft File Explorer. This list shows all files
currently in a workflow that you are assigned to review. You can approve or reject the
files directly from the list.

To see a list of all your current workflow assignments on a content server:

1. Open the WebCenter Content Servers node in Microsoft File Explorer, making
sure that the navigation pane is visible.

2. Select the server for which you want to see all your workflow assignments.

3. Find and select the My Workflow Assignments folder. This folder may be nested
beneath the Users folder.

The content pane lists all files on the server that you have currently been assigned to
review. You can work with the files in this list directly to review them.

Tips

• If the server does not have a folder called My Workflow Assignments, then
workflow assignments may not be enabled on the server, or the server is not a
supported type.
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• The My Workflow Assignments list matches that in Oracle WebCenter Content
Server's web interface (under My Content Server).

4.25.2 Approving or Rejecting Files in Workflows
If you are designated as a reviewer in a workflow, you must approve or reject all files
in that workflow.

To approve or reject a file in a workflow:

1. Open the My Workflow Assignments folder.

The folder contains all files on the server that you have been assigned to review.

2. Open the document to be reviewed in its associated application.

If the workflow step was set up to allow editing of the content item, you can make
changes, and check in new revisions.

If the workflow step does not allow file editing, you can review the file, but not
make any changes. (If you do change the file, you can check it in only as a new
content item.)

3. When you are done reviewing the file and making changes (if allowed and where
required), save and close the file.

4. When you are ready to approve or reject the file, right-click it in the My Workflow
Assignments folder, then choose either Approve or Reject. These options are
also available on the File menu.

If you choose Approve, a dialog may open where you can electronically sign and
approve the file. This happens only for files that require an electronic signature. For
files that do not require an electronic signature, the file is approved immediately. After
you have approved the file, the file moves to the next step in the workflow.

If you choose Reject, a dialog opens where you must provide a reason for rejecting
the file. After you click OK, the file is sent back to the most recent workflow step that
permitted contribution. The users assigned to that contribution step receive an email
notification, so they can edit the file and submit it for review again.

Tips

• For WebCenter Content user interface, if you are using Microsoft Office
applications, you can approve or reject workflow items within those applications.

• You will typically receive an email notification that you should review a content
item on the server.

• A content item in a workflow is not available to other users on the server until it
successfully moves through the entire workflow.

4.25.3 Removing a File From Your WorkFlow Assignments
For WebCenter Content user interface, you can remove a file from your list of workflow
assignments. Selecting this option does not change the document's workflow status. If
a subsequent workflow step assigns the document to you, it will again appear in your
list. If you need to reinstate an item to your list, you must do so through the server's
web interface.

To remove a file from your workflow assignments:
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1. Select the file in the My Workflow Assignments folder.

2. Right-click the file and select Remove From Your Assignments.

This option is also available from the File menu.

3. Read the confirmation dialog to make sure the intended file will be affected, then
select OK.

You can select more than one file at a time to be removed from your workflow
assignments. If you do this, a confirmation dialog will appear, one at a time, for each
file.

4.26 How can I access the content server files in offline
mode?

You can access content server files in online mode or in offline mode. In online mode,
you need a live connection to the content server to have access to the folders and files
on it. You log in to the server and then you have access to all folders and files in
accordance with your assigned privileges.

In offline mode, files you have chosen to make available offline are accessed as read-
only copies from a special cache location on your local computer. You can then view
these files even if you are not connected to the content server. This may be useful in
situations where you need access to files, but you cannot connect to the server that
they reside on. For example, you may need read-only access to a report or a
presentation you are giving while traveling. In this case you could obtain a copy of the
current version of the report before you disconnect from the server, and then have
read-only access to that file while working offline.

Marking files as available offline is performed on a snapshot of the folder they are in. If
you add any new files to the folder, these are not automatically made available offline.
You must make the folder available offline again to include the new files in the folder.

Files that are available offline show a cylinder in their file icon, which can be either
blue or gray (Figure 4-5). In addition, the Available Offline option in the file's context
menu has a check mark.

Figure 4-5    Offline Availability Icons

The cylinder is blue if your locally cached file is up to date with the file on the content
server; that is, no new revision has been checked in to the content server since you
selected the file for offline availability.

The cylinder is gray if the offline and online files do not match. This would, for
example, be the case if someone updated the original file on the content server, and
your local copy is still an older revision; in other words, out of date.

When online, you can update the files in an offline folder. All offline files in that folder
are then overwritten with the most recent revisions of those files on the content server.

You must change to offline mode before you can work on the files that are stored in
your local cache, rather than the files that are stored on the server. After going to
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offline mode, you can access not only the files and folders that you have specifically
made available offline, but also files and folders that you have checked out.

In offline mode, the content server has an Offline Files folder, which lists all files on
that server that are offline, including those that are not in a content folder. You can
interact with these files directly from the list.

Making Folders and Files Available Offline

You make folders and files available for offline use by selecting and right-clicking
them, then choosing Make Content Available Offline (for folders) or Available
Offline (for files).

Refreshing Offline Files

The offline copy of a file is not automatically updated. This means that if a new file
revision is checked in to the content server, your local copy is out of date. This is
indicated by a gray cylinder overlay on the file icon (Figure 4-5).

You can refresh offline files by right-clicking the folders they are in and choosing
Refresh Offline Content. This updates the files to their latest released revisions on
the content server.

Any files that were added to a folder after it was made available offline will not be
made available offline if you refresh that folder. For that to happen, you must right-click
the folder and choose Make Content Available Offline.

Changing to Offline Mode

Change to offline mode by selecting the content server name under the WebCenter
Content Servers folder, right-clicking, then choosing Work Offline. You must do this
before you can work on the files stored in your local cache (your offline files).

You can tell that you are working in offline mode by the fact that the Work Offline
option has a check mark against it. In addition, the server icon may show a red offline
indicator (Figure 4-6).

Figure 4-6    Offline Oracle WebCenter Content Server (native 11g user interface)

Viewing or Opening Offline Files

You view or open offline files exactly as you would any other files. One way is to select
the offline file, right-click it, then choose View (for read-only mode) or Open with... (for
full edit mode).

To find all offline files on a server in one place, open the Offline Files folder (if
available). The Offline Files folder may be visible only when the server is in offline
mode.

Removing Offline Folders and Files

You remove offline folders and files by selecting and right-clicking them, then choosing
Remove Offline Content.
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The selected files and folders are removed from the local cache and they are no
longer available offline. This does not affect the original files and folders on the content
server; they remain available.

Changing Back to Online Mode

When you have finished working offline and are ready to reconnect to a server, right-
click the server and click Work Offline. This unchecks the context menu option. You
may then have to log in to the server by entering your user name and password.

Tips

• When using the WebCenter Content user interface, any folders that you made
available offline are shown beneath the Other Folders node. These folders and
subfolders contain the files that you can work on offline.

• For files in a folder to be made available offline, the files must actually reside in
that folder. This means that you cannot make the files in query folders available
offline, because the contents of query folders do not actually exist there. The
actual files may exist under a different folder location, or they may not even appear
in a 'standard' folder at all.
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5
Microsoft Office Integration

This chapter describes how Desktop client integrates Oracle WebCenter Content into
Microsoft Office applications.

This section covers these topics:

• How does Desktop client integrate Oracle WebCenter Content into Microsoft
Office applications?

• How do I open and view an existing document?

• How can I reopen a recently opened document?

• How do I check out a document that is in Read-Only (View) mode?

• How do I open a different revision of a document?

• How do I refresh a document?

• How do I create a new document and check it in to a content server?

• How do I check in a managed document while editing it?

• How do I check in a managed document when closing it?

• How do I turn an unmanaged document into a managed document?

• How do I turn a managed Microsoft Office document into an unmanaged
document?

• How can I insert links, files, and images into Microsoft Office documents?

• How can I compare two revisions of the same Word document?

• How can I compare a Word document with another document?

• How do I approve or submit Microsoft Office documents in workflows?

5.1 How does Desktop client integrate Oracle WebCenter
Content into Microsoft Office applications?

The Desktop client software enables you to interact with content servers and the files
on them directly from Microsoft Word, Excel, and PowerPoint. You can perform a
number of content management tasks, including opening Microsoft Office documents
from a content server ("check out"), saving documents to a server ("check in"),
searching for documents on a server, comparing document revisions on a server, and
inserting files on a server or links to these files into the current document.

Note:

Not all these features may be available in all Microsoft Office applications and
for all content servers (depending on their server type and version).
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5.1.1 Integration into Microsoft Office
The Desktop client software integrates Oracle WebCenter Content into Microsoft
Office applications in the following ways:

• It adds a ribbon called WebCenter Content to the Microsoft Office application
interfaces.

• In versions of Microsoft Office that include a File tab, Desktop adds Oracle
WebCenter Content options as follows:

– In Microsoft Office 2010, Desktop adds WebCenter Content Options directly to
the File tab.

– In Microsoft Office 2013, Desktop adds Oracle WebCenter Content options to
the Open and Save As pages, as well as to a new WebCenter Content page.
These pages are available from the File tab.

5.1.2 The WebCenter Content Ribbon

Figure 5-1    WebCenter Content ribbon in Microsoft Word 2007

The WebCenter Content ribbon includes the following groups and options (the options
are explained in The WebCenter Content Options):

• Open:

– Open

– Recent Content Items

– Revisions

• Manage:

– Check Out

– Refresh

– Unmanage

• Check In:

– Check In

– Check In With Metadata

• Save As New:

– Save As New

• Compare: (available only in Microsoft Word)
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– With Revision

– With Content Item

• Insert:

– Insert

• WebCenter:

– Options:

* Edit Server List

– Help Contents

– About

5.1.3 File Tab Options
In versions of Microsoft Office that include a File tab, Desktop adds WebCenter
Content options, either directly to the tab or to pages accessible from the tab. The
options are explained in The WebCenter Content Options.

Microsoft Office 2010

The following options are added to the File tab:

• WebCenter Save As New

• WebCenter Open

• WebCenter Content:

– WebCenter Content Open

– WebCenter Content Check Out

– WebCenter Content Save [As New]

– WebCenter Content Check In

– Check In With Metadata

Microsoft Office 2013

The following options are added to pages accessible from the File tab:

• On the Open page:

– WebCenter Content - WebCenter Content Open

• On the Save As page:

– WebCenter Content - WebCenter Content Save [As New]

• On the WebCenter Content page:

– WebCenter Content Open

– WebCenter Content Check Out

– WebCenter Content Save [As New]

– WebCenter Content Check In

– Check In With Metadata
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5.1.4 The WebCenter Content Options
In Microsoft Office applications, the Desktop client software adds the following options
to the WebCenter Content menu or ribbon, or to the File tab and its pages, as
available:

• Open: This option opens a dialog where you can locate a file on a content server
and open it in the current Microsoft Office application. The file is checked out of
the content server. For more information, see How do I open and view an existing
document?.

• Recent Content Items: This option opens a menu that lists a number of content
items on Oracle WebCenter Content Server instances that were most recently
opened in the Microsoft Office application. You can conveniently reopen a
document by selecting it in the list. For more information, see How can I reopen a
recently opened document?.

• Revisions: This option opens a dialog where you can choose a particular revision
of the managed file to be opened in the current Office application. For more
information, see How do I open a different revision of a document?.

• Check Out: This option checks the currently open read-only Office document out
of the content server, so you can make changes and check it back in to the server
as a new revision when you are done. For more information, see How do I check
out a document that is in Read-Only (View) mode?.

• Refresh: This option updates the currently open managed Office document to the
latest revision on Oracle WebCenter Content Server. For more information, see 
How do I refresh a document?.

• Unmanage: This option removes the managed status of the current Office
document and turns it into an unmanaged document, which means you can no
longer check it in to the content server as a revision of the existing document. For
more information, see How do I turn a managed Microsoft Office document into an
unmanaged document?.

• Check In: This option checks the current Office document back in to the content
server as a new revision using its existing metadata. (This option is available only
if the current document is already managed by a content server.)

• Check In With Metadata: This option opens a dialog where you can modify the
metadata of the current Office document before checking it in to the content server
as a new revision. (This option is available only if the current document is already
managed by a content server.)

• Save As New: This option opens a dialog where you can check the current Office
document in to a content server as a new content item. For more information, see 
How do I create a new document and check it in to a content server?.

• [Compare] With Revision: This option enables you to compare the current Word
document with a different revision of the same document on the content server. If
you choose this option, a dialog is opened where you can select the document
revision that you want to compare the current Word document with. (This option is
available only if the current Word document is a managed content item.) For more
information on the document comparison feature, see How can I compare two
revisions of the same Word document?.

• [Compare] With Content Item: This option enables you to compare the current
Word document with a different document on the content server. If you choose this
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option, a dialog is opened where you can locate a file on the content server to
compare to the document currently open in Microsoft Word. For more information
on the document comparison feature, see How can I compare two revisions of the
same Word document?.

• Insert: This option opens a dialog where you can select one or more files on an
Oracle WebCenter Content Server instance for insertion into the current Microsoft
Word, Excel, or PowerPoint document (at the current cursor position). You can
insert links to files on a server, the contents of files, or images. For more
information, see How can I insert links, files, and images into Microsoft Office
documents?.

• Edit Server List: This option opens a dialog where you can add, view, and delete
server connections. For more information, see Working with Content Server
Connections.

• Help Contents: This option launches the Desktop online help in your standard
web browser.

• About: This option opens a dialog that provides version information about the
Desktop client software.

5.2 How do I open and view an existing document?
You do not use the Microsoft Office application's standard file-open features to open or
view a managed document. Instead, you use the special WebCenter Content Open
option:

1. In the Microsoft Office application (Microsoft Word, PowerPoint, or Excel), open
the WebCenter Content menu or ribbon, then choose Open, or choose
WebCenter Content Open from the File tab or Open page, as available.

2. In the Select Content dialog, select the Edit or View option, depending on which
edit mode you want for the document:

Edit: The document is checked out of the server and opens in full edit mode. You
can make changes to the document as required and when you save the document
you can check it back in to the server as a new revision of the existing content
item. While the document is checked out, it is locked on the content server, and no
other user can check out the file until you either check it back in or cancel its
checked-out status ("undo the check-out").

View: The document is not checked out of the server and it opens in read-only
mode. You can make changes to the document, but you will have to save it as a
new file (with a new file name) and check it in to the server as a new content item.
If a document opens in view mode, you will see "(Read-Only)" following the file
name in the application title bar.

3. Browse to, or search for, the Microsoft Office document on the server that you
want to open, select it, then click OK.

Tips

• Make sure that you select a file that is compatible with the current Microsoft Office
application (for example, a word-processing document for Microsoft Word).

• If the document is already in your local cache (typically because you checked it out
and edited it earlier, but did not yet check it back in to the server), it opens from
there; otherwise, the latest released revision on the content server opens.
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• You can also open or view a managed Microsoft Office document from its context
menu or the File menu in Windows Explorer.

5.3 How can I reopen a recently opened document?
You reopen a managed Microsoft Office document you worked on earlier by opening
the most recently used list and selecting the file you want to open.

The most recently used list is in the Recent Content Items drop-down menu in the
WebCenter ribbon.

Tips

• If the document was last opened in read-only mode ('view'), you are asked
whether you want to open it in read-only mode again or if you want it opened in full
edit mode ('open').

• If you hover the mouse cursor over a list item [in Office 2007 -2013], you see the
content ID of the file as well as the server it resides on.

• Managed documents do not appear in the Documents list on the Windows Start
menu.

5.4 How do I check out a document that is in Read-Only
(View) mode?

You check out a managed document from within a Microsoft Office application by
using the Check Out option in the WebCenter Content menu or ribbon, or by using the
WebCenter Content Check Out option from the File tab or WebCenter Content page,
as available.

What happens depends on the state of the managed document that is currently open
in the Microsoft Office application:

• If the document currently open is the latest revision on the server and it is
not already checked out

The document is checked out of the server and its read-only status is revoked.
You can now edit the document as required and check it back in to the server as a
new revision of the existing content item.

• If the document currently open is not the latest revision on the server

You are presented with two options: (1) download, check out, and edit the latest
revision from the content server, or (2) continue to edit the current, outdated copy
on your local computer. This situation could, for example, have arisen if you were
emailed a managed Word document and someone has checked a new revision of
that document in to the content server by the time you are ready to check in your
document. You can edit the document as required and check it back in to the
server as a new revision of the existing content item.

• If the current document is not the latest revision and there is already a
modified version of the document in your local cache

You are presented with two options: (1) close the current document and edit the
previously modified copy in your local cache instead, or (2) edit the current copy
and discard all previous modifications (as stored in the locally cached copy). This
situation could, for example, have arisen if you checked out a document and made
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changes, saved and closed the document without checking it in, and then viewed
any revision of the document from the server.

Tips

• If you do not check out the document, you can still make changes to it, but you
cannot check it back in to the server as a new revision of the existing content item.
Instead, you can check it in as a new content item using the Save As New option.

• A managed document that is open in a Microsoft Office application might not have
been checked out of the content server in the following situations:

– You opened it from a content folder in view mode. This downloads a copy of
the managed document from the server to your local cache, but does not
check it out.

– You open it from your local file system (for example, saved as an email
attachment). Desktop detects it is a managed document, but does not check it
out.

• After you check out a read-only document, the "(Read-Only)" indicator in the
application title bar disappears. In addition, the information bar changes to reflect
the new document state.

• You cannot check out a read-only document if it is in a file format that does not
support embedded Microsoft Office properties (such as RTF, XML, or plain text).

• The Check Out option is not available if you cannot check out the current read-
only document.

5.5 How do I open a different revision of a document?
When you open a managed Microsoft Office document that has multiple revisions, you
can choose to open a different document revision instead of the current one.

You open a different revision by opening the managed document, choosing Revisions
from the WebCenter Content ribbon, selecting the document revision you want to
open and clicking OK.

The currently open document is replaced with the selected document revision, in read-
only mode.

Tips

• Opening a different revision may be useful if you opened a document that may
have newer revisions on the server; for example, because it was emailed to you as
an attachment some time ago and newer revisions may have been checked in
after that. There may also be situations where you may want to open an older
document revision than the one you opened in the Microsoft Office application.

• If you want to edit the document and save it as a new revision of the existing
content item on the server, you must check it out first by selecting the Check Out
option in the WebCenter Content menu or ribbon. Otherwise you can only check it
in as a new content item.

• You can avoid the situation of obsolete document attachments by emailing links to
content items rather than the files themselves. This works only if the file recipient
has access to the content server that stores the attached file.
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5.6 How do I refresh a document?
When you open a managed document, you can refresh it to show the latest revision
from the content server.

You refresh the current managed document by opening the WebCenter Content menu
or ribbon and choosing Refresh.

The latest revision of the current managed document is then downloaded from the
server and opens in the Microsoft Office application (replacing the old revision). You
can then edit the document as required and check it back in to the content server as a
new revision of the existing content item.

Tips

• Refreshing a document may be useful if you opened a document that may have
newer revisions on the server; for example, because it was emailed to you as an
attachment some time ago and newer revisions may have been checked in after
that.

• You can avoid the situation of obsolete document attachments by emailing links to
content items rather than the files themselves. This works only if the file recipient
has access to the content server that stores the attached file.

5.7 How do I create a new document and check it in to a
content server?

If you create a new document in a Microsoft Office application, you can check it in to a
content server. This uploads and submits the file to the server and makes it available
to other users from there in accordance with their assigned access privileges.

You check in a newly created document by choosing Save As New from the
WebCenter Content ribbon, or by using the WebCenter Content Save [As New]
option from the File tab or Save As page, as available. This opens the Save dialog,
which lets you check in the document either by using a check-in form or by selecting a
folder on a server where the document should be saved.

Tips

• The file name that you specify for the checked in document will also be the content
item title (minus the file extension).

• By default, the file is closed in the Microsoft Office application after it is checked in
to a content server. Select the Reopen after check-in check box if you want the
document to be reopened automatically after it is checked in. (The file is not only
reopened but is also checked out of the content server again.) This is useful if you
want to continue to work on the document after check-in.

5.8 How do I check in a managed document while editing it?
You can check in a managed document at any point during editing by choosing Check
In from the WebCenter Content menu or ribbon, or WebCenter Content Check In
from the File menu or WebCenter Content page, as available. You may be asked to
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provide a comment in a Check-In Comment dialog. If you have any unsaved changes
in your document, these are saved before the check-in.

For WebCenter Content 11g server, using the Check In feature automatically uploads
the document to the content server and creates a new revision of the content item.

For Oracle Content Database servers and WebDAV servers, using the Check In
feature automatically uploads the document to the content server and overwrites the
existing file.

The Check In option is not available for read-only managed documents, since you
must check these in as new content items (Save As New).

Tips

• If you want to carry on editing the document after it has been checked in, you must
select the Reopen after check-in option on the Check In Comment dialog.

• Simply saving the document (for example, by pressing Ctrl+S) will update it in the
Desktop cache on your computer, but will not check it in.

• New revisions inherit all metadata from the previous revision. If you want to modify
the metadata before checking the managed document in to the server, choose
Check In With Metadata (from the WebCenter Content menu or ribbon, or from
the File tab or WebCenter Content page) to open a check-in dialog. After the
check-in, the document is closed automatically.

• You can check files in to a server only if you checked out that file yourself, or if you
have administrator privileges for that server.

5.9 How do I check in a managed document when closing
it?

You will usually be able to check in a document as you close it or exit its application.
This is when a special document close dialog is shown, giving options for saving
changes, checking in, editing metadata, and undoing the check-out. (Alternatively,
your computer may have been configured to not show the special dialog, in which
case managed documents will be closed in the same way as unmanaged documents.)

If you choose to check in a document without editing its metadata, the metadata from
the previous revision is reused.

Documents that are saved but not checked in are stored in a special cache on your
local computer.

After a document has been checked in to the server or saved to the local cache, it is
closed in the Microsoft Office application.

If you save a document but do not check it in at the same time, other users on the
server cannot check out the file until you check it back in or undo the check-out.

If you choose the Undo Check-Out option (which is only available if you have made
no changes, or if you have made changes but you are choosing not to save them), the
checked-out status of the content item is cancelled on the server, which means that
other users on the server can check out the file.

If the special close dialog is not being used on your computer, you will simply be
prompted to save any unsaved changes before the document is closed. If there are no
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unsaved changes, the document will simply close. In either case, the document is
stored in a special cache on your local computer and is not automatically checked
back in to the content server. Other users cannot check out the document until you
check it back in or undo the check-out.

Tips

• Use the application's built-in Save As feature if you want to save the file in a
different location than the local cache (that is, as an unmanaged file on your own
computer).

5.10 How do I turn an unmanaged document into a
managed document?

If you have an existing, unmanaged Microsoft Office document on your local computer,
you can check it in to a content server and make it available to the users on that server
according to their assigned access privileges.

You turn an unmanaged document into a managed document from within a Microsoft
Office application by selecting the WebCenter Content ribbon and choosing Save As
New, or by choosing WebCenter Content Save [As New] from the File tab or Save
As page, as available. This opens the Save dialog, which lets you check in the
document either by using a check-in form or by selecting a folder on a server where
the document should be saved.

Tips

• The file name that you specify for the checked in document will also be the content
item title (minus the file extension).

• By default, the file is closed in the Microsoft Office application after it is checked in
to a content server. Select the Reopen after check-in check box if you want the
document to be reopened automatically after it is checked in. (The file is not only
reopened but is also checked out of the content server again.) This is useful if you
want to continue to work on the document after check-in.

5.11 How do I turn a managed Microsoft Office document
into an unmanaged document?

After you have opened a managed Microsoft Office document, you can 'unmanage'
that document; that is, remove the document properties that associate it with a
particular content server. This effectively turns the document into a brand-new,
unsaved document that you cannot check back in to the server as a new revision of
the original document. You can, of course, check it in to the server as a new content
item (using the Save As New option), or you can save it as a local file. The original
content item remains available on the content server.

To turn the current managed document into a new, unmanaged document, open the
WebCenter Content menu or ribbon and then choose Unmanage and click OK in the
dialog reminding you of the consequences of this action.
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5.12 How can I insert links, files, and images into Microsoft
Office documents?

Desktop ties in to the built-in object insertion features of Microsoft Office applications
by enabling you to insert items from Oracle WebCenter Content Server instances into
Word, Excel, and PowerPoint documents. You can insert links to files on a server, the
actual contents of files from a server, or images from a server. The items are always
inserted at the current cursor position in the Microsoft Office document. The Microsoft
Office document into which you insert managed content or links to managed content
do not have to be managed documents themselves.

To insert links, files, and images on an Oracle WebCenter Content Server instance
into the current Microsoft Office document:

1. Move the cursor to the position in the Microsoft Office document where you want
to insert one or more links.

2. On the WebCenter Content ribbon, choose Insert in the Insert group.

3. On the Insert Content Item dialog, open the panel for the type of insertion you
want to make: link, file, or image. (Your selection will be remembered for the next
time you make an insertion, but you can change it.)

4. Click Browse to open the Select Content dialog, where you can locate and select
the file that you want to link to or insert, or the image that you want to insert.

You can select multiple files at the same time. When searching for files, select the
check box for each item in the search results list that you want to include. When
browsing to files in content folders, hold the Shift key for consecutive selections
and Ctrl for non-consecutive selections. Click OK when you are done.

After you have selected the file or files you want to link to or insert, the Content
Item field in the Insert Content Item dialog shows their content IDs. If you selected
multiple files, the Content Item field shows the content ID of the first selected file,
and you can use the drop-down list to go to a different file.

5. Complete the fields on the selected panel of the Insert Content Item dialog. See
the online help for an explanation of the fields.

6. Click OK to insert the link, file, or image into the Microsoft Office document.

5.13 How can I compare two revisions of the same Word
document?

If the current managed Word document resides on an Oracle WebCenter Content
Server instance and it is not a read-only copy, you can compare it with a different
revision of the same document.

With the managed document open in Microsoft Word, choose With Revision from the
Compare group of the WebCenter Content ribbon. If the option to choose a different
revision is not available, then the current document is either not managed by a content
server or it is currently in read-only mode.

From the Select Revision dialog, select the revision that you want to compare the
current document with, then click OK.
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Microsoft Word's built-in comparison features are now used to compare the current
document with the revision that you selected, and the changes are shown in a new
document. Exactly how the changes are represented depends on the version and
configuration of your Microsoft Word application, but insertions and deletions are
typically shown in different colors and formatting for easy identification.

Tips

• The top of the Select Revision dialog shows which revision is currently open in
Microsoft Word, along with some information about the content item (title, server,
content ID, author, and the like). At the bottom is a list of all existing revisions of
the content item, along with their title, author, release date, and comments. If you
would like to see more information about any particular revision, select that
revision in the list and choose Content Information... to open that revision's
content information page on the server.

• If you hover your mouse cursor over a marked change in the document, a screen
tip is displayed providing content management information about that file, as
shown in Figure 5-2. The following information is provided: the content ID, file size,
and, if the file is currently checked out, the user name of the person who checked
it out.

Figure 5-2    screen Tip Showing Information About File Change

5.14 How can I compare a Word document with another
document?

You can compare the current Word document (managed or unmanaged) with a
different document on the content server.

With the document open in Microsoft Word, choose With Content Item from the
Compare group of the WebCenter Content ribbon.

Using the Select Content dialog, select a Word document on a content server, then
close the dialog.

Microsoft Word's built-in comparison features are now used to compare the current
document with the file that you selected, and the changes are shown in a new
document. Exactly how the changes are represented depends on the configuration of
your Microsoft Word application, but insertions and deletions are typically shown in
different colors and formatting for easy identification.

Tips

• If you want to compare the current managed Word document with a document on
your local computer (not stored on a content server), simply use Word's built-in
compare feature to select the file.
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5.15 How do I approve or submit Microsoft Office
documents in workflows?

The Microsoft Office integration in the WebCenter Content user interface provides
additional check boxes for workflow approval or submission on the dialog you see
when you close a document or exit the application.

Workflows can be set up to require electronic signatures during the approval or
submission of documents. Electronically signed documents are more secure because
the server is able to tell them apart from other versions of those documents, and will
not allow unauthorized versions through the workflow steps. You sign a document
electronically by entering your login credentials, as explained in the procedures below.

Check In and Approve the Document

If the workflow step was set up to allow editing of the document, you can make
changes and then approve it while checking it in as a new revision.

With the document open in its Microsoft Office application, and after you have
reviewed and edited the document as required, choose either Check In or Check In
With Metadata from the WebCenter Content ribbon.

If available, select the Check in and approve check box on the Check-in Content
dialog. This check box will not be available if the document requires an electronic
signature for workflow processing. In this case, locate the document in Windows
Explorer and use its context menu to sign and approve the document.

Complete the other areas of the Check-in Content dialog as required, then click OK.

Submit the Document for Review

If the workflow step does not allow editing, you can review the Microsoft Office
document without making any changes, then submit it for review.

With the document open in its Microsoft Office application, and after you have
reviewed the document as required, choose either Check In or Check In With
Metadata from the WebCenter Content ribbon.

If available, select the Submit document for workflow review check box on the
Check-in Content dialog. This check box will not be available if the document requires
an electronic signature for workflow processing. In this case, locate the document in
Windows Explorer and use its context menu to sign and approve the document.

Complete the other areas of the Check-in Content dialog as required, then click OK.

Tips

• If you exit the application or close the document without first checking it in, you can
use the Close Document dialog to check in and approve it, or submit it for review.
To do this, select the Check in and approve check box or the Submit document
for workflow review check box on the Close Document dialog, when it appears.
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6
Microsoft Outlook Integration

This chapter describes how Oracle WebCenter Content: Desktop integrates with
Microsoft Outlook.

This section covers these topics:

• What is Email Client integration in Microsoft Outlook?

• How does Desktop integrate with Microsoft Outlook?

• How do I preserve email messages and attachments on a content server?

• How can I retrieve and read preserved messages and attachments?

• How do I send messages that contain attachments and links to content server
files?

• How can I create a new message with links to the file?

• How can I view all my workflow assignments?

• How do I work with Distribution Lists?

• What are the background and setup information needed to connect to a content
server?

6.1 What is Email Client integration in Microsoft Outlook?
You can check email messages and their attachments in to a content server directly
from Microsoft Outlook to preserve them and share them with others in your
organization. In Microsoft Outlook, you can drag and drop messages directly into
content folders on a server, or you can use a special content check-in form (Oracle
WebCenter Content Server only). You can also attach managed content items from
the server as well as links to them to your outgoing messages.

Checked-in messages are not intended to be checked out, modified, and checked
back in. Messages are checked in to a content server for the express purpose of
preserving them exactly as they were received. You can open a checked-in message
from a server to view it in your default email application. You can even make changes
if you want, but you cannot check it back in to the server. You can, however, send the
message to other people or save a copy on your local computer.

6.2 How does Desktop integrate with Microsoft Outlook?
Desktop adds some of the following integration features to Microsoft Outlook,
depending on which version of Microsoft Outlook you are using.

WebCenter Content Servers Directory

This is added to the list of mail items in the mail folders pane.

To show the mail folders pane, open the View menu, then choose Navigation Pane,
then choose Normal.
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To show the WebCenter Content Servers directory, open the WebCenter Content
menu or ribbon, choose Email Integration Settings..., then select Show WebCenter
Content Servers. Click OK to return to Microsoft Outlook. You must now restart
Microsoft Outlook for the change to take effect.

WebCenter Content Menu

A menu called WebCenter Content is added to the menu bar in Microsoft Outlook
2002, 2003, and 2007.

This menu contains the following items:

• Check In Mail Item... opens a dialog where you can check the currently selected
message in to a content server.

• Check In Distribution List... opens a dialog where you can check an email
distribution list in to a content server.

• Email Integration Settings... opens a dialog where you can set a number of
configuration options for the email client integration.

• Email Integration Help launches the Desktop online help in your standard web
browser.

• About WebCenter Content: Desktop... opens a dialog that provides version
information about the Desktop client software.

WebCenter Content Toolbar

A toolbar called WebCenter Content is added to Microsoft Outlook 2002, 2003, and
2007. If you do not see the toolbar, you can display it by selecting View, then
Toolbars, then WebCenter Content.

The toolbar items depend on the application context. In the main Microsoft Outlook
window, the WebCenter Content toolbar contains the following option:

• Check In Mail Item opens a dialog where you can check the currently selected
message in to a content server. (You can also use the WebCenter Content menu
to do this.)

In a message editing window (new message or forward message), the WebCenter
Content toolbar contains the following option:

• Get Attachment opens a dialog where you can select a file on a content server to
be attached to the current message or embedded in the message as a link.

WebCenter Ribbon

A ribbon called WebCenter Content is added to Microsoft Outlook 2010 and 2013.

This ribbon includes the following groups and options:

• Check In

– Check In Mail Item opens a dialog where you can check the currently
selected email message in to a content server.

– Check In Distribution List opens a dialog where you can check an email
distribution list in to a content server.

• Misc

– Email Integration Settings opens a dialog where you can set a number of
configuration options for the email client integration.
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– Help Contents option launches the Desktop online help in your standard web
browser.

– About WebCenter Content: Desktop opens a dialog that provides version
information about the Desktop client software.

Insert and Message Ribbons

A Get Attachment item is added to the Insert and Message ribbons in Microsoft
Outlook 2010 and 2013. This item opens a dialog where you can select a file on a
content server to be attached to the current message or embedded in the message as
a link.

Content Pane and Preview Pane

The integration with Microsoft Outlook lets you drag and drop messages into content
server folders, copy and paste messages, create shortcuts, and so on.

When you select an object in the WebCenter Content Servers directory in the mail
pane, the contents of that object are displayed on the right, in the content pane. It may,
for example, show a list of all files in the current content folder.

Managed content files listed in the content pane may have a symbol in their file icon to
indicate their content management status. For example, if the file is currently checked
out by yourself, this is visualized using a green check mark, as shown in Figure 6-1.

Figure 6-1    Status Icon Overlaid on Top of Microsoft Word Application Icon

Additionally, if you hover your mouse cursor over a managed file in the content pane, a
screen tip is displayed providing content management information about that file, as
shown in Figure 6-2.

Figure 6-2    Screen Tip Showing Content Management Information About File

In details view, the content pane includes a number of columns that show metadata
information about the files or folders (for example, their title and content ID). To
change which metadata columns are displayed, or their default width and order, right-
click any of the column headings in the content pane and choose Column Settings....

You may also see a preview pane, which shows additional information about the
selected item in the content pane (as examples: summary information, metadata, a
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preview). If you do not see the preview pane, select WebCenter Content Servers in
the Mail Folders pane, right-click in an unused area of the content pane, select View,
then select Preview Pane.

6.3 How do I preserve email messages and attachments on
a content server?

You preserve email messages on a content server by checking them in to that server.
Unless your system has been set up to start check-in automatically, you start by
selecting a message or messages in Microsoft Outlook and doing one of the following:

• Select Check In Mail Items from the WebCenter Content ribbon.

• Hold the Ctrl key while using your mouse to drag and drop the selected email
message to a content folder on a server in the mail folders pane. (If you do not
hold the Ctrl key, the original message will be removed from your email
application.)

If the message has attachments, these can either be checked in to the content server
as separate items or embedded in the message. (Your system may be set up to
always do one of these things.)

If attachments can be checked in as separate items, all detected attachments to the
selected messages are shown in the Check In Email Messages dialog. By default, the
settings on this dialog will check in the attachments as separate items, each with its
own content ID. If you want to check in a message and one or more of its attachments
as a single item, clear the check box against each attachment that you want to embed.

If the items you are checking have names that conflict with those already used on the
content server, you are prompted to rename the items. You do this by selecting the
item that you want to rename and clicking Rename.

Select the Oracle WebCenter Content Server instance that you want to check the
message or attachment in to, then select the content profile that should be applied to
the check-in form (providing any profiles are defined on the content server).

If you want the content item to show up in a content folder on the server, make sure
that you specify the location in the Folder field.

After you've clicked Continue, you can use the Check In Content dialog to check in
each of the messages or attachments that are to be checked in separately. The Check
In Content dialog will have separate pages for each item to be checked in. If there is
an item (message or attachment) that you do not want to check in, click Exclude Item
when you see the item's page in the Check In Content dialog.

Each item's page includes a check-in form that is partially completed with default
metadata. You can add further metadata or change the default metadata as required.
See the online help for more information.

The suggested title of a checked-in Microsoft Outlook message is usually a
combination of its subject line and the date it was received. However, files can be
named in other ways (for example using other attributes of the email, the email
message ID, or a uniquely generated code) depending on how your system has been
configured. Characters not allowed in Windows file names are replaced by spaces.
You can change the title as needed before completing the check-in.
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Note:

By default, Desktop replaces most of the special characters in the Windows file
names with a space. However, some special characters (example, #&^) in the
file names are exempted and are used as is. If you want any additional special
characters to be ignored by Desktop, you must create a new registry string -
Remove Special Characters under the following Windows Registry key:

HKEY_CURRENT_USER\Software\Oracle\WebCenter Desktop\Content

You must then specify the special characters that you want Desktop to ignore
in the Value data field.

Click Next to see the check-in form for the next item, then click Finish to check the
messages and attachments in to the selected content folder.

Microsoft Outlook messages are checked in as .msg files. Outlook VCard (.vcf) files
are not checked in to the content server.

Tips

• The content information page of a checked-in message will include links to each of
the checked-in attachments. These links point to the most recent revision of each
attachment, unless the server is using the RmaEmail component, in which case
the links will always point to the first revision.

• In some configurations, if you drag and drop a message into a content folder that
already has a message with the same file name, then a sequence number in
parentheses is added to the file name (for example, "Re Our Discussion (2).msg").
In other configurations, such duplication may not be allowed.

6.4 How can I retrieve and read preserved messages and
attachments?

You can open a checked-in email message from a server to view it in your default
email application. You can even make changes if you want, but you cannot then check
that message back in to the server. You can, however, send the message to other
people or save a copy on your local computer. Remember that email messages are
checked in to a content server for the express purpose of preserving them exactly as
they were received.

Using Microsoft Outlook

Begin by browsing the content folders on a server to find the email message you want
to view. To open an email file, double-click the file or right-click it and choose View
from the context menu.

Do not choose Open from the context menu of checked-in email files. This will check
out the file, but you cannot check it back in (just undo the check-out).

Using Windows Explorer
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In Windows Explorer, you can browse to email files in content folders on a server, but
you can also search for them. After locating the email message you want to view,
right-click the file and choose View from the context menu.

6.5 How do I send messages that contain attachments and
links to content server files?

Your outgoing messages can contain attachments and links to files on a content
server.

For WebCenter Content user interface, begin by creating or opening an email
message, then choose Get Attachment from the WebCenter Content toolbar, the
Insert ribbon, or the Message ribbon. Use the Browse button on the Get Attachment
dialog to locate and select the file or files that you want to include in your message.
Click OK when you have done this.

After you have selected the file or files you want to include in the message, the
Content Item field in the Get Attachment dialog shows their content IDs. If you
selected multiple files, the Content Item field shows the content ID of the first selected
file, and you can use the drop-down list to show the details of the other files.

For each content ID, decide whether to include the file as a link or as an attachment.

To insert the current file as a link, select the Link icon in the left panel. Then, for that
file, provide the link text, specify the rendition type, and choose whether to link to the
latest revision. For more information, see the online help.

To attach the current file to your message, select the File icon in the left panel. Then,
for that file, specify the rendition type.

Click OK to include the file or files in your message as links or attachments, as
specified by you.

Tips

• If you use Microsoft Word as your email editor in Microsoft Outlook, you can right-
click and insert links through the context menu.

• You cannot attach content server files to your messages if you are using Microsoft
Word as your email editor. To attach content server files, you must use Microsoft
Outlook's own HTML or text editor.

• In the Select Content dialog (opened by clicking the Browse button on the Get
Attachment dialog), you can select multiple files at the same time. When searching
for files, select the check box for each item in the search results list that you want
to include. When browsing to files in content folders, hold the Shift key for
consecutive selections and Ctrl for non-consecutive selections.

6.6 How can I create a new message with links to the file?
For native 11g user interface, when you select a file in the content folder hierarchy,
you see information about that file in the preview pane. You can use the Send link by
email option in the preview pane to create a new email message that includes links to
the currently selected file.
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Begin by selecting the file in the content folder tree (in the mail pane of Microsoft
Outlook, or in Windows Explorer, as available).

WebCenter Content servers: From the Email menu, select Send link by email. This
opens a new message. The subject of the message is Re: followed by the title of the
linked file. In the body of the message, three links are inserted, one to the web-
viewable version of the file, one to the native version of the file, and one to the content
info page for the file. If you do not want to include one of these links, you can delete it
before sending the message.

Content DB or WebDAV servers: In the preview pane, select Send link by email.
This opens a new message. The subject of the message is Re: followed by the name
of the file. In the body of the message, enclosed in angle brackets, is a URL that points
to a web-viewable version of the file on the server.

You can now complete the message and send it.

6.7 How can I view all my workflow assignments?
You can view all your current workflow assignments for an Oracle WebCenter Content
Server instance in one convenient list in your email application. This list shows all files
currently in a workflow that you are assigned to review. You can approve or reject the
files directly from the list.

Begin by making sure that the folders pane is visible in Microsoft Outlook, and that the
WebCenter Content Servers node is enabled.

Select the server for which you want to see all your workflow assignments. Find and
select the My Workflow Assignments node. This node may be nested beneath the
Users node.

If the server does not have a node called My Workflow Assignments, then workflow
assignments may not be enabled on the server, or the server is not a Content Server
11g instance.

The content pane lists all files on the server that you have currently been assigned to
review. This list matches that in Oracle WebCenter Content Server's web interface
(under My Content Server). You can work with the files in this list directly to review
them.

6.8 How do I work with Distribution Lists?
Support for distribution lists is disabled by default. To use the distribution list features
described in this section, you must enable them by checking the Support Distribution
Lists option, which is on the Email Checkin Settings dialog. You can open this dialog
from the WebCenter Content menu or ribbon and choosing Email Integration
Settings....

A distribution list is a collection of email addresses grouped under a common name.
Any message addressed to the group name is sent to everyone on the list. You can
check distribution lists in to an Oracle WebCenter Content Server instance (providing it
is running the RmaEmail component). You cannot check distribution lists in to Oracle
Content DB server or other WebDAV servers.

You can check in distribution lists that already exist in a Microsoft Outlook address
book or new ones that you create.
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After you check a distribution list in to an Oracle WebCenter Content Server instance,
you can modify the list by adding, changing, or removing information. Also, you can
clear the information in the name and address fields by clicking Reset.

Changes you make to the list are reflected only in the version checked in to the
content server. If the list is also used in Microsoft Outlook, that version remains
unchanged. When you edit a distribution list that is checked in to the content server,
you can create a new revision or a new content item when you save the list.

Checking In a New Distribution List

You can create a new email distribution list and then check that list in to an Oracle
WebCenter Content Server instance.

Begin by choosing Check In Distribution List from the WebCenter Content ribbon or
menu. On the Distribution List Checkin dialog, click Add, then, on the [Edit/Add]
Distribution List dialog, enter a name for the new distribution list that you are creating.

For each new member that you want to add to the distribution list, enter the following
information:

• Name: The person's name as you would like it to display in the distribution list.

• Address: That person's email address.

When you are finished adding the names and addresses for the distribution list, click
OK to open the distribution list check-in form.

Specify the appropriate metadata for the distribution list and click Check In.

Click OK on the check-in confirmation message and then click Close to close the
Distribution List Checkin dialog.

After the distribution list is checked in to the content server, it is included in the
Distribution List Checkin dialog for that server.

If you use Microsoft Word as your email editor in Microsoft Outlook, you will not be
able to check in distribution lists. To use this feature, you must use Microsoft Outlook's
own HTML or text editor.

Checking In a Distribution List from a Microsoft Outlook Address Book

You can select an email distribution list that already exists in a Microsoft Outlook
address book and check that list in to an Oracle WebCenter Content Server instance.

Begin by choosing Check In Distribution List from the WebCenter Content ribbon or
menu. On the Distribution List Checkin dialog, click Address Book to open the Check
In Distribution List From Address Book dialog.

In the Show lists from list, select the group in Microsoft Outlook that contains the
distribution list you are checking in to the content server. From that group, select the
distribution list that you want to check in.

If you want, click Details... to open the properties dialog for the distribution list,
including the list of addressees. This dialog is the same one that displays in Microsoft
Outlook for viewing the details of a distribution list. To modify the properties, follow the
instructions in Microsoft Outlook Help.

When you are ready to check in the distribution list, click Check in to open the
distribution list check-in form.

Specify the appropriate metadata for the distribution list and click Check In.
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Click OK on the check-in confirmation message and then click Close to close the
Distribution List Checkin dialog.

After the distribution list is checked in to the content server, it is included in the
Distribution List Checkin dialog for that server.

Adding a New Member to an Existing Distribution List

Begin by selecting Check In Distribution List from the WebCenter Content menu or
ribbon in Microsoft Outlook.

Select the distribution list that you want to add a new member to, then click Edit.

You can see the Edit Distribution List dialog with the name and address fields already
populated with the details of the first member in the list. To add a new member,
overwrite these values with the name and address of the new member. This will not
remove the original first addressee in the list.

Click Add to add the new member to the distribution list.

Repeat this process for each new member you want to add to the distribution list.

When you are finished adding new members to the distribution list, click OK.

You are prompted to check in the distribution list either as a new content item or as a
revision to the existing item. To check in the distribution list as a new content item,
choose New Content Item. Then provide a new name for the distribution list and click
OK. To check in the distribution list as a revision to the existing content item, choose
New Revision.

Provide or modify the appropriate metadata for the distribution list, then click Check
In.

Click OK to the check-in confirmation message, then click Close.

Changing the Name or Address of a Distribution List Member

Begin by selecting Check In Distribution List from the WebCenter Content menu or
ribbon in Microsoft Outlook.

Select the distribution list that contains the member whose name or address you want
to modify, then click Edit.

Select the list member whose name or address you want to modify.

Update the Name and Address fields as appropriate and click Modify to save the
changes.

Repeat this process for each list member whose name and address you want to
modify.

When you are finished, click OK.

You are prompted to check in the distribution list either as a new content item or as a
revision to the existing item. To check in the distribution list as a new content item,
choose New Content Item. Then provide a new name for the distribution list and click
OK. To check in the distribution list as a revision to the existing content item, choose
New Revision.

Provide or modify the appropriate metadata for the distribution list, then click Check
In.
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Click OK to the check-in confirmation message, then click Close.

Deleting a Member from a Distribution List

Begin by selecting Check In Distribution List from the WebCenter Content menu or
ribbon in Microsoft Outlook.

Select the distribution list that contains the member that you want to remove from the
list, then click Edit.

Select the list member that you want to remove from the distribution list. Click Delete
to remove the selected list member, and click Yes to confirm the operation.

Repeat this process for each member that you want to remove from the distribution
list.

When you are finished, click OK.

You are prompted to check in the distribution list either as a new content item or as a
revision to the existing item. To check in the distribution list as a new content item,
choose New Content Item. Then provide a new name for the distribution list and click
OK. To check in the distribution list as a revision to the existing content item, choose
New Revision.

Provide or modify the appropriate metadata for the distribution list, then click Check
In.

Click OK to the check-in confirmation message, then click Close.

Deleting a Distribution List

You can delete a distribution list from Oracle WebCenter Content Server. When you
do so, all revisions of that distribution list will be removed. If the list is also used in
Microsoft Outlook, it remains unchanged and is still available through Microsoft
Outlook.

Begin by selecting Check In Distribution List from the WebCenter Content menu or
ribbon in Microsoft Outlook.

Select the distribution list that you want to remove from the content server.

Click Delete to remove the selected distribution list, and click Yes to confirm the
operation. Click Close to close the Distribution List Checkin dialog.

6.9 What are the background and setup information needed
to connect to a content server?

6.9.1 Email Specific Metadata on Oracle WebCenter Content Server
This section applies only when connected to a server that is using the native 11g user
interface.

With the Desktop components installed on an Oracle WebCenter Content Server
instance, the content check-in form typically includes six email specific metadata
fields, providing they were enabled on the content server (see Table  below). These
are all optional metadata fields, which means you do not need to provide values for
them in order to check in an email message. If used, these metadata fields are pre-
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populated with available values when you check an email message or attachment in to
the content server.

Field Label on
Content Check-in
Form

Field Name in
Content Server

Description

Author Or Originator EmailFrom The sender of the email message (that is, the
name in the 'From' field).

Addressee(s) EmailTo The recipient or recipients of the email message
(that is, the name or names in the 'To' field).

Other Addressee(s) EmailCC The other recipients of the email message (that
is, the names in the 'Cc' field). Any names in the
'Bcc' field are ignored.

Email Subject EmailSubject The subject line of the email message.

Publication Date PublicationDate This is the date and time that the email message
was sent (as recorded in the message header).

Received Date ReceivedDate This is the date and time that the email message
was received (as recorded in the message
header).

6.9.2 Default Email Metadata and File Names
Oracle WebCenter Content Server

Oracle WebCenter Content Server can store multiple files of the same name as
separate content items. However, in the integration of Oracle WebCenter Content
Server with your Windows desktop application, file names in content folders must be
unique (in the same way that a folder in Windows cannot contain two files of the same
name). Because of this requirement, when you add an email message to a content
folder that already contains a message of the same name, it is automatically checked
in as a new revision to the existing item on the server. For example, if Our
discussion.msg is in a folder on the server and you add a second Our discussion.msg
file to that same folder, then the second file becomes a new revision of the first file. If
Our discussion.msg is in a folder and you add Our recent discussion.msg or Our
discussion.eml to that folder, then they remain separate content items because they
have different file names.

The file name that is displayed in the Name column in Windows Explorer or your email
application and in the Name field of the Content Properties dialog is the same as the
original file name in the content server repository. When you rename content through
the Windows Explorer integration, the original file name also changes to reflect the
new name.

If Oracle WebCenter Content Server is set up to automatically generate content IDs,
then the content IDs follow the established numbering convention. If this option is not
enabled, checking in a new content item through Windows Explorer or an email client
generates a unique sequential content or message ID.

Oracle Content Database Servers and Other WebDAV Servers

Content folders on Oracle Content Database servers and other WebDAV servers
behave exactly like Windows folders on your local computer. If you copy a file to a
folder on the server that already contains a file of the same name, then the existing file
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is simply overwritten. (Unlike with Oracle WebCenter Content Server, there is no
revisioning on these servers.)

6.9.3 Setting the Email Check In Option
When you check email messages in to the content server, you have the option of
setting some configuration options.

Begin by selecting Options, then Email Integration Settings... from the WebCenter
Content menu or ribbon in Microsoft Outlook.

Select the appropriate option to specify how email messages must be handled when
checking in to the content server:

• Check In Email After Sending: Each email is checked in to the content server at
the time of sending.

• Support Distribution Lists: A distribution list is a collection of email addresses
grouped under a common name. If you enable the support for distribution list, any
message addressed to the group name is sent to everyone on the list.

• Show WebCenter Content Servers: Displays the integration hierarchy in the
folders list of your email client (Microsoft Outlook or Lotus Notes). You must restart
your email application for the integration hierarchy to be displayed. You can see a
folder called WebCenter Content Servers in the folders pane in your email
application.

This setting applies only if you check in a message using the Check In Mail Item
feature in Microsoft Outlook [or Lotus Notes]. It does not apply if you drag and drop a
message into a content folder.

Click OK to close the Email Checkin Settings dialog. The setting takes effect
immediately.
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7
Lotus Notes Integration

This chapter explains how Oracle WebCenter Content: Desktop integrates with Lotus
Notes.

This section covers these topics:

• What is Email Client integration in Lotus Notes?

• How does Desktop integrate with Lotus Notes?

• How do I preserve email messages and attachments on a content server?

• How can I retrieve and read preserved messages and attachments?

• How can I send messages that contain attachments and links to content server
files?

• What is a Distribution List and how does it work?

7.1 What is Email Client integration in Lotus Notes?
You can check in email messages and their attachments to a content server directly
from Lotus Notes so that they can be preserved and shared with others in your
organization. You can also attach managed content items from the server as well as
links to them to your outgoing messages.

Checked-in messages are not intended to be checked out, modified, and checked
back in. Messages are checked in to a content server for the express purpose of
preserving them exactly as they were received. You can open a checked-in message
from a server to view it in your default email application. You can even make changes
if you want, but you cannot check it back in to the server. You can, however, send the
message to other people or save a copy on your local computer.

7.2 How does Desktop integrate with Lotus Notes?
For supported versions of Lotus Notes and Lotus Domino mail databases, the Desktop
client software adds a number of new items to the Actions menu in Lotus Notes
(Figure 7-1).
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Figure 7-1    Actions Menu in Lotus Notes 8.5

The standard Actions menu in Lotus Notes includes the following integration items:

• Check In Mail Item...: This option opens a dialog where you can check the
currently selected message in to a content server.

• Get Attachment...: This option opens a dialog where you can select a file on a
content server to be attached to the current message or embedded in the
message as a link.

• Check In Distribution List...: This option opens a dialog where you can check an
email distribution list in to a content server.

• Email Integration Settings...: This option opens a dialog where you can set a
number of configuration options for the email client integration.

• Email Integration Help: This option launches the Desktop online help in your
standard web browser.

• About WebCenter Content: Desktop...: This option opens a dialog that provides
version information about the Desktop client software.

7.3 How do I preserve email messages and attachments on
a content server?

You preserve email messages on a content server by checking them in to that server.
Unless your system has been set up to start check-in automatically, you start by
selecting the message in Lotus Notes and doing the following:

• Open the Actions menu and select Check In Mail Item....

If the message has attachments, these will either be checked in to the content server
as separate items or embedded in the message (depending on how your system is set
up).
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If attachments can be checked in as separate items, the Attachment Options dialog is
displayed, showing all detected attachments to the current message. By default, the
settings on this dialog will check in the attachments as separate items, each with its
own content ID. The content information page of the checked-in message will include
links to each of the checked-in attachments. These links point to the most recent
revision of each attachment, unless the server is using the RmaEmail component, in
which case the links will always point to the first revision.If you want to check in the
attachments and message as a single item, select the check box against each
attachment that you want to embed.

Use the Check In Content dialog to check in one message or attachment at a time. If
you selected multiple messages or if attachments will be checked in separately, the
Check In Content dialog will reopen for each item to be checked in. Attachments are
checked in before their associated message.

On the Check In Content dialog, select the Oracle WebCenter Content Server instance
that you want to check the message or attachment in to, then select the content profile
that should be applied to the check-in form (providing any profiles are defined on the
content server). The dialog also includes a check-in form that is partially completed
with default metadata. You can add further metadata or change the default metadata
as required. See the online help for more information.

The suggested file name of a checked-in Lotus Notes message is usually its subject
line. However, files can be named in other ways (for example using other attributes of
the email, the email message ID, or a uniquely generated code) depending on how
your system has been configured. Characters not allowed in Windows file names are
replaced by spaces. You can change the title as needed before completing the check-
in.

If you want the content item to show up in a content folder on the server, make sure
that you specify the location in the Folder field.

Click OK or Finish to check the message or attachment in to the selected content
folder.

Lotus Notes messages are checked in as .eml files.

Tips

• Attachments are always checked in first, followed by their associated message, so
you can check in an attachment by itself simply by canceling the content check-in
form when it reappears for checking in the message.

7.4 How can I retrieve and read preserved messages and
attachments?

Using Windows Explorer, you can open a checked-in email message from a server to
view it in your default email application:

• After locating the email message you want to view, right-click the file and choose
View from the context menu.

You can even make changes if you want, but you cannot then check that message
back in to the server. You can, however, send the message to other people or save a
copy on your local computer. Remember that email messages are checked in to a
content server for the express purpose of preserving them exactly as they were
received.
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In Windows Explorer, you can also search for email files in content folders on a server.

7.5 How can I send messages that contain attachments and
links to content server files?

Your outgoing messages can contain attachments and links to files on a content
server.

For WebCenter Content user interface, begin by creating or opening an email
message, then open the Actions menu and select Get Attachment.... Use the
Browse button on the Get Attachment dialog to locate and select the file or files that
you want to include in your message. Click OK when you have done this.

After you have selected the file or files you want to include in the message, the
Content Item field in the Get Attachment dialog shows their content IDs. If you
selected multiple files, the Content Item field shows the content ID of the first selected
file, and you can use the drop-down list to show the details of the other files.

For each content ID, decide whether to include the file as a link or as an attachment.

To insert the current file as a link, select the Link icon in the left panel. Then, for that
file, provide the link text, specify the rendition type, and choose whether to link to the
latest revision. For more information, see the online help.

To attach the current file to your message, select the File icon in the left panel. Then,
for that file, specify the rendition type.

Click OK to include the file or files in your message as links or attachments, as
specified by you.

Tips

• In the Select Content dialog (opened by clicking the Browse button on the Get
Attachment dialog), you can select multiple files at the same time. When searching
for files, select the check box for each item in the search results list that you want
to include. When browsing to files in content folders, hold the Shift key for
consecutive selections and Ctrl for non-consecutive selections.

7.6 What is a Distribution List and how does it work?

Note:

Support for distribution lists is disabled by default. To use the distribution list
features described in this section, you must enable them by checking the
Support Distribution Lists option, which is on the Email Checkin Settings dialog.
You can open this dialog from the Actions menu and choosing Email
Integration Settings....

A distribution list is a collection of email addresses grouped under a common name.
Any message addressed to the group name is sent to everyone on the list. You can
check distribution lists in to an Oracle WebCenter Content Server instance (providing it
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is running the RmaEmail component). You cannot check distribution lists in to Oracle
Content DB server or other WebDAV servers.

You can check in distribution lists that already exist in a Microsoft Outlook address
book or new ones that you create.

After you check a distribution list in to an Oracle WebCenter Content Server instance,
you can modify the list by adding, changing, or removing information. Also, you can
clear the information in the name and address fields by clicking Reset.

Important:

Changes you make to the list are reflected only in the version checked in to the
content server. If the list is also used in an email application, that version
remains unchanged. When you edit a distribution list that is checked in to the
content server, you can create a new revision or a new content item when you
save the list.

Checking In a New Distribution List

You can create a new email distribution list and then check that list in to an Oracle
WebCenter Content Server instance.

Begin by opening the Actions menu and choosing Check In Distribution List.... On
the Distribution List Checkin dialog, click Add, then, on the [Edit/Add] Distribution List
dialog, enter a name for the new distribution list that you are creating.

For each new member that you want to add to the distribution list, enter the following
information:

• Name: The person's name as you would like it to display in the distribution list.

• Address: That person's email address.

When you are finished adding the names and addresses for the distribution list, click
OK to open the distribution list check-in form.

Specify the appropriate metadata for the distribution list and click Check In.

Click OK on the check-in confirmation message and then click Close to close the
Distribution List Checkin dialog.

After the distribution list is checked in to the content server, it is included in the
Distribution List Checkin dialog for that server.

Checking In a Distribution List from a Microsoft Outlook Address Book

You can select an email distribution list that already exists in a Microsoft Outlook
address book and check that list in to an Oracle WebCenter Content Server instance.

Begin by opening the Actions menu and choosing Check In Distribution List.... On
the Distribution List Checkin dialog, click Address Book to open the Check In
Distribution List From Address Book dialog.

In the Show lists from list, select the group in Microsoft Outlook that contains the
distribution list you are checking in to the content server. From that group, select the
distribution list that you want to check in.
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If you want, click Details... to open the properties dialog for the distribution list,
including the list of addressees. This dialog is the same one that displays in Microsoft
Outlook for viewing the details of a distribution list. To modify the properties, follow the
instructions in Microsoft Outlook Help.

When you are ready to check in the distribution list, click Check in to open the
distribution list check-in form.

Specify the appropriate metadata for the distribution list and click Check In.

Click OK on the check-in confirmation message and then click Close to close the
Distribution List Checkin dialog.

After the distribution list is checked in to the content server, it is included in the
Distribution List Checkin dialog for that server.

Adding a New Member to an Existing Distribution List

Begin by opening the Actions menu and choosing Check In Distribution List....

Select the distribution list that you want to add a new member to, then click Edit.

You can see the Edit Distribution List dialog with the name and address fields already
populated with the details of the first member in the list. To add a new member,
overwrite these values with the name and address of the new member. This will not
remove the original first addressee in the list.

Click Add to add the new member to the distribution list.

Repeat this process for each new member you want to add to the distribution list.

When you are finished adding new members to the distribution list, click OK.

You are prompted to check in the distribution list either as a new content item or as a
revision to the existing item. To check in the distribution list as a new content item,
choose New Content Item. Then provide a new name for the distribution list and click
OK. To check in the distribution list as a revision to the existing content item, choose
New Revision.

Provide or modify the appropriate metadata for the distribution list, then click Check
In.

Click OK to the check-in confirmation message, then click Close.

Changing the Name or Address of a Distribution List Member

Begin by opening the Actions menu and choosing Check In Distribution List....

Select the distribution list that contains the member whose name or address you want
to modify, then click Edit.

Select the list member whose name or address you want to modify.

Update the Name and Address fields as appropriate and click Modify to save the
changes.

Repeat this process for each list member whose name and address you want to
modify.

When you are finished, click OK.
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You are prompted to check in the distribution list either as a new content item or as a
revision to the existing item. To check in the distribution list as a new content item,
choose New Content Item. Then provide a new name for the distribution list and click
OK. To check in the distribution list as a revision to the existing content item, choose
New Revision.

Provide or modify the appropriate metadata for the distribution list, then click Check
In.

Click OK to the check-in confirmation message, then click Close.

Deleting a Member from a Distribution List

Begin by opening the Actions menu and choosing Check In Distribution List....

Select the distribution list that contains the member that you want to remove from the
list, then click Edit.

Select the list member that you want to remove from the distribution list. Click Delete
to remove the selected list member, and click Yes to confirm the operation.

Repeat this process for each member that you want to remove from the distribution
list.

When you are finished, click OK.

You are prompted to check in the distribution list either as a new content item or as a
revision to the existing item. To check in the distribution list as a new content item,
choose New Content Item. Then provide a new name for the distribution list and click
OK. To check in the distribution list as a revision to the existing content item, choose
New Revision.

Provide or modify the appropriate metadata for the distribution list, then click Check
In.

Click OK to the check-in confirmation message, then click Close.

Deleting a Distribution List

You can delete a distribution list from Oracle WebCenter Content Server. When you
do so, all revisions of that distribution list will be removed. If the list is also used in an
email application, it remains unchanged and is still available through that application.

Begin by opening the Actions menu and choosing Check In Distribution List....

Select the distribution list that you want to remove from the content server.

Click Delete to remove the selected distribution list, and click Yes to confirm the
operation. Click Close to close the Distribution List Checkin dialog.
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8
Web Browser Search Integration

This chapter describes how Oracle WebCenter Content: Desktop integrates with web
browsers.

This section covers these topics:

• How does Desktop integrate with web browser search?

• How does Desktop integrate with Microsoft Internet Explorer?

• How does Desktop integrate with Mozilla Firefox?

• How does Desktop integrate with Google Chrome?

8.1 How does Desktop integrate with web browser search?
Oracle WebCenter Content: Desktop integrates with web browsers to enable you to
search for content on a server directly from the search field of the web browser. The
content given below is only applicable for Oracle WebCenter Content Servers.

The following web browsers are supported:

• Microsoft Internet Explorer 8.0 or higher

• Mozilla Firefox 3.5 or higher

• Google Chrome 10 or higher

This integration adds a search provider or search engine to your web browser. The
default name for this search provider or engine is 'Oracle WebCenter Content Search',
but this can be changed by the content server administrator. Contact your content
server administrator if you are not sure what name is being used. A search provider or
engine in your web browser is for a specific Oracle WebCenter Content Server
instance only. You cannot search multiple content servers using a single search
provider or engine. You cannot add two search providers or engines for the same
Oracle WebCenter Content Server instance.

If you are currently logged in to the content server, you will see all content items that
meet the search criteria and for which you have access privileges on the server. If you
are not logged in, then you will see only public content.

The search results are displayed in the web browser using the Oracle WebCenter
Content Server web interface. Specifically, the search mimics the Quick Search
feature in that interface.

Tips

• For web browser integration to work, it must first be enabled on the content server
(on the DesktopIntegrationSuite component configuration page). Ask the content
server administrator whether the web browser plug-in has been enabled for that
server.

• See your web browser help for additional information about searching.
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See Using Web Browser Search Fields to Search for Managed Content in Using
Oracle WebCenter Content.

8.2 How does Desktop integrate with Microsoft Internet
Explorer?

Oracle WebCenter Content: Desktop lets you search content servers using the
Internet Explorer web browser.

Adding the Search Provider During an Oracle WebCenter Content Server
Session

Begin by using Internet Explorer to log in to the Oracle WebCenter Content Server
instance you want to add the search provider for.

Open the My Content Server tray or menu, then click My Downloads.

Click Add browser search in the downloads table. (If there are downloads for both
32-bit and 64-bit versions, it does not matter which one you choose.)

In the Add Search Provider dialog, optionally select the 'Make this my default search
provider' check box, then click Add.

Adding the Search Provider from the Browser Search Box

This method is supported in Internet Explorer 8 and Internet Explorer 10.

Begin by using Internet Explorer to log in to the Oracle WebCenter Content Server
instance you want to add the search provider for.

Click the arrow to the right of the search box in your browser. (This arrow acquires a
colored glow, indicating that the website offers a search provider that can be installed
in Internet Explorer.)

Point to Add Search Providers and click the required search provider name. (The
default search provider name is 'Oracle WebCenter Content Search', but the server
administrator may have changed this.)

Figure 8-1    Oracle WebCenter Content Search Provider Added to Internet
Explorer 9

Searching for Managed Content in Internet Explorer

While using Internet Explorer, click the arrow to the right of the search box (Internet
Explorer 8 and 10) or address bar (Internet Explorer 9), and select the Oracle
WebCenter Content search engine.
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Enter your search term and press Enter. The search results are displayed in the
Oracle WebCenter Content Server web interface.

If you are currently logged in to the content server, you will see all content items that
meet the search criteria and for which you have access privileges on the server. If you
are not logged in, then you will see only public content.

Removing the Search Provider from Internet Explorer

You remove the Oracle WebCenter Content search provider from Internet Explorer just
as you would any other search provider. For instructions, see the Internet Explorer
help for the version you are using.

8.3 How does Desktop integrate with Mozilla Firefox?
Oracle WebCenter Content: Desktop lets you search content servers using the Firefox
web browser.

Adding the Search Engine During an Oracle WebCenter Content Server Session

Begin by using Firefox to log in to the Oracle WebCenter Content Server instance you
want to add the search engine for.

Open the My Content Server tray or menu, then click My Downloads.

Click Add browser search in the downloads table. (If there are downloads for both
32-bit and 64-bit versions, it does not matter which one you choose.)

In the Add Search Engine dialog, optionally select the 'Start using it right away' check
box, then click Add.

Adding the Search Engine from the Browser Search Box

Begin by using Firefox to log in to the Oracle WebCenter Content Server instance you
want to add the search engine for.

Click the arrow in the browser search bar to open the search engine list. (The search
engine button acquires a colored glow, indicating that the website offers a search
engine that can be installed in Firefox.)

Click Add "Search_Engine" to make the search engine available in the web browser
(Figure 8-2). The default search engine name is 'Oracle WebCenter Content Search',
but the server administrator may have changed this.

Figure 8-2    Oracle WebCenter Content Search Engine Added to Firefox
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Setting and Using a Search Engine Keyword in Firefox

You can speed up searches in your web browser by assigning keywords to a search
provider. This allows you to search directly from the browser's address bar without
having to select the search engine to use first. For example, if you set 'cs' as the
keyword for an Oracle WebCenter Content search engine, then specifying "cs
Search_Term" in the address bar of your web browser immediately performs the Quick
Search query on the Oracle WebCenter Content Server associated with the keyword.

By default, no search engine keyword is associated with an Oracle WebCenter
Content Server instance.

To set a keyword, begin by clicking the arrow in the Firefox search bar to open the
search engine list.

Click Manage Search Engines....

In the Manage Search Engine List dialog, select the Oracle WebCenter Content
search engine and click Edit Keyword....

Enter the keyword (for example, cs) and click OK.

You can now use the defined keyword to perform a quick search on the associated
Oracle WebCenter Content Server instance directly from the address bar. In the
browser address bar, type the search engine keyword associated with the Oracle
WebCenter Content Server instance you want to search followed by the search term,
for example:

cs "sales report"

Searching for Managed Content in Firefox

While using Firefox, click the arrow in the browser search bar and select the Oracle
WebCenter Content search engine.

Enter your search term in the search bar and press Enter. The search results are
displayed in the Oracle WebCenter Content Server web interface.

If you are currently logged in to the content server, you will see all content items that
meet the search criteria and for which you have access privileges on the server. If you
are not logged in, then you will see only public content.

Removing the Search Engine from Firefox

You remove the Oracle WebCenter Content search engine from Firefox just as you
would any other search engine. For instructions, see the Firefox help for the version
you are using.

8.4 How does Desktop integrate with Google Chrome?
Oracle WebCenter Content: Desktop lets you search content servers using the
Chrome web browser.

Adding the Search Engine During an Oracle WebCenter Content Server Session

Begin by using Chrome to log in to the Oracle WebCenter Content Server instance
you want to add the search engine for.

Open the My Content Server tray or menu, then click My Downloads.
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Click Add browser search in the downloads table. (If there are downloads for both
32-bit and 64-bit versions, it does not matter which one you choose.)

Depending on your Chrome version, the search engine for the current Oracle
WebCenter Content Server instance is installed and enabled in the web browser
immediately, or you can first modify the search engine name, keyword, or URL before
installing it.

Setting a Search Engine Keyword in Chrome

You can speed up searches in your web browser by assigning keywords to a search
provider. This allows you to search directly from the browser's address bar without
having to select the search engine to use first. For example, if you set 'cs' as the
keyword for an Oracle WebCenter Content search engine, then specifying "cs
Search_Term" in the address bar of your web browser immediately performs the Quick
Search query on the Oracle WebCenter Content Server associated with the keyword.

The default search engine keyword for an Oracle WebCenter Content Server instance
is its main URL, for example server1.example.com.

To set a keyword, begin by clicking the configuration icon (wrench) on the Chrome
toolbar.

Click Options, then, on the Basics page, click Manage search engines....

On the Search Engines page, under Other search engines, select the Oracle
WebCenter Content search engine and specify the keyword (for example, cs). You can
also change the search engine name if you want.

Close the Search Engines page.

You can now use the defined keyword to perform a quick search on the associated
Oracle WebCenter Content Server instance directly from the address bar. In the
browser address bar, type the search engine keyword associated with the Oracle
WebCenter Content Server instance you want to search followed by the search term,
for example:

cs "sales report"

Searching for Managed Content in Google Chrome

In the Chrome address bar, type the search engine keyword associated with the
Oracle WebCenter Content Server instance you want to search followed by the search
term, for example:

cs "sales report"

The search results are displayed in the Oracle WebCenter Content Server web
interface.

If you are currently logged in to the content server, you will see all content items that
meet the search criteria and for which you have access privileges on the server. If you
are not logged in, then you will see only public content.

Removing the Search Engine from Firefox

You remove the Oracle WebCenter Content search engine from Chrome just as you
would any other search engine. For instructions, see the Chrome help for the version
you are using.

Chapter 8
How does Desktop integrate with Google Chrome?

8-5



A
Advanced Client Configuration

This appendix describes the advanced client configuration on your computer.

This section covers these topics:

• How do I set Windows Explorer integration options?

• How do I change the location of the local file cache?

• How do I disable overriding the default content profile selection?

• How do I configure and disable pattern-based file naming for email check-ins?

Important:

This section deals with advanced configuration on your computer. Make sure
that you consult with your system administrator to verify you are allowed to
perform the tasks in this section.

Note:

For administrative Desktop tasks, see Managing Desktop in Managing Oracle
WebCenter Content.

A.1 How do I set Windows Explorer integration options?
Desktop offers a number of advanced configuration options that enable you to fine-
tune the way it works with Windows Explorer on your computer. To see the advanced
options dialog, do the following:

• Windows 7 and Windows Vista: Open Windows Explorer and then right-click the
WebCenter Content Servers item in the folders list (not in your favorites list!)
while simultaneously holding the Shift and Ctrl keys.

Note:

Make sure all folders are shown in Windows Explorer (which is not the
default): click Tools, then Folder Options, then General, and then Show
all folders.

• Windows XP: Open Windows Explorer and then right-click the WebCenter
Content Servers item in the folders list while simultaneously holding the Shift and
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Ctrl keys. Alternatively, Shift+Ctrl+right-click the WebCenter Content Servers
icon on the Windows desktop.

The context menu now includes an option called Properties.... Choose this option to
open the Windows Explorer Integration Properties dialog (Figure A-1).

Figure A-1    Windows Explorer Integration Properties Dialog

Important:

Modify these settings only if you know what you are doing or if specifically
instructed to do so, for example by an Oracle support engineer. Changing
these settings may break your Desktop client installation!

Note:

Your system administrator may have set up your computer to prevent you from
making any changes to the configuration settings in this dialog. If that is the
case, you can change a setting, but the changes will not "stick" after you click
OK.

Appendix A
How do I set Windows Explorer integration options?
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Element Description

Windows Explorer Integration
logging

Select this check box if you want errors that occur
during software execution to be written to a log file. This
may be useful for troubleshooting and diagnostic
purposes. The log file is called WebDAVClient.log, and it
is located in the Windows temp directory (as defined by
the %TEMP% system variable).

Maximum log file size (MB) Specify the maximum file size that the Windows
Explorer integration log file is allowed to have (in
megabytes). After the log file exceeds this size limit, it is
deleted and a new log file is started.

Application Integration logging Select this check box if you want normal Desktop
operations, such as program calls and the like, to be
written to a log file. This can be useful for
troubleshooting and diagnostic purposes. The log file is
called DIS_Log.log, and it is located in the Windows
temp directory (as defined by the %TEMP% system
variable). There is no size limit to this log file other than
any dictated by the file system.

IdcClient.ocx logging Select this check box if you want the IdcClient
operations to be written to a log file. This can be useful
for troubleshooting and diagnostic purposes. The
IdcClient handles communications with content servers.
The log file is called IdcClient.log, and it is located in the
Windows temp directory (as defined by the %TEMP%
system variable). There is no size limit to this log file
other than any dictated by the file system.

View Log... Click any of these buttons to view their associated log
file.

Open files with URLs in native
characters instead of %XX UTF8
format

Select this check box if you want URLs to be encoded in
the operating system's native encoding (for example,
Big-5) rather than Unicode.

Use %XX format Select this check box to encode all URL bytes in the
%XX escaped format, except for the following
characters: a-z A-Z 0-9 ! # $ & ' ( ) + - . ; = _.

Use WebDAV URL when opening
files with the following extensions

Select this check box if you want files with the specified
file extensions to be opened using WebDAV rather than
downloading them and then opening them from the
offline cache. In other words, the WebDAV URL is
provided to the application, so that it acts as a WebDAV
client. Use commas to separate the file extensions.

Make 'Open' the default file action,
not 'View'

Select this check box if you want a content file on a
server to be opened rather than viewed when you select
it in the folder tree in Windows Explorer and press Enter
or double-click it. Note that local copies of managed
documents always open in full edit mode regardless of
this setting.

For a comparison of the 'view' and 'open' actions, see 
What are the content management actions performed
on files on a content server?.

Appendix A
How do I set Windows Explorer integration options?
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Element Description

Hide the Close Document check-in
dialog

Select this check box if you do not want to see the
special close dialog for managed documents in
Microsoft Office applications. Instead, managed
documents are saved in much the same way as
unmanaged Office documents ("Do you want to save the
changes?").

Remove Passwords Click this button to remove the cached passwords for all
content server connections on your computer. This
forces a login prompt the next time you connect to a
server, which may be useful if the incorrect login
credentials were inadvertently cached for a content
server.

Launch document URLs with DDE Select this check box to attempt to open URLs using a
DDE transaction instead of a ShellExecute API call. The
connection and transaction are timeout values (in
milliseconds) that help to ascertain if the DDE
conversation has succeeded.

Launch document URLs with
associated executables

Select this check box to issue a call to ShellExecute
using the document's associated executable as the exe
and the URL as the document argument. (This is done
for URLs.)

Launch local documents with
associated executables

Select this check box to issue a call to ShellExecute
using the document's associated executable as the exe
and the file path as the document argument. (This is
done for files on the file system; that is, those that are
checked out and cached locally on the disk.)

Unquote secondary launch API Select this check box to call ShellExecute without the
document path surrounded by quotes.

OK Click this button to close this dialog and submit any
changes you made.

Cancel Click this button to close this dialog and cancel any
changes you made.

A.2 How do I change the location of the local file cache?
Desktop uses temporary storage cache on the file system of client computers. For
more information, see How are content files stored in a local cache?. By default, this
storage cache is located in the following directory:

• Windows XP: C:\Documents and Settings\USER\Application Data\Stellent\
SyndicationCache

• Windows Vista and Windows 7: C:\Users\USER\AppData\Roaming\Stellent\
SyndicationCache

However, this may not comply with your organization's standards for where data
should be stored on client computers. To accommodate for this, you can use the
following Windows Registry keys to modify the location of the temporary storage cache
on a client computer (the paths below are examples):

Appendix A
How do I change the location of the local file cache?
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Important:

Check with your system administrator whether you are allowed to make
changes to the Windows registry. Also, changing the registry, if done
incorrectly, may affect the stability of your computer. Do not edit the Windows
registry unless you are confident about doing so.

[HKEY_CURRENT_USER\Software\Oracle\WebCenter Desktop\Content\WebDAV]
"Syndication Dir"="H:\\Application Data\\SyndicationCache"

Tips

• The AppData structure in Windows Vista and Windows 7 is hidden by default. You
must enable the option to view hidden folders in Windows Explorer.

• This registry value is not included by default; you must add it manually.

• The registry value is a string value.

• Any files already in the offline cache are not automatically moved from the old to
the new location. It is therefore recommended that you empty your offline cache
before changing its location.

• The offline cache location has subdirectories for each defined server connections.

• Make sure that you restart your computer (or log off and log back on) after
modifying this setting.

• When entering the path in Registry Editor, use single backslashes (\) to separate
directories in the path. However, if you export the registry branch to a file, the
value will contain double backslashes (\\).

• Setting this registry key affects the offline cache location for all defined server
connections. You cannot change the cache location setting for individual content
servers. However, the settings are user-specific, so if there are multiple user
accounts on the computer, the settings apply to the current user only.

• Your system administrator may have disabled the ability to make changes to the
Desktop configuration settings on your computer.

A.3 How do I disable overriding the default content profile
selection?

If you are prompted to provide metadata when dragging and dropping or copying and
pasting a new file into a folder that has a default content profile assigned to it, you can
normally change that profile in the content check-in dialog.

You can use the following Windows Registry key to disable the ability to override the
default content profile selection:

[HKEY_CURRENT_USER\Software\Oracle\WebCenter Desktop\Content]
"Metadata Prompts Allow Any Profile"=dword:00000000

Appendix A
How do I disable overriding the default content profile selection?
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Important:

Check with your system administrator whether you are allowed to make
changes to the Windows registry. Also, changing the registry, if done
incorrectly, may affect the stability of your computer. Do not edit the Windows
registry unless you are confident about doing so.

Tips

• This registry value is not included by default; you must add it manually.

• The registry value is a dword value.

• Setting the value to '0' prevents you from changing the default content profile
selection in the content check-in dialog. The default value is '1'.

• If you are using 32-bit Microsoft Office on 64-bit Windows, you do not need to use
Wow6432Node.

• Your system administrator may have disabled the ability to make changes to the
Desktop configuration settings on your computer.

A.4 How do I configure and disable pattern-based file
naming for email check-ins?

You can use the registry to change the pattern used for naming the email files. By
default, pattern-based file naming is enabled when checking in email files. The default
is to use the subject line and date received as the file name, in the form
<$xEmailSubject$>-<$xReceivedDate$>.msg. For example:

Re Sales figures for 2012-05152013 153025.msg

If you want to disable pattern-based file naming, you can do so by specifying an empty
string as the file naming pattern in the Windows Registry key.

To configure or disable pattern-based file naming, use the following Windows Registry
key:

[HKEY_CURRENT_USER\Software\Oracle\WebCenter Desktop\Content]
"MSG File Name Pattern"="<token>"

To disable pattern-based file naming, use an empty string:

"MSG File Name Pattern"=""

To configure pattern-based file naming, use one or more of the following tokens:

• <$xEmailSubject$>

• <$xEmailFrom$>

• <$xEmailTo$>

• <$xEmailCC$>

• <$xPublicationDate$>

• <$xReceivedDate$>

Appendix A
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• <$xEmailId$>

For example:

[HKEY_CURRENT_USER\Software\Oracle\WebCenter Desktop\Content]
"MSG File Name Pattern"="<$xEmailSubject$>-<$xEmailFrom$>-<$xPublicationDate$>"

An example of how this would appear:

Re Sales figures for 2012-John Doe-06252013 091159.msg

Important:

Check with your system administrator whether you are allowed to make
changes to the Windows registry. Also, changing the registry, if done
incorrectly, may affect the stability of your computer. Do not edit the Windows
registry unless you are confident about doing so.

Tips

• These settings apply only to Microsoft Outlook message files. Lotus Notes
message files are not subject to pattern-based file naming.

• This registry value is not included by default; you must add it manually if you want
to disable or configure pattern-based file naming.

• The email metadata component of Desktop may have been set up to override
pattern-based file naming, in which case these registry settings will have no effect.

• The date based tokens will be resolved into MMDDYYYY HHMMSS (for example,
4/23/2013 5:18:52 PM becomes 04232013 171852) and the date is based on
UTC. If the message header value cannot be retrieved then the token will resolve
to no value.

• If pattern-based file naming is disabled, generated file names are based on the
subject line, the internet message ID, or the GUID, as available and appropriate.
Examples of each of these are:

Re Sales figures for 2012.msg

0E906834E170104899F28A9E1F4642029BA485@jdoe1.example.com.msg

963533CA-F448-466F-97F9-525FB2AA43B8.msg

• These settings apply to all servers accessed through the Desktop instance to
which the registry key applies.

• Your system administrator may have disabled the ability to make changes to the
Desktop configuration settings on your computer.

Appendix A
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B
Uninstalling the Desktop Client Software

This appendix describes how to uninstall the Desktop client software and the individual
Desktop components.

This section covers these topics:

• How do I uninstall the Desktop client software completely?

• How do I uninstall individual Desktop components?

B.1 How do I uninstall the Desktop client software
completely?

To completely uninstall the Desktop client software:

1. Open Windows Control Panel.

2. Click the following link, depending on your operating system:

• Windows XP: Add or Remove Programs

• Windows Vista and Windows 7 (category view): Uninstall a program (under
Programs)

• Windows Vista and Windows 7 (icon view): Programs and Features

3. Select Oracle WebCenter Content Desktop.

4. Do the following, depending on your operating system:

• Windows XP: Click Remove.

• Windows Vista and Windows 7: Right-click and choose Change (or Uninstall).

The Desktop install/uninstall wizard is launched.

5. Complete the wizard, selecting the Remove or Uninstall options.

Click Yes when asked if you are sure that you want to remove the Desktop client
software from your computer.

The software is removed from the client computer.

6. Restart your computer.

Tips

• If you reinstall the Desktop client software (for example, during an upgrade), any
server connections that you set up earlier will continue to be available after
reinstalling the software.

• Uninstalling the Desktop client software from your computer will not remove any
Oracle WebCenter Content search providers from your web browsers.
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B.2 How do I uninstall individual Desktop components?
To uninstall individual Desktop components:

1. Open Windows Control Panel.

2. Click the following link, depending on your operating system:

• Windows XP: Add or Remove Programs

• Windows Vista and Windows 7 (category view): Uninstall a program (under
Programs)

• Windows Vista and Windows 7 (icon view): Programs and Features

3. Select Oracle WebCenter Content: Desktop.

4. Click Change to start the Desktop install wizard.

5. Go through the installation procedure (see Installing the Latest Version of the
Desktop Client Software) and unselect the application(s) that you no longer want
to integrate with Content Server.

6. Restart your computer.

Appendix B
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C
Reference Information

This appendix provides information on the Enterprise libraries, content folders and
files, content file versioning and so on.

This section covers these topics:

• What are Enterprise Libraries?

• What are content folders and files?

• How do a new content folder inherit and propagate metadata?

• What is Content File Versioning?

• What is Content File Metadata?

• What are the content management actions performed on files on a content server?

• What does the icons displayed in the WebCenter Content Servers folder tree
indicate?

• Which are the options available in the Content Folder context menu?

• Which are the options available in the Content File context menu?

• Which are the options available in the Desktop context menu?

• How are content files stored in a local cache?

• How do I enable metadata prompting for enterprise libraries and folders?

• What are the capabilities of a content server?

• How do I identify the URLs for Oracle WebCenter Content Server?

• What are the URLs required for creating a content server connection?

• What are the custom document properties of Microsoft Office files?

C.1 What are Enterprise Libraries?
For full information about using enterprise libraries, see About Document Libraries in
Using Oracle WebCenter Content.

Enterprise libraries provide structure and organization to documents. They are the top
level of a folder tree in which all folders and documents should be stored.

Enterprise libraries are created by individuals to provide flexible security and
comprehensive document management used by an entire organization.

Enterprise libraries are a robust way to secure, manage and share content that is
accessed by many people in your organization. You can set access in an enterprise
library at the document level, lock documents while editing, and maintain a
comprehensive revision history of documents. You can create and share any number
of enterprise libraries and folders or shortcuts within enterprise libraries.
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C.2 What are content folders and files?
Content folders offer a familiar, tree-like structure that provides convenient access to
files on a content server without having to use that server's own user interface (web-
based or otherwise). They are essentially like the directories on your local computer,
but they point to virtual locations on the content server. Similarly, the "files" in the
content folders are symbolic links or pointers to content items in the content server
repository.

Oracle WebCenter Content Server Instances Running the WebCenter Content
User Interface

Content folders and files interact with enterprise libraries in the following ways:

• Content folders can be nested beneath enterprise libraries.

• Files can be added to content folders or directly to enterprise libraries.

• You cannot add files directly beneath the enterprise libraries node in the folder
tree.

You only see enterprise libraries, folders, and files for which you have access
privileges on the content server.

Oracle WebCenter Content Server Instances Running the Native 11g User
Interface

For Oracle WebCenter Content Server instances, content folders are shown under
Browse Content in the server's folder tree in Windows Explorer and your email
application.

Note:

Content folders are available on client computers only if the content server
administrator has enabled the folders functionality on the server. If this is not
the case, you will not see a content folders tree. Also, content folders may be
displayed differently for a content server than shown in this section, depending
on the server configuration (specifically, the folders component running on it).

The folder structure that you see in the folders tree in the native 11g user interface is
identical to that in the Oracle WebCenter Content Server web interface (under 'Browse
Content'), as illustrated in Figure C-1. You see only folders and files for which you
have access privileges on the server.

Appendix C
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Figure C-1    Content Folders in Windows Explorer and Oracle WebCenter
Content Server's Web Interface

Oracle Content Database Servers and Other WebDAV Servers

On Oracle Content Database servers and other WebDAV servers, content folders are
shown directly under the defined server connection in the folder tree in Windows
Explorer and your email application. The folder structure that you see in the folder tree
is identical to that in Oracle Content DB's web interface or Oracle Drive. You only see
folders and files for which you have access privileges on the server.

Interacting with Content Folders and Files

You work with content folders and files in the folder tree of a content server in much
the same way as you do with other, local folders and files on your computer. You can
copy and paste files, drag and drop files, right-click files to open context menus, and
so on. In addition, you can perform a number of content management tasks on the
folders and files on the server. Depending on the server type and setup, you may
check files out of the server, check them in, make them available for offline use, view
content information, and so on.

C.3 How do a new content folder inherit and propagate
metadata?

When you create a new content folder on an Oracle WebCenter Content Server
instance, the metadata from its parent folder automatically populates the metadata
fields for the new folder. This allows the folder to initially "inherit" metadata, but
enables you to make changes to the new folder. Subsequent changes to a parent
folder's metadata do not affect the metadata for existing subfolders.

The content server administrator can enable the metadata propagation feature, which
enables you to apply a parent folder's metadata to all the subfolders and files in it. See 
How do I propagate library and folder metadata? for more information.

Appendix C
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C.4 What is content file versioning?
Oracle WebCenter Content Server

Oracle WebCenter Content Server can store multiple files of the same name as
separate content items. However, in the integration of Oracle WebCenter Content
Server with your Windows desktop applications, file names in content folders must be
unique (in the same way that a folder in Windows cannot contain two files of the same
name). Because of this requirement, when you copy a file to a content folder that
already contains a file of the same name, it is automatically checked in as a new
revision of the existing file on the server. For example, if process.doc is in a folder on
the server and you copy a second process.doc file to that same folder, then the
second file becomes a new revision of the first file (even though they may be
completely different documents). If process.doc is in a folder and you copy
process2.doc or process.xls to that folder, then they remain separate content items
because they have different file names.

When you move a file to a content folder that already contains a file with the same
name, then that file may replace the original file in that folder, depending on the folders
component running on the server. The old file is not removed, however; it just loses its
folder association. The content item is still on the server and you can search for it.

The file name that is displayed in the Name column in Windows Explorer or your email
application and in the Name field of the Content Properties dialog is the same as the
original file name in the content server repository. When you rename content through
the Windows Explorer integration, the original file name also changes to reflect the
new name.

If Oracle WebCenter Content Server is set up to automatically generate content IDs,
then the content IDs follow the established numbering convention for that server. If this
option is not enabled, checking in a new content item generates a unique sequential
content or message ID.

Oracle Content Database Servers

When you add a file to a content folder on an Oracle Content Database server that
already contains a file of the same name, then it depends on the folder settings how
this is handled. If automatic versioning is enabled for the folder, the file is checked in
as a new revision of the existing file on the server. If manual versioning is enabled,
then the existing file is simply overwritten (in other words, the content folder behaves
exactly like standard Windows folders on your local computer).

Other WebDAV Servers

When you add a file to a content folder on a WebDAV server that already contains a
file of the same name, then it depends on the server settings how this is handled.
Unless the WebDAV server has special versioning features, the existing file is simply
overwritten with the new file (in other words, the content folder behaves exactly like
standard Windows folders on your local computer).

Appendix C
What is content file versioning?

C-4



C.5 What is content file metadata?
Metadata is "data about data." It enables the content server to keep track of all items
managed on the server, and also helps with searching for items, controlling access,
and so on.

When you check a file in to an Oracle WebCenter Content Server instance, you
associate information with that file that uniquely identifies it so that you can easily
locate the file in the content server at any time. Oracle WebCenter Content Server
uses three types of metadata: default, optional, and custom. The specific metadata
fields used depend on how your system administrator has configured the server.

Default metadata fields are preconfigured for the software and include the content ID
and primary file. The content ID is a unique identifier for each content item on the
server and is often assigned automatically. If the system is set up to allow you to enter
a content ID, you can do so in the content check-in form. Some of the default
metadata fields are mandatory: a content item cannot be checked in with any of these
fields left blank. Mandatory metadata fields are marked with an asterisk (*) on the
content check-in form.

If you provide no title for the file being checked in, the file name (minus the file
extension) is used as the title.

Desktop can "remember" the metadata values used at check-in and automatically
populate metadata fields each time you check in a new content item.

Whenever you check a file in to Oracle WebCenter Content Server, default metadata
values are automatically assigned to the content. These default values, which are set
by the system administrator through Oracle WebCenter Content Server's web
interface, are evaluated in the following order:

1. Folder: When you add a file to a content folder on the server, that file inherits any
default metadata values for the folder that have been set through Oracle
WebCenter Content Server's web interface.

2. User: For any metadata defaults not set for the folder, the user's default metadata
values (as set in the user profile) are applied.

3. System: The system default values are applied to any fields that are not set by
either the folder metadata or the user's default metadata.

4. Email: If the EmailMetadata component is installed on the content server, e‐mail
specific default metadata is assigned to the content.

After you check content in to the content server, you can change the metadata for the
content item on its content information page (see How do I view and modify library,
folder, and file information and properties?).

Caution:

If you change the security group, content type, or account of a content item,
you will change the URL of that item in the content server and may also change
who has access to the item.
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If you change metadata for a folder, the new metadata is applied to all content you add
to the folder after the change. The metadata of the content that is already in the folder
prior to the change remains the same.

When you create a new content folder, the metadata from its parent folder
automatically populates the metadata fields for the new folder. This allows the folder to
initially "inherit" metadata, but enables you to make changes to the new folder.
Subsequent changes to a parent folder's metadata do not affect the metadata for
existing subfolders. If you want to apply a parent folder's metadata to subfolders and
content items, you can use the metadata propagation feature.

C.6 What are the content management actions performed
on files on a content server?

You can perform various content management actions on files on a content server:

• View: When you view a file on a content server, it opens in its associated
application in read-only mode, but it is not checked out of the content server. You
can make changes to the file in the application, but you will have to save it as a
new file (with a new file name) and check it in to the server as a new content item.
Depending on the file type and state, you may be able to check out a read-only
document directly in a Microsoft Office application, so you can make changes and
check it back in to the server as a new revision.

It is normally the latest released file revision on the server that is downloaded and
opened in its associated application. However, if the file is already in your local
cache (typically because you opened it before, modified it, but did not yet check it
back in to the server), then you can choose which file version to open: the one in
your local cache (View) or the latest released file revision on the server (View File
From Server).

For more information, see How do I view files?.

• Open: When you open a file on a content server, it opens in its associated
application in full edit mode and it is checked out of the content server. The file is
locked on the server, and no other user can check out the file until you either
check it back in or cancel its checked-out status ("undo the check-out"). You can
make changes to the file as required. When you check the file back in to the
content server, it is checked in as a new revision of the existing content item. In
Microsoft Office applications, you are given the opportunity to do this when you
close the document or exit the application; other file types must be checked in
using Windows Explorer. For more information, see How do I open files? (Opening
a content folder simply shows the contents of that folder.)

• Check out (and check in): When you check out a file from a content server, it is
downloaded from the server and placed in the offline cache on your computer. The
file is locked on the content server, and no other user can check out the file until
you either check it back in or cancel its checked-out status ("undo the check-out").
The checked-out file is not opened in its associated application. (This is how
checking out a file is different from opening it.) You can process the file as desired,
and check it back in to the server when you are ready. For more information, see 
How do I check out files?.

When you check in a file to a content server, it is uploaded and submitted to the
content server. You can check in files as new revisions of content items already on
the server, or new files as new content items. After you check a file in to a server,
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it is stored on that server and other users have access to it in accordance with
their assigned privileges. For more information, see How do I check in files?.

• Available offline: When you make files available offline, you create copies of
these files in a cache directory on your local computer, so that you can access
these files even if there is no connection to the server. For more information, see 
How can I access the content server files in offline mode?.

Table C-1 below provides a side-by-side comparison between these content
management actions on files on a server.

Table C-1    Content File Actions

Action Checked Out of
Content Server?

Available in Offline
Cache (1)?

Opened in Associated
Application?

View No No (3) Yes (4)

Open (2) Yes (5) Yes Yes (6) (7)

Check Out Yes (5) Yes No

Available Offline No Yes No

Notes

1. The file is copied to a temporary location on your local computer and can be
accessed in offline mode. For more information, see How are content files stored
in a local cache?.

2. Opening a content folder simply shows the contents of that folder.

3. The file is copied to your local computer as a temporary file, but cannot be
accessed in offline mode.

4. The file is opened in read-only mode. You can make changes to the file, but you
will have to save it as a new file (with a new file name) and check it in to the server
as a new content item. In Microsoft Office applications, you may be able to check it
out directly depending on the file type and state, so you can make changes and
check it back in to the server as a new revision.

5. The file is locked on the content server, and no other user can check out the file
until you either check it back in or cancel its checked-out status ("undo the check-
out").

6. The file is opened in full edit mode. You can make changes to the file as required.
When you check the file back in to the content server, it is checked in as a new
revision of the existing content item. In Microsoft Office applications, you are given
the opportunity to do this when you close the document or exit the application;
other file types must be checked in using Windows Explorer.

7. If the file is already checked out or available offline, you can choose a specific
application to open the file in rather than its associated application ("Open With").

C.7 What does the icons displayed in the WebCenter
Content Servers folder tree indicate?

Content items shown in the WebCenter Content Servers folder tree are preceded by
an icon which identifies their application type, as is customary in Microsoft Windows,
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as well as their content management status. Table  below lists the available status
icons with their description. Each of these status icons is an overlay of the application
icon for the content item (see Figure C-2 for an example of a Word application icon
with a checked-out status overlay).

Figure C-2    Checked-out Microsoft Word Document

Icon Description

This icon is used to indicate that you have currently checked out the
content item. The versions of your locally cached copy and the original
file on the content server match; that is, no changes have been made
to either version since the file was checked out.

It is not always possible to obtain the user login information on content
servers other than Oracle WebCenter Content Server instances. Files
that you have checked out yourself may then be marked as if someone
other than you checked them out (showing the padlock icon; see
below).

All shortcuts to a checked-out file will also show this icon, since they
are linked to the original file.

This icon is used to indicate that you have currently checked out the
content item. However, the versions of your locally cached copy and
the original file on the content server do not match; more specifically,
the modified timestamp of the file in your local cache has changed.
This will typically be the case if you checked out a file, made changes
to it, but did not yet check it back in to the content server. The icon
provides a visual reminder for this.

All shortcuts to a checked-out file will also show this icon, since they
are linked to the original file.

This icon is used to indicate that someone other than you has currently
checked out the content item, and the file is locked. You cannot check
out the item, but you can still view it or make it available offline on your
computer.

If you move the mouse cursor over the icon, you see a yellow box that
includes the user name of the person who checked out the item.
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Icon Description

This icon is used to indicate that there is a conflict between the locally
cached copy of a content item and the original file on the content
server. This will typically happen if the file in the local cache is
modified, but it is not checked out to you (for example, because
someone cancelled the checked-out status of the file in the content
server). You also see this status if you have made changes to a file in
a workflow, but have not yet approved or rejected the file.

You can remedy this situation in either of two ways:

• If you do not mind losing all changes to your local copy, then you
can right-click the item and choose the Discard Changes option
in the context menu. The locally cached copy is then moved in the
recycle bin, effectively deleting it (unless the cache directory is
located on a network share; in that case it is deleted directly).

• If you want to keep all changes to your local copy, then you can
right-click the item and choose the Move to Desktop option in the
context menu. The local cached copy is then moved to your
desktop, and you can check out the original file and check in the
file on your desktop.

This icon is used to indicate that the content item is currently available
offline (that is, in local cache for your read-only access). The versions
of your locally cached copy and the original file on the content server
match; that is, no new revision has been checked in to the content
server since you selected the file for offline availability.

Only files can be made available offline, not folders. When you select
the Make Content Available Offline option in the context menu of a
folder, all content items in that folder (and any subfolders) are made
available offline.

This icon is used to indicate that the content item is currently available
offline. However, the versions (more specifically, the dID attribute) of
your locally cached copy and the original file on the content server do
not match. This would, for example, be the case if someone updated
the original item on the content server, and your local copy is still an
older revision.

You can remedy this situation by right-clicking the file or its folder and
choosing the Refresh Offline Files option (for files) or Refresh
Offline Content option (for folders). This updates the copy in your
local cache with the latest revision on the content server (and the icon
turns into a blue cylinder again).

C.8 Which are the options available in the Content Folder
context menu?

When you right-click a folder in the folder tree, a context menu comes up, which
provides a number of options that are relevant to the folder in that particular situation
(as is customary in Microsoft Windows). This context menu includes a number of
standard Windows items (such as Copy and Delete), but also has a number of
Desktop-specific content management options. The context menu for folders may
include any of the following Desktop-specific options:

• New Folder: Enables you to create a new content subfolder in the current folder.

• New Project: Enables you to create a new collaboration subproject in the current
project.
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• Open: Opens the selected folder in a new window, with the folders pane not
visible (when selected in folders pane), or opens the selected folder in the content
pane (when selected in the content pane).

• Make Content Available Offline: Creates local copies of all content in the
selected content folder or collaboration project in a special cache location on your
computer. You can then view these files (in read-only mode) even if you are not
connected to the content server. For more information, see How can I access the
content server files in offline mode?.

• Refresh Offline Content: Updates the offline file cache on your local computer to
reflect the latest content of the corresponding content folder(s) or collaboration
project(s) on the content server. For more information, see How can I access the
content server files in offline mode?.

• Remove Offline Content: Deletes the content in the selected collaboration folder
or collaboration project from the offline file cache on your local computer (not from
the content server!). This means you can no longer view these files when you are
not connected to the content server. For more information, see How can I access
the content server files in offline mode?.

• Search... (Oracle WebCenter Content Server only): Opens a search form on the
current content server where you can specify criteria and search for items on that
server based on these criteria. For more information, see How do I search for files
in the Microsoft File Explorer navigation pane?.

• Show Quick Search (Oracle WebCenter Content Server only): Shows or hides
the Quick Search feature in Windows Explorer. For more information, see How do
I search for files using the Quick Search feature?.

• Show Only Published Content (Oracle WebCenter Content Server only):
Includes or excludes from the file list all content items that are in an unreleased
state on the content server; that is, any content items that are currently in a
workflow, have not yet been fully converted or indexed, or have a future release
date.This option is not available when in a query folder or retention query folder.

• Propagate (Oracle WebCenter Content Server only): Copies the metadata of the
selected content folder or collaboration project to all subfolders and files in that
folder or project. For more information, see How do I propagate library and folder
metadata?.

• Copy: Copies the selected content folder or collaboration project and all its
content into the copy-and-paste buffer. You can then create a copy of the folder(s)
or project(s) by pasting them to a different location. (You can also press the Ctrl
+C key combination to do this.) For more information, see How do I copy libraries,
folders, and files?.

• Paste: Pastes the contents of the copy-and-paste buffer into the current location.
(You can also press the Ctrl+V key combination to do this.)

• Create Shortcut (Oracle WebCenter Content Server only): Creates a shortcut to
the selected content folder or collaboration project at the same folder or project
level in the folder tree. For more information, see How do I work with Oracle
WebCenter Content Server shortcuts ("Special Shortcuts")?.

• Delete: Removes the selected content folder or collaboration project, including all
its content, from the folder tree (and also from the content server!). (You can also
press the Delete key to do this.) You should use this option with great care as it
may directly affect files on the content server. For more information, see How do I
delete libraries, folders, and files?.
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• Rename: Enables you to give the selected content folder or collaboration project
in the folder tree a new name. (You can also press the F2 key to do this.) For more
information, see How do I rename libraries, folders, and files?.

• Folder Information... (Oracle WebCenter Content Server only): Displays the
folder information page on the server for the selected folder or project in the folder
tree. For more information, see How do I view and modify library, folder, and file
information and properties?.

• Properties: Displays a dialog that provides information about the selected folder
or project in the folder tree. For more information, see How do I view and modify
library, folder, and file information and properties?.

• Advanced Properties (Oracle Content DB servers only): Displays a window that
displays the properties about the selected folder in the folder tree.

• Sharing (Oracle Content DB servers only): Displays a window where you can set
the properties for sharing the selected folder(s); in other words, who has access to
the folder and who can create content in it.

• Update Metadata (Oracle WebCenter Content Servers using native 11g user
interface only): This enables you to update the metadata that will be given to new
content items in this folder. This will open either the Editing Default Metadata
Values page or the Hierarchy Folder Configuration page, depending on which
folder system is being used. For more information, see How do I view and modify
library, folder, and file information and properties?.

• Favorite (Oracle WebCenter Content Servers using WebCenter Content user
interface only): Adds the current folder to your Favorites node.

C.9 Which are the options available in the Content File
context menu?

When you right-click a file in the folder tree, a context menu comes up, which provides
a number of options that are relevant to the file in that particular situation, as is
customary in Microsoft Windows. This context menu includes a number of standard
Windows items (such as Copy and Delete), but also has a number of Desktop-specific
content management options. The context menu for files may include any of the
following Desktop-specific options:

Note:

Most of these options are also available on the File menu in Windows Explorer.

• Open: Opens the selected file in its associated application in full edit mode; that is,
it is checked out of the content server, and if you make any changes, you can
check it in as a new revision of the content item. For more information, see How
do I open files?.

• View File From Server: Downloads the latest released revision of the selected file
from the content server to your local cache and opens it in its associated
application in read-only mode. The file is not checked out and if you make any
changes, you must check it in as a new content item. For more information, see 
How do I view files?.
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• View: Opens the selected file from your local cache in its associated application in
read-only mode. Its associated content item on the server is not checked out and if
you make any changes to the file, you must check it in as a new content item. This
option is available only if a file is in your local cache. For more information, see 
How do I view files? and How are content files stored in a local cache?.

• Open With...: Allows you to choose the application with which to open the
selected file (rather than the application associated with the file type). A submenu
provides all available applications. This option is available only for files that are
already checked out of the content server. For more information, see How do I
open files?.

• Check Out: Retrieves the selected file from the content server and makes it
available for further processing (for example, editing). For more information, see 
How do I check out files?.

• Check In: Uploads the selected file to the content server and stores it on that
server. If it is a new content item, you must provide metadata. If it is an existing
content item, it inherits the metadata from the previous revision. For more
information, see How do I check in files?.

• Check In With Metadata: Allows you to modify the metadata of a managed file
before uploading it to the content server as a new revision. For more information,
see How do I check in files?.

• Undo Check Out: Cancels the checked-out status of the selected file on the
content server. For more information, see How do I check out files?.

• Discard Changes: Moves the locally cached copy of a content item to the recycle
bin, effectively deleting it (unless the cache directory is located on a network
share; in that case it is deleted directly). This option is available if there is a conflict
between the locally cached file copy and the original file on the content server.

• Move to Desktop: Moves the locally cached copy of a content item to the
Windows desktop. This option is available if there is a conflict between the locally
cached file copy and the original file on the content server. Moving the file to the
desktop allows you to check out the original file and check in the file on your
desktop.

• Available Offline: Creates local copies of all selected files in a special cache
location on your computer. You can then view these files (in read-only mode),
even if you are not connected to the content server. For more information, see 
How can I access the content server files in offline mode?.

• Approve: Approves the current file for moving to the next workflow step. If the
document requires an electronic signature, the Workflow: Sign and Approve dialog
opens, where you can electronically sign the current file and approve it for moving
to the next step in the workflow. You can approve files only if they are not currently
checked out. For more information, see How do I work with workflows on content
server instances?.

• Reject: Marks the current file in a workflow as rejected and returns it to the most
recent workflow step that permitted contribution. The users assigned to that
contribution step receive an email notification, so they can edit the file and submit
it for review again.You can reject files only if they are not currently checked out.
For more information, see How do I work with workflows on content server
instances?.

• Remove From Your Assignments: Removes the current file from your list of
workflow assignments (in your My Workflow Assignments folder). Selecting this
option does not change the document's workflow status. If a subsequent workflow
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step assigns the document to you, it will again appear in your list. If you need to
reinstate an item to your list, you must do so through the server's web interface.
This option is available only when using the WebCenter Content user interface.
For more information, see How do I work with workflows on content server
instances?.

• Copy: Copies the selected file from the local cache into the copy-and-paste buffer.
You can then create a copy of this file by pasting it to a different location. (You can
also press the Ctrl+C key combination to do this.) This option is available only if a
file is in your local cache. For more information, see How do I copy libraries,
folders, and files?.

• Copy File From Server: Copies the latest released revision of the selected file on
the server into the copy-and-paste buffer (rather than from your local cache). You
can then create a copy of this file by pasting it into a different location. (You can
also press the Ctrl+C key combination to do this.) For more information, see How
do I copy libraries, folders, and files?.

• Paste: Pastes the contents of the copy-and-paste buffer into the current location.

• Copy Links: Copies the various URLs of the file selected in the folder tree into the
copy-and-paste buffer. You can then paste these URLs into any Windows
application (for example, an email message) to provide direct links to the file. For
more information, see How can I copy content file links?.

• Create Shortcut (Oracle WebCenter Content Server only): Creates a shortcut to
the selected file in the same folder as the referenced file. For more information,
see How do I work with Oracle WebCenter Content Server shortcuts ("Special
Shortcuts")?.

• Delete: Removes the selected file from the folder tree (and also from the content
server!). (You can also press the Delete key to do this.) You should use this option
with great care as it may directly affect files on the content server. For more
information, see How do I delete libraries, folders, and files?.

• Rename: Enables you to give the selected file in the folder tree a new name. (You
can also press the F2 key to do this.) This option is not available when the file is
currently checked out of the content server. For more information, see How do I
rename libraries, folders, and files?.

• Content Information... (Oracle WebCenter Content Server only): Displays the
content information page on the server for the selected file in the folder tree. For
more information, see How do I view and modify library, folder, and file information
and properties?.

• Properties: Displays a dialog that provides information about the selected file in
the folder tree. For more information, see How do I view and modify library, folder,
and file information and properties?.

• Advanced Properties (Oracle Content DB servers only): Displays a window that
displays the properties about the selected file in the folder tree.

• Sharing (Oracle Content DB servers only): Displays a window where you can set
the properties for sharing the selected file; in other words, who has access to the
file.

• Update Metadata (Oracle WebCenter Content Servers using native 11g user
interface only): This enables you to update the metadata for a content item. For
more information, see How do I view and modify library, folder, and file information
and properties?.
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• Favorite (Oracle WebCenter Content Servers using WebCenter Content user
interface only): Adds the current file to your Favorites node.

C.10 Which are the options available in the Desktop context
menu?

The Desktop context menus may include the following server-related options:

• Open: Opens the selected server in a new window, with the folders pane not
visible (when selected in folders pane), or opens the selected server in the content
pane (when selected in the content pane).

• Search... (Oracle WebCenter Content Server only): Opens a search form on the
current content server where you can specify criteria and search for items on that
server based on these criteria. For more information, see How do I search for files
in the Microsoft File Explorer navigation pane?.

• Show Quick Search (Oracle WebCenter Content Server only): Shows or hides
Oracle WebCenter Content Server's Quick Search feature in Windows Explorer.
For more information, see How do I search for files using the Quick Search
feature?.

• Log Off: Breaks the connection to the current content server. This means that you
will have to provide your login credentials (user name and password) again the
next time you want to access that server. For more information, see How do I log
off from a content server?.

• Work Offline: Disconnects you from the current content server. This means that
you will only have access to the files on that server that have been marked to be
available offline. For more information, see How do I work with content server in
offline mode? and How can I access the content server files in offline mode?.

• Remove: Enables you to remove the selected server connection from the folder
tree.

• Properties: Opens a dialog which shows a number of properties of the current
content server.

• Add Server...: Opens a dialog where you can add a new content server
connection to the folder tree.

• Save Query: Saves the current search query in your list of saved queries (see My
Saved Queries). This enables you to quickly perform the search query again to
see the latest dynamic search results. (Not available for servers using the
WebCenter Content user interface.)

• View Query Definition: Opens a dialog that shows the query statement for the
selected saved query. (Not available for servers using the WebCenter Content
user interface.)

C.11 How are content files stored in a local cache?
Desktop may download temporary copies of files from a content server and store them
on your local computer. By default, the temporary storage cache is located in the
following directory:

• Windows XP: C:\Documents and Settings\USER\Application Data\Stellent\
SyndicationCache
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• Windows Vista and Windows 7: C:\Users\USER\AppData\Roaming\Stellent\
SyndicationCache

where USER is the profile name of the current computer user (for example, jsmith).
The 'SyndicationCache' directory stores all offline Desktop files in separate
subdirectories for each content server.

The following files are stored in your local cache:

• Copies of files that you checked out of the content server

• Read-only copies of files on the content server that you specifically marked to be
available offline (so that you can access these files even if there is no connection
to the server)

• Modified files managed by a content server that you have not yet checked back in
to that server (typically checked-out files that were edited)

• Newly created files in Microsoft Office applications that were not checked in
successfully (for example, because no server connection could be established)

Note:

You can change the offline cache location on your computer if the defaults do
not meet your organization's file storage requirements. For more information,
see How do I change the location of the local file cache?.

C.12 How do I enable metadata prompting for enterprise
libraries and folders?

Note:

The procedure given in this section is for Oracle WebCenter Content Server
11gR1 instances. This feature is also available for Oracle Content DB Server
instances (see the Oracle Content Database Administrator’s Guide).

When you drag and drop, copy and paste, or save a new file to an enterprise library or
folder, you may be asked to provide metadata for that file before it is checked in to the
server. This only happens if the enterprise library or folder was specifically configured
to enable metadata prompting. If metadata prompting is not enabled for an enterprise
library or folder, new files in that library or folder will always inherit the default
metadata values for the library or folder as set through the content server's web
interface. If a required field does not have a default value assigned to it, you will
always be prompted to provide metadata. For more information on metadata
inheritance, see What is Content File Metadata?.

To enable metadata prompting for an enterprise library or folder:

1. Open Windows Explorer and make sure the folders pane is visible.

2. Open the WebCenter Content Servers node.
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3. Click the Oracle WebCenter Content Server or Oracle Content DB Server instance
that stores the library or folder for which you want to enable metadata prompting. If
prompted, log in by entering your user name and password for that server.

4. Select the library or folder in the folder tree for which you want to enable metadata
prompting.

The preview pane, if enabled, displays the content information of the selected
folder. If the preview pane is not visible, you can enable it. You can also right-click
the folder and choose Folder Information to open the information page in a
separate window.

The information page shows metadata that is assigned to the selected folder on
the content server (for example, its owner, content type, security group, and so
on).

For more information on content information (metadata), see Viewing and Editing
Document Library Properties in Using Oracle WebCenter Content.

5. Do whichever of the following is appropriate for your installation:

If you are using the native 11g user interface

Either:

• Open the Folder Actions menu and then choose Update to open the
Hierarchy Folder Configuration page; or

• Open the Edit menu, then click Folder Information, and then show
advanced options.

Make sure that the Prompt for Metadata or Enable Metadata Prompts check
box is selected.

If you are using the WebCenter Content User Interface

• In the preview pane, on the metadata tab, select Prompt for metadata when
items are added to this library/folder.

Note:

If you do not see these options, then you do not have sufficient privileges
on the server to perform that action.

6. When you are done, click Save or Submit Update to save the changes. The
changes take effect immediately; you do not need to restart your computer or the
content server.

C.13 What are the capabilities of a content server?
The Desktop client software provides different content management features
depending on the server type and configuration, as outlined in the table below.
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Content
Management
Capability

11gR1 Oracle
WebCenter
Content
Server with
Desktop
11gR1
components
and
Framework
Folders

11gR1 Oracle
Content
Server with
Desktop
11gR1
components
and
Folders_g

10gR3 Oracle
Content
Server with
Desktop
11gR1
components

10gR3 Oracle
Content Servers
with Desktop
10gR3
components

Oracle
Content
DB Server

WebDA
V
Server

Standard Windows
operations such as
copy-and-paste,
drag-and-drop, and
create Windows
shortcuts

yes yes yes yes yes yes

Checking files out of
the server

yes yes yes yes yes yes

Checking files in to
the server (copy-and-
paste or drag-and-
drop)

yes (1) yes (1) yes (2) yes (2) yes yes

Checking files in to
the server (check-in
form)

yes yes yes yes no no

Browsing to files on
the server (navigation
tree)

yes yes yes yes yes yes

Searching for files on
the server (search
form)

yes yes yes yes no no

Working with offline
files on the server

yes yes yes yes yes yes

Copying links to files
on the server

yes yes yes yes yes yes

Creating content
server shortcuts to
files and folders on
the server

yes yes yes yes no no

Propagating content
server metadata to
subfolders and files.

yes yes yes yes no no

Choosing which
metadata fields and
values to propagate

yes no no no no no

Working with query
folders.

yes no no no no no

Working with
personal folders.

yes no no no no no

Hiding unpublished
files

yes no no no no no
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Content
Management
Capability

11gR1 Oracle
WebCenter
Content
Server with
Desktop
11gR1
components
and
Framework
Folders

11gR1 Oracle
Content
Server with
Desktop
11gR1
components
and
Folders_g

10gR3 Oracle
Content
Server with
Desktop
11gR1
components

10gR3 Oracle
Content Servers
with Desktop
10gR3
components

Oracle
Content
DB Server

WebDA
V
Server

Changing folder
association of items
by dragging and
dropping them to a
different folder

yes yes no no no no

Associate items not
assigned to any
content folder with a
folder by dragging
and dropping them to
the target folder

yes no no no no no

Inserting content
files, file links, or
images on the server
into Microsoft Office
documents

yes yes yes yes no no

Choosing content
profiles on search
and check-in pages

yes yes no no n/a n/a

Checking in files by
dragging and
dropping into profile
node

yes yes no no no no

Comparing a Word
document with
another file on the
server

yes yes yes yes yes yes

Comparing a Word
document with an
earlier file revision on
the server

yes yes yes yes no no

Seeing productivity
nodes (My Checked-
Out Content, My
Workflow
Assignments, My
Saved Queries, etc.)
in the folder tree.

yes yes yes no no no

Approving or
rejecting workflow
items directly in
Windows Explorer
(through context
menu)

yes yes no no n/a n/a
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Content
Management
Capability

11gR1 Oracle
WebCenter
Content
Server with
Desktop
11gR1
components
and
Framework
Folders

11gR1 Oracle
Content
Server with
Desktop
11gR1
components
and
Folders_g

10gR3 Oracle
Content
Server with
Desktop
11gR1
components

10gR3 Oracle
Content Servers
with Desktop
10gR3
components

Oracle
Content
DB Server

WebDA
V
Server

Interacting with the
WebCenter Content
user interface

yes (3) no no no n/a n/a

Notes

1. If any required metadata is missing, you may be prompted to provide it depending
on the configuration settings for the folder.

2. If any required metadata is missing, the check-in operation will fail if no default
folder metadata has been defined.

3. This requires a connection to Oracle WebCenter Content Server 11gR1
(11.1.1.8.0) or higher with Framework Folders and the latest Desktop 11gR1
integration component.

C.14 How do I identify the URLs for Oracle WebCenter
Content Server?

When creating a content server connection, you must provide the WebDAV URL for
that server and possibly its CGI URL (depending on the server type). See What are
the URLs required for creating a content server connection? for information on what
these URLs typically look like.

If you are already accessing an Oracle WebCenter Content Server instance through
your web browser, you see its CGI URL in the address bar and you can use this
information to set up your server connection in Desktop. It is the web address from the
beginning up to, but not including, the question mark (?), as shown in Figure C-3. The
WebDAV URL is typically the CGI URL plus '/webdav' appended to it.

Figure C-3    CGI URL of Oracle WebCenter Content Server

You can copy and paste the URL in the address bar to the URL fields in the Add
Server dialog. Each defined content server connection must have its own, unique
WebDAV URL. You cannot have two server connections on your computer that use
the exact same WebDAV URL.

If you are using your web browser to connect to the WebCenter Content user interface
offered by Oracle WebCenter Content Server 11gR1 (11.1.1.8.0) or higher, you can
also see all required URLs for Desktop by opening your user menu and clicking Add
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Server to Desktop Integration. (You can click Add Server to automatically add a
connection for that server to the Desktop folder tree.)

Contact your content server administrator if you have any problems determining the
server URLs.

C.15 What are the URLs required for creating a content
server connection?

When creating a content server connection, you must provide the WebDAV URL for
that server, and possibly its CGI URL (for Oracle WebCenter Content Server
instances). If you want to connect to the WebCenter Content user interface on Oracle
WebCenter Content Server 11gR1 (11.1.1.8.0) or higher, you must also provide the
URL for that user interface. Each defined content server connection must have its
own, unique WebDAV URL. You cannot have two server connections on your
computer that use the exact same WebDAV URL.

Oracle WebCenter Content Server

Oracle WebCenter Content Server instances require both a WebDAV URL and CGI
URL, and possibly a UI URL.

The WebDAV URL for content servers typically has the following form:

http[s]://host-name:[port]/web-root/idcplg/webdav

For example:

http://server:7044/idc/idcplg/webdav
http://server.example.com:16200/cs/idcplg/webdav
https://server/cs/idcplg/webdav

The CGI URL is typically the same as the WebDAV URL, without '/webdav', for
example:

http://server:7044/idc/idcplg
http://server.example.com:16200/cs/idcplg
https://server/cs/idcplg

If the WebCenter Content user interface is being used, the user interface URL points
to the server providing that user interface, for example:

http://server.example.com:16400/wcc/faces

See How do I identify the URLs for Oracle WebCenter Content Server? for a way to
find out what the URL of an Oracle WebCenter Content Server instance is. You can
also ask your system administrator what URLs to use.

If clients should connect to an Oracle WebCenter Content Server 11gR1 instance
using basic authentication rather than form-based authentication (that is, using a
login dialog), then you can force basic authentication by adding '_dav' to the server's
WebDAV and CGI URLs. In addition, HTTPS should be used. For example:

https://server.example.com:16200/_dav/cs/idcplg/webdav
https://server.example.com:16200/_dav/cs/idcplg

WebDAV and CGI URLs with '_dav' are not supported in Oracle Content Server
10gR3.
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Oracle Content DB Servers and WebDAV Servers

Oracle Content DB servers and other WebDAV servers require only a WebDAV URL.
What this URL looks like is entirely dependent on the server location and
configuration. You may want to ask your system administrator what URLs to use.

Note:

You may not need to set up server connections for Desktop on your own
computer, as this is often handled by system administrators.

C.16 What are the custom document properties of Microsoft
Office files?

A number of custom properties may be added to Microsoft Office files, depending on
the content server type and configuration (specifically, the DesktopTag feature on
Oracle WebCenter Content Server). By default, these new custom properties include:

• DISdDocName: This is the content ID of the document on the content server.
Every content item on the server has its own content ID, which uniquely identifies
that item on the server. (Each checked-in document revision has an additional,
internal ID as a unique reference to that specific revision; see DISdID below.)

• DISProperties: This is a list of all Desktop properties that are added to Microsoft
Office documents.

• DIScgiUrl: This is the CGI URL of the content server that the document resides
on. It essentially enables Microsoft Office applications (or other third-party
software) to "remember" what content server the Microsoft Office document came
from when it was opened in the application, and where it was stored on the server.

• DISdWorkflowState: This is the current state of the document in a workflow (if
applicable).

• DISdUser: This is the user name of the document author (or more specifically, the
user who checked the document in to the content server).

• DISdID: This is the unique identifier for this specific document revision on the
content server. Every revision of a content item on the server has its own internal
ID, which provides a unique reference to that specific revision of the content item.

• DISTaskPaneUrl: This is the URL that can be used to display information about
the content item in the task pane of Microsoft Office applications (or other third-
party software).

Note:

The custom properties are automatically handled by Desktop and should not be
changed by end users.

Viewing the Custom Properties
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You can view the custom properties of a Microsoft Office file as follows:

• Microsoft Office XP (2002) and 2003: Choose File, then Properties, and then
open the Custom tab.

• Microsoft Office 2007: Click the Office button in the top left corner, then choose
Prepare, then Properties, then Document Properties, then Advanced
Properties, and then open the Custom tab.

• Microsoft Office 2010: Open the File panel, then click Info, then Properties,
then Advanced Properties, and then open the Custom tab.

Figure C-4    Custom Document Properties (Microsoft Word 2007)

These custom document properties allow Desktop to keep track of the location of a
managed Microsoft Office document on a content server as well as its revision history.
This enables users to open the most recent revision of a managed document even if
they have an older revision, or to check a document back in to a content server even
outside a content management integration context. This may be useful in a number of
situations, for example:

• You received a managed Microsoft Office document from someone else, for
example as an attachment to an email.

• You received a managed Microsoft Office document that may not be the most
recent revision.

• You copied a managed Microsoft Word document from a server in the WebCenter
Content Servers folder tree on your computer to a folder outside that folder tree.

In any of these cases, you can open the latest revision of the document in Microsoft
Word on your computer, make changes, and then check it back in to the server using
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the WebCenter Content menu or ribbon in Microsoft Word. Desktop looks at the
custom properties embedded in the Microsoft Word document to find out where to
upload the file to.
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